THESIS

Canopy Mortality Modeling and Mapping in Burned Areas of Northwest Wyoming

Submitted by
Diane C. Abendroth

Department of Forest, Range, and Watershed Stewardship

In partial fulfillment of the requirements for the Degree of Master of Science
Colorado State University
Fort Collins, Colorado
April 24, 2008
COLORADO STATE UNIVERSITY

APRIL 24, 2008

WE HEREBY RECOMMEND THAT THE THESIS PREPARED UNDER OUR SUPERVISION BY DIANE C. ABENDROTH ENTITLED CANOPY MORTALITY MODELING AND MAPPING IN BURNED AREAS OF NORTHWEST WYOMING BE ACCEPTED AS FULFILLING IN PART REQUIREMENTS FOR THE DEGREE OF MASTER OF SCIENCE.

Committee on Graduate Work


Adviser


Department Head
ABSTRACT OF THESIS

Binary classification tree models were used to create predictive geospatial maps of canopy mortality in burned areas of northwest Wyoming. Canopy mortality represented a measure of burn severity that could be easily detected using overhead sensors, is quantifiable, and important for fire and resource managers to document. Field estimates and digital orthophotography were used to collect 694 observations of percent mortality, which were used as model training data. A suite of Landsat (TM and ETM+) indices widely used for burn severity mapping were employed as predictor variables to determine the best model combinations. Additionally, ancillary geospatial data from pre-fire images, digital elevation models, vegetation maps, drought indices, and fire locations were also used.

According to results from an array of spatial model comparisons and independent tests using new observations, it is possible to produce reasonably accurate maps of three canopy mortality categories in burned areas. These have applications for vegetation and fuels management, hydrologic assessments, and wildlife habitat conservation. Photo- and field-based canopy mortality estimates performed comparably in model development. The 80-100% canopy mortality category was most accurately mapped, followed by the 0-20% class. The middle category (25-75% mortality) was poorly predicted.

Three spatial resolutions of model development were compared, including .07, 1, and 5 hectare mortality estimate areas with identical focal mean aggregations for raster data layers. The most accurate results came from the .07 hectare scale analysis, using the original 30 meter pixel resolution Landsat TM and ETM+ raster image products. A relative change detection index (the relative differenced Normalized Burn Ratio)
performed better at this resolution than an absolute index (the differenced Normalized Burn Ratio). The coarser resolution analyses were hampered by overgeneralization, misclassifications along patch boundaries, and unbalanced proportions of classes in the training data. At the 1 and 5 hectare resolutions, mapping of the middle mortality category was further compromised because it was composed of a combination of adjacent burned patches rather than a forest with some trees killed and others remaining.

While Landsat TM and ETM+ products can be used to map some distributional patterns of canopy mortality in burned areas, such as those resulting from crown fire, the smaller-scale heterogeneity of mixed lethal burns is not adequately captured. Map users must be aware of this limitation, in order to avoid misconceptions about the true nature of fire disturbances.
ACKNOWLEDGEMENTS

This research was made possible through Cooperative Agreement H1200040001, administered by the Rocky Mountains Cooperative Ecosystem Studies Unit (RM-CESU), with funding was provided by the National Park Service Fire Program. The Natural Resource Ecology Laboratory at Colorado State University contributed technical and logistical support. The Principal Investigator and Research Adviser for the project was Dr. Mohammed A. Kalkhan. I am very grateful to the talented and dedicated people at these institutions who supported my graduate school experience.

I would like to specifically thank my thesis committee for their time, attention and great ideas.

Mohammed Kalkhan
Melinda Laituri
Monique Rocca
Dave Theobald

The following personal friends, esteemed colleagues, and teachers have helped me immensely with aspects of this thesis and my graduate experience at Colorado State University. They provided invaluable ideas, assistance, and support.

Pete Barry
Nate Benson
Nancy Bockino
Cory Bolen
Kate Cueno
Lisa Elenz
Stephen Howard
Linda Kerr
Carl Key
Kelly McCloskey
Mack McFarland
Kristen Meyer
Eric Miller
Jay Miller
Penny Morgan
Kara Paintner
Robin Reich
Joel Silverman
Andi Thode
Brett Wolk

I also thank my family for their patience and encouragement.

Paul Abendroth
Susan Abendroth
Randy Frazier
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABSTRACT OF THESIS</td>
<td>i</td>
</tr>
<tr>
<td>ACKNOWLEDGEMENTS</td>
<td>iii</td>
</tr>
<tr>
<td>CHAPTER 1: INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td>Preface</td>
<td>1</td>
</tr>
<tr>
<td>Literature Review</td>
<td>2</td>
</tr>
<tr>
<td>Remote Assessments of Burn Severity</td>
<td>3</td>
</tr>
<tr>
<td>Definitions of Burn Severity</td>
<td>9</td>
</tr>
<tr>
<td>Canopy Mortality as a Measure of Burn Severity</td>
<td>12</td>
</tr>
<tr>
<td>Spatial Resolution</td>
<td>13</td>
</tr>
<tr>
<td>Positional Errors</td>
<td>15</td>
</tr>
<tr>
<td>Classification Tree Models</td>
<td>16</td>
</tr>
<tr>
<td>Methods</td>
<td>19</td>
</tr>
<tr>
<td>Model Data Selection and Preparation Processes</td>
<td>19</td>
</tr>
<tr>
<td>Study Area</td>
<td>20</td>
</tr>
<tr>
<td>Dependent Variable: Estimates of Percent Canopy Mortality</td>
<td>23</td>
</tr>
<tr>
<td>Predictor variables: Selection and Preparation</td>
<td>25</td>
</tr>
<tr>
<td>Classification Tree Modeling Using R</td>
<td>30</td>
</tr>
<tr>
<td>Accuracy Assessment</td>
<td>30</td>
</tr>
<tr>
<td>Canopy Mortality Sampling Considerations</td>
<td>31</td>
</tr>
<tr>
<td>Literature Cited</td>
<td>37</td>
</tr>
<tr>
<td>CHAPTER 2: USING SATELLITE IMAGERY TO MAP POST-FIRE FOREST CANOPY MORTALITY CLASSES IN NORTWEST WYOMING</td>
<td>45</td>
</tr>
<tr>
<td>Abstract</td>
<td>45</td>
</tr>
<tr>
<td>Introduction</td>
<td>46</td>
</tr>
<tr>
<td>Background</td>
<td>48</td>
</tr>
<tr>
<td>Methods</td>
<td>51</td>
</tr>
<tr>
<td>Study Area</td>
<td>51</td>
</tr>
<tr>
<td>Data Preparation</td>
<td>52</td>
</tr>
<tr>
<td>Classification Tree Model Development</td>
<td>56</td>
</tr>
<tr>
<td>Accuracy Assessment</td>
<td>58</td>
</tr>
<tr>
<td>Results and Discussion</td>
<td>59</td>
</tr>
<tr>
<td>Classification Tree Model Structure</td>
<td>59</td>
</tr>
<tr>
<td>Classification Tree Model Performance</td>
<td>64</td>
</tr>
<tr>
<td>Summary and Conclusions</td>
<td>69</td>
</tr>
<tr>
<td>Literature Cited</td>
<td>71</td>
</tr>
<tr>
<td>CHAPTER 3: MAPPING CANOPY MORTALITY IN BURNED LANDSCAPES OF NORTWEST WYOMING, USA: EFFECTS OF CHANGING SPATIAL RESOLUTION</td>
<td>77</td>
</tr>
<tr>
<td>Abstract</td>
<td>77</td>
</tr>
<tr>
<td>Introduction</td>
<td>78</td>
</tr>
</tbody>
</table>
CHAPTER 1: INTRODUCTION

Preface

Wildland fire effects mapping using remote sensing has become a standard practice for large fires on federally managed land (Miller and Yool 2002, Lentile et al 2006, Kolden and Weisberg 2007). Landsat-5 TM and Landsat-7 ETM+ imagery has become the most common source for burn severity assessments based on the Normalized Burn Ratio (NBR) (Hudak et al 2004b). As more and larger fires are occurring in the Rocky Mountains West (Westerling et al 2006), land managers and wildland fire researchers must rely on remote sensing to collect fire effects data (van Wagendonk et al 2004). It is necessary to understand how burn severity maps made using remote sensing data reflect actual fire effects on the ground (Hudak 2006, Thode 2006). Both thematic correctness and positional accuracy in geographic space must be considered. Armed with knowledge about the capabilities and limitations of mapping fire effects from satellite-based sensors, more informed assessments can be made from these maps, and additional geographic analyses can be applied as appropriate.

The objectives of this study were twofold. First, percent canopy mortality in burned forests was investigated to see whether it can be used as a quantitative and consistent index of burn severity, detectable using remote sensing. Second, it explored the relationships between spatial resolution, fire behavior, and patch heterogeneity in remote sensing of fire effects.

Several Landsat (TM and ETM+) burn severity indices, as well as additional geospatial data including forest type and topography were evaluated as predictor variables for modeling canopy mortality. Predictive geospatial models were developed using
binary classification trees, and used to generate map surfaces. As part of this investigation, Chapter 2 compares two methods for obtaining geo-referenced observations of percent canopy mortality for use in model development, ground estimates and remote estimates using digital orthophotography. In addition, three classification systems, with two, three, and five mortality categories respectively, were modeled to indicate the degree of map precision attainable. This chapter demonstrates model utility for new observations (such as different fires) using accuracy assessments with independent data.

Chapter 3 addresses the second research objective. It explores the performance of three spatial resolutions (.07, 1, and 5 hectares) for canopy mortality mapping using classification tree models. The benefits and drawbacks of these spatial aggregations are explored in the context of model accuracy, fire behavior processes, and associated patterns of effects. Spatial resolution limits the discrimination of surface patterns depending on their size, making finer-scale heterogeneity in fire effects difficult to observe (Rocca 2004, Key 2006, Lentile 2006). However spatial aggregation helps to reduce positional and misregistration errors that also degrade accuracy (Townshend et al 1992, Goodchild 1994). Chapter 3 uses classification tree models based on a range of spatial resolutions to show how these tradeoffs affect detection of canopy mortality. Model accuracy assessments indicate a fire behavior threshold beyond which patterns of fire effects cannot be adequately detected using Landsat Remote Sensing.

**Literature Review**

Burn severity mapping studies forge together concepts and techniques from several disciplines including Remote Sensing, Fire Science, Forest Ecology, Geography,
and Statistics. In order to understand how mapping of fire effects is possible, and how these maps reflect fire’s disturbance to the landscape, it is necessary to understand the state of scientific knowledge in these areas. The following literature review provides such context for several topics relevant to this thesis research.

Remote Assessments of Burn Severity

Beginning in the mid 1980’s, remote sensing using multi-spectral satellite imagery technology greatly facilitated studies of fire disturbances (e.g. Jakubauskas et al 1990, Turner and Romme 1994). Early satellite-based fire studies showed that remote sensing was well suited to mapping fire scars and detecting different levels of damage to vegetation and soils (White et al 1996). These studies also demonstrated more spatial heterogeneity in fire effects than was previously thought to exist (Turner et al 2003). More recently, availability of satellite imagery and advances in Geographic Information Systems (GIS), coupled with the need to demonstrate and understand the heterogeneous effects of fire, has brought about a demand for burn severity mapping on public lands using remote sensing (Brewer et al 2005, Lentile et al 2006).

After the 1988 fires in Yellowstone National Park, Turner et al (1994) used Landsat TM images to classify three levels of burn severity in order to assess spatial patterns of fire effects. Their severity classes included crown fire, lethal surface fire, and light surface burn. They used supervised image classification using the GRASS 4.0 i. maxlik program within the burn perimeters to map the three levels based on the spectral reflectance of known points on the ground.

Jakubauskas et al (1990) first used a ratio of two Landsat bands to map burn severity. They mapped three qualitative severity levels in a Michigan fire using the
Environmental Vegetation Index (Near IR/Red). Lopez-Garcia and Caselles (1991) pioneered a normalized difference in the near and middle infrared reflectance of Landsat bands 4 and 7 to map the extent of forest fires in Spain. This method was later termed the Normalized Burn Ratio or NBR. The NBR uses the same differencing relationship used in the Normalized Differenced Vegetation Index (NDVI); however the middle Infrared Band (Band 7) is subtracted from the near infrared band (Band 4) instead of the visible red portion of the spectrum (Band 3). The NBR equation (1) is normalized by dividing by the sum of the two bands, thus it has a scale of -1 to 1. The result is multiplied by 1000 to remove the decimal (Key and Benson 2006).

\[
NBR = \frac{\text{NearIR(band 4)} - \text{MidIR(band 7)}}{\text{NearIR(band 4)} + \text{MidIR(band 7)}} \times 1000
\]  

(1)

The comparison of near infrared to middle infrared wavelengths emphasizes the differences in burned areas for two reasons (White et al 1996). Near infrared radiation is strongly reflected by photosynthesizing plants, so that weakened or defoliated vegetation following a fire has a reduced reflectance. Middle infrared is absorbed by plants mainly because of foliar moisture content. Dead vegetation and exposed soil (after canopy removal by fire) are much more reflective in this wavelength category. Blackened soils, like dark pavement, emit middle infrared radiation even more strongly (Jensen 2000). Lopez-Garcia and Caselles (1991) also noted that the thermal infrared (Band 6) reflectance alone was sensitive to burned areas due to the heat emitted from blackened soils as well as reduced green, moist vegetation cover.

White et al (1996) explored the use of Landsat TM image band ratios to detect gradients in the severity of fires, not just the distribution of burned areas. They hypothesized that low severity burned areas would correspond to less change in surface
reflectance relative to more severely burned areas. They evaluated a number of Landsat band combinations as well as the NDVI and NBR in comparison to ground plots. They also applied these processes to images of burned areas taken after recovery over one growing season had occurred.

Of all Landsat bands, the middle infrared band 7 was the most sensitive to burn severity in forest vegetation according to White et al (1996). It showed the widest spread of reflectance values within a burn perimeter. The near infrared band (band 4) was not as sensitive to severity, but strongly detected removal of foliar biomass and re-growth post burn. Together, the two captured both the physical and biological effects of fire. The use of a one year post fire image versus one from immediately post fire provided greater sensitivity because the patterns of plant regeneration responded to otherwise unseen effects on soils, litter, and understory plants (White et al 1996).

After a season of many large fires in western forests in 2000, the National Park Service began using a differenced NBR comparing pre- and one year post-fire to investigate burn severity mapping. The differenced NBR (or dNBR) is a subtraction of the post fire NBR from the pre fire NBR (Equation 2):

$$dNBR = Pre-fire \ NBR – Post-fire \ NBR$$ (2)

Key (2006) described three approaches to burn severity mapping, with different timing of post-fire imagery. First, “rapid assessment” burn severity maps are made from immediate post burn dNBR indices, with utility for obtaining time-sensitive information for fire operations and public education. DNBR products from one or two months post fire provide “initial assessments” of severity with greater accuracy because the fire has been controlled and smoke is less likely to diminish image quality. These maps highlight
crown fire areas most effectively, and give resource managers a useful map for follow-up management planning. The third approach to burn severity mapping is the “extended assessment,” which is made from comparison of pre-burn NBR with one year post burn NBR are capable of better differentiation of fire effects because re-growth patterns can be incorporated. If users are willing to wait until one-year post burn imagery is obtained, the extended assessment approach can provide superior maps for both fire ecology and resource management applications (Key 2005).

The differenced Normalized Differenced Vegetation Index (dNDVI) (Equation 3) has also been used to map burn severity, but has not performed as well as dNBR in western North America (Zhu et al 2006, Miller and Thode 2007). Studies in Australia (Hammill and Bradstock 2004) and Spain (Diaz-Delgado et al 2001) have successfully used dNDVI to map foliar damage and recovery due to fire.

\[ d\text{NDVI} = \text{Pre-fire NDVI} - \text{Post-fire NDVI} \tag{3} \]

Because the dNBR is an absolute measure of change for each pixel, the amount of initial, pre-fire vegetation can strongly influence the magnitude of absolute pre and post differences (Miller and Thode 2007). This problem can cause misclassification of burn severity levels because plant mortality due to fire is poorly detected in sparsely vegetated areas. Miller and Thode (2007) proposed the relative dNBR (RdNBR) algorithm to compensate for this, which they have demonstrated to be successful in a variety of western vegetation types. Because Band 7 reflectance is boosted in areas with burned soils, the relationship between dNBR and ground measures of severity is nonlinear (Miller and Thode 2007). To compensate, a square root transformation is incorporated in the RdNBR equation (4):

\[
RdNBR = \left( \frac{Pr eFireNBR - PostfireNBR}{\sqrt{|Pr eFireNBR/1000|}} \right)
\]  

(4)

Similarly, dNDVI can be relativized by dividing dNDVI by pre-fire NDVI (Equation 5). No transformation is needed because Band 3 does not exhibit boosted reflectance from burned soils (Miller and Thode 2007).

\[
RdNDVI = \left( \frac{Pr eFireNDVI - PostfireNDVI}{Pr eFireNDVI} \right) \times 1000
\]  

(5)

In 2004, the dNBR method was adopted in the U.S. by the multi-agency Wildland Fire Leadership Council’s Monitoring Trends in Burn Severity (MTBS) program for creation of a nationwide burn severity atlas (Eidenshink et al. 2007, Lentile et al. 2006). In this effort, the U.S. Forest Service and the U.S. Geological Survey are jointly producing dNBR burn severity maps for all wildland fires larger than 1000 acres (500 acres in the East). RdNBR maps will also be made available in some cases.
The MTBS burn severity mapping is retro-active to 1984, using archived Landsat TM and ETM+ images.

There are several main causes of burn severity mapping thematic inaccuracy using remote sensing, which hold true for all reflectance indices. Overstory canopy vegetation obstructs the patterns of fire effects on the ground surface (Patterson and Yool 1998, Bobbe et al 2001, Miller and Yool 2002, Sanchez-Flores and Yool 2004, Cocke et al 2005, Lentile et al 2006). The spatial resolution of the sensing instruments cannot always discern small spot fires or burned patches (Bobbe et al 2001, Key 2006, Lentile et al 2006, Roy 2006). Plant regrowth following a fire sometimes masks the reflectance changes caused when the fire killed the original vegetation (Key 2005, Key and Benson 2006). Positional errors inherent in the use of geospatial data, particularly remote sensing, can lead to false change detection (Townshend et al 1992, Goodchild 1994). Variability in solar angle and shadow effects can also cause false changes depending on image seasonality (Key 2006, Kolden and Weisberg 2007). These sources of error are inevitable given the limitations of the available technology.

**Definitions of Burn Severity**

Differenced NBR and NDVI reflectance indices have been compared to burn severity levels on the ground in a number of test studies (White et al 1996, Zhu et al 2006, Key 2006, Miller and Thode 2007). In order to evaluate these relationships, it is necessary to understand how burn severity has been defined. The generally accepted definition of burn severity is the degree of ecological disturbance or change in ecosystem components (Ryan 2002, van Wagendonk et al 2004, Key and Benson 2006). Unlike “fire intensity,” which is a measurable quantity in terms of heat per unit area per unit of
time used in fire behavior predictions (Neary et al. 2005); “burn severity” is a qualitative measure.

Many classification systems have been used to evaluate burn severity, most of which use categories such as “low,” “moderate,” and “high” (Robichaud et al. 2007). Low severity fire effects are more ephemeral, and cause little impact on the structure and function of a community, while high severity effects include major changes in plant composition, nutrient balance, and hydrologic function for a long period of time (Lentile et al. 2006). These classifications can be subject to individual judgment, and may differ substantially between vegetation types and geographic regions (Hudak 2006, Key and Benson 2006, Lentile et al. 2006). Further, cultural bias is evident in some definitions of burn severity, for example Simard (1991) defined burn severity as the significantly negative fire impacts to wildland systems and society.

Often burn severity is rated according to the effects of fire on whichever resource impacts are under consideration (Jain and Graham 2007). In forested areas, severity classes are often closely associated with the effects to the overstory (Diaz-Delgado et al. 2001, Hammill and Bradstock 2004, Lentile et al. 2006). The definition of high severity is sometimes equated with stand replacing fire (e.g. Agee 1998, Miller and Thode 2007). On the other hand, burn severity maps created for erosion mitigation reflect the distribution of related effects such as litter consumption and char depth (Bobbe et al. 2001, Hudak 2004ab, Neary et al. 2005).

Care must be taken to avoid confusing tree-based burn severity maps with those based on ground effects. This can cause misconceptions about a fire’s ecological impact, or even the nature of a fire regime (see Safford et al., in press). Fire effects to overstory
vegetation and soils occur as a result of different aspects of fire behavior (fire intensity versus fire duration), and are independently distributed (van Wagtendonk et al 2004, Neary et al 2005, Jain and Graham 2007). In fact, different predictive models are used to describe the two (Ryan 2002). A fast-moving crown fire can destroy the overstory of a forest while having mild effects on the understory and soil. A surface fire burning though large, heavy fuels can smolder for hours or days, causing lethal damage deep in the soil (Ryan 2002, Neary et al 2005).

Ryan and Noste (1983) developed a protocol and rating system for field assessment of burn severity that incorporates separate field ratings for these distinct effects to the overstory and soil surface. They explained that these severity patterns are linked to two processes; above and below the ground surface. The heat pulse down into the soil is a function of fire residence time associated with smoldering logs and duff (Ryan 2002). The heat pulse experienced by above-ground vegetation corresponds to flame length, which is a measure of fire intensity determined by slope, wind speed, fuel physical and chemical characteristics, and fuel moisture (Rothermel 1972). This dual view makes a crucial link between fire behavior processes and severity patterns. While conceptually elegant, the Ryan and Noste (1983) burn severity rating system is ground-based and not easily applied to remote sensing.

In the field of remote sensing, fire severity is overall magnitude of change determined by the sensors over a given pixel (Diaz-Delgado et al 2001, Zhu et al 2006). These changes are influenced by fire behavior, vegetation, and terrain, so field validation is needed to interpret what the recorded changes actually are. Today, most comprehensive assessments of burn severity attempt to involve a combination of soil and
overstory effects (Miller and Yool 2002). In forested environments, remotely sensed burn severity maps are often better correlated with overstory mortality than soil effects that are obscured beneath the canopy (Patterson and Yool 1998, Bobbe et al 2001, Sanchez-Flores and Yool 2004, Cocke et al 2005, Lentile et al 2006).

Key and Benson (2006) produced a manual for undertaking burn severity mapping, and developed a methodology for making ground measurements of severity for map calibration and accuracy assessment. This manual includes a field protocol for characterizing ecological change on the ground, called the Composite Burn Index (CBI). CBI plots are temporarily installed on the ground in burned areas, and geo-referenced for comparison with dNBR pixel values. They provide a means of calibrating dNBR derived burn severity maps. CBI plots record rankings from 0 (unburned) to 3 (most severe) for ecological change in each layer of a plant community; soil surface, understory, shrub layer, intermediate trees, and overstory trees.

**Canopy Mortality as a Measure of Burn Severity**

Due to canopy interference, it is difficult to map fire effects on the ground using remote sensing, at least in forested vegetation (Hudak et al 2004a, Cocke et al 2005, Kasischke 2006, Murphy 2006). One exception would be in areas where high severity canopy fires remove the obstructing trees (Bobbe et al 2001, Cocke et al 2005). Since soil and canopy effects are often distributed independently, it would be appropriate to map them separately (Neary et al 2005).

While it may be unrealistic to map many ground surface effects in forested vegetation using remote sensing, canopy effects are much more visible from space. In forested environments, remotely sensed burn severity products are often highly correlated
with effects on overstory vegetation (Hudak et al 2004ab, Lentile et al 2006, Miller and Thode 2007). Because of these sensitivities, Landsat-derived indices can be used (in combination with ancillary data) to make maps of canopy mortality.

In forested ecosystems, canopy mortality is a tangible, ecologically significant expression of burn severity. Ryan and Noste (1983) suggest that the ideal burn severity classification system would identify tree mortality. At the ecosystem scale, fire regimes are described in terms of whether or not overstory trees are killed (Turner et al 1994, Arno 2000, Arno et al 2000, Morgan et al 2001). Percent canopy mortality would provide the means to a measurable and consistent mapping approach. Many fire ecologists have expressed the need for a quantitative characterization of burn severity that would allow comparisons between fires, vegetation types, and fire seasons (Miller and Yool 2002, Brewer et al 2005, Lentile et al 2006, Jain and Graham 2007). Maps of percent canopy mortality would give a more descriptive and concrete basis for decisions about post-fire land management, some of which have far reaching environmental and economic effects.

Not only does it appear quite feasible to map canopy severity using remote sensing techniques, the ecological and management implications of these effects are of high importance. The spatial distribution of fire-induced tree mortality dominates ecosystem function across the landscape for decades or more (Ryan 2002, Turner et al 2003, Neary et al 2005). The amount of edge between patches of stand replacing, partial mortality, and unburned forests is important to understand because of its benefits for ungulate browse (Turner and Romme 1994). Other species affected include tree insects, cavity nesting birds, and forest carnivores (Ryan 2002, others). Stand replacing fires
represent greater risk for invasive species (Hudak et al. 2004b). With decreased evapo-
transpiration and rainfall interception, burned forests change the surface and subsurface
hydrology (Turner et al. 1994). They represent socio-economic impacts and due to
reduced recreation potential and risk factors for the wildland urban interface (Miller and
Yool 2002). Stand replacing fires also can represent timber harvest (salvage)
opportunities. Future fuel loading and accumulation also is a function of fire pattern
(Hely, Bergeron, and Flannigan 2000, Turner et al. 2003). The burn patch sizes, degree of
overstory removal, and distances to seed sources will affect plant succession, providing
data for modeling updates to vegetation and habitat maps in burned areas (Turner et al

Spatial Resolution

The spatial resolution of remote sensing imagery inherently limits accurate
mapping of fire effects in a GIS (Moody and Woodcock 1995, Lertzman et al. 1998,
Hudak et al. 2004b, Key 2005). This is because each pixel value in a satellite image
represents the mean reflectance of all surfaces within that unit. If there is heterogeneity
in the reflectance properties within the pixel, these patterns are indistinguishable
(Goodchild 1994). This is particularly problematic where fire effects vary at the
individual log or tree scale (Key 2005), or along patch boundaries (Cao and Lam 1997).
Patch boundary pixels, by definition, have a mix of fire effects. With fewer of these
mixed pixels (due to smaller pixels or less edge on the ground), there is less overall
confusion and greater map accuracy (Cao and Lam 1997). In a burn severity mapping
study using Landsat and airborne AVIRIS sensors, van Wagendonk et al. (2004) showed
that the relationship between CBI ground plots and dNBR pixel values depended on the
spatial resolution (pixel size) of the sensor. Roy (2006) found that the fine scale of pattern and spectral characteristics of fire effects in African savannahs were not adequately detected by the NBR using Landsat imagery.

The spatial heterogeneity of fire effects on overstory trees, the scale at which they occur, and the ability of remote sensing to detect tree mortality, together suggest fundamental elements of landscape ecology. Turner and Romme (1994) illustrated that the mechanisms that control the ignition and spread of fires dictate the spatial patterns of fire effects. Fire behavior processes are therefore borne out in the patterns of burn severity on the landscape. To understand how to best map burned landscapes using GIS analyses, one must consider the operational scales at which the underlying processes (in this case fire) operate (Levin, 1992).

Fire spread processes that occur according to fine scale distributions of fuels, microclimate, and topography will also be obscured at the 30 meter pixel resolution. Many burn severity mapping studies show that low and moderate categories are more difficult to discriminate (Patterson and Yool 1998, Bobbe et al 2001, Sanchez-Flores and Yool 2004, Cocke et al 2005). Confusion results from the sub-pixel mosaic of burned and unburned patches. Mixed areas are mapped depending on their respective proportions.

Severely burned areas are more spatially homogeneous than low and moderate burns (Turner et al 1994, Hudak et al 2004a). Such areas are therefore more likely to be effectively detected at the 30 meter pixel spatial resolution.

*Positional Errors*
All analysis of remote sensing imagery is subject to some degree of registration error. Despite advanced geo-rectification and terrain correction methods using ground control points and digital elevation models, it is not possible to align pixels perfectly with their corresponding geographic locations in GIS (Verbyla and Boles 2000). Goodchild (1994) cautioned that the true location of a given pixel’s central point may be anywhere within the nine pixels in a 3x3 array surrounding the point. Additionally, the coordinates of a point on the ground may be as far as 2 pixels away from the one it appears to intersect.

When two images are compared in the case of change detection, the degree of offset in the position of each grid can introduce misregistration errors that mask or artificially inflate real changes (Dai and Khorram 1998, Verbyla and Boles 2000). Townshend et al (1992) recommended that registration accuracy within .2 of a pixel is necessary for less than 10% error in change detection classifications. They noted that customary user specifications for image overlays are less stringent - only between half and one pixel. In a simulation study of misregistration errors in change detection, Dai and Khorram (1998) found that among the 7 Landsat TM bands, band 4 (NIR) is the most sensitive. Unfortunately this band is a major component of the NBR and NDVI indices used for burn severity mapping.

Smoothing filters based on a moving window for mean pixel values are often used to help minimize noise from image misregistration (Verbyla and Boles 2000). The benefits of such methods, coupled with the drawbacks of coarser resolution due to pixel aggregation present interesting tradeoffs for mapping canopy mortality in burned areas.
This is particularly true where the scale of spatial heterogeneity in burn patches approaches that of image resolution (Key 2006).

*Classification Tree Models*

Most studies in which NBR or NDVI indices are used for burn severity mapping use regression models to predict severity based on CBI plots or similar field observations (White et al 1996, van Wagendonk et al 2004, Brewer et al 2005, Zhu et al 2006, Miller and Thode 2007 and others). This study explores an alternative - Classification and Regression Tree (CART) analysis - to explore the relationship between canopy mortality and several predictive variables to map stand replacing fire effects. The following is a summary of CART methods, advantages, and caveats for use.

CART models do not have the limiting assumptions about data normality and error distributions that regression models do, because they are not based on probability distributions (Lawrence and Wright 2001). Rather, they operate according to observed patterns (Urban 2002). Consequently, they have several advantages for fire studies, which are prone to spatial dependency (Bataineh et al 2006).

When CART is used to predict continuous variables, “regression trees” are created, which predict average numeric values for the dependent variable. “Classification trees” predict the probability of membership in a category, and are created using categorical dependent variables (Urban 2002).

With a set of training data, CART models make a series of binary splits (or branches) derived from an iterative process that finds the single level of one of the predictor variables that most reduces the overall deviance (Urban 2002). A computer algorithm compares the deviance (2 log likelihood statistic) of the data with no
partitioning versus each possible split, choosing the one with the greatest difference (reduction in deviance). The same process is applied to the resulting groups until specified criteria are met, and the tree is complete. The terminal nodes of the tree are called leaves. For each leaf, a class is assigned, and the percent of correctly assigned observations (probability of correct classification) is given.

The first few splits in the tree represent patterns that segregate groups on a broad scale, and are considered the most useful predictors. The longer the node in the tree diagram, the more important the split in terms of reducing deviance and increasing the homogeneity of the two resulting groups (Urban 2002). Variables higher in the tree explain more of the variance between observations, and therefore represent their hierarchical importance (Michaelsen et al 1994, Amatulli et al 2006). Lower branches represent more localized or interactive processes that distinguish group membership at a more subtle level (Sanchez-Flores and Yool 2004). Variables that are re-used at different levels in the tree indicate a non-linear relationship to the dependent variable (Simard et al 2000, Coops et al 2006).

The advantages of CART lie in their ease of use, flexibility with respect to input data, and easy interpretability (Lawrence and Wright 2001, Urban 2002, Perlich et al 2003, Amatulli et al 2006). Because classification trees function by identifying variables that best distinguish groups, they are able to handle complex interactions that make sense ecologically but are difficult to describe with conventional regression models. In this way, CART helps to identify the real environmental thresholds that are associated with group differences (Michaelsen et al 1994, Simard et al 2000, Lawrence and Wright 2001, Perlich et al 2003).
For this study, an important advantage of CART modeling is that each predictor variable has a chance to be considered with every partitioning step. This has allowed comparison of several similar burn severity indices (NBR post fire, dNBR, RdNBR, dNDVI, and RdNDVI). In a regression model, these inputs would be expected to exhibit multicollinearity because they are inherently similar (Ott and Longnecker 2001). CART modeling does not have the problems of variance inflation found in regression (Simard et al 2002). Instead, the best predictor is simply picked.

Classification and regression trees work best with large datasets. Perlich et al (2003) recommended at least 700 observations. Very small datasets tend to predict badly (Mingers 1989). Tree models are completely representative of the training data, and therefore the derived splitting rules are only suitable for equivalent data base ranges (Coops et al 2006). Extrapolating a model beyond the training data is risky without independent testing (Amatulli et al 2006).

Classification and regression trees usually need to be pruned, because they are overfitted to noise and chance occurrences and particularities of the training data rather than real relationships (Hansen et al 2000). This also helps to simplify them, because they are often more complex than necessary (Esposito et al 1997, Amatulli et al 2006). The lowest branches of a tree model tend to be the least reliable (Urban 2002). Pruning will increase the misclassification rates on the training dataset but will reduce the errors made on an independent test (Mingers 1989, Lawrence and Wright 2001, Sanchez-Flores and Yool 2004). Pruning tree models also helps to improve their interpretability and utilization (Esposito et al 1997, Amatulli et al 2006).
The most widely used method for pruning in CART involves cross validation, usually with subsets made by randomly splitting the data into ten even-sized groups. Ninety percent of the data is used to construct the tree model under study, with 10% reserved for testing it. This is repeated ten times Monte Carlo fashion (Urban 2002). Initially, each new split reduces the residual mean deviance. As more nodes are added, however, it begins to increase again, as independent test performance falls off. It is best to prune off splits at this point, because these partitioning rules are not likely to apply outside of training dataset (Michaelsen et al 1994).

**Materials and Methods**

*Model Data Selection and Preparation Processes*

This section provides a comprehensive description of the research process flow from variable selection to modeling of canopy mortality in the burned areas of northwest Wyoming (Figure 1). These methods were ultimately employed in the investigations described in both Chapter 2 and Chapter 3, but the following includes more detail about processes and rationale for modeling choices. Geographic data preparation steps are described in detail in Appendix A, and statistical analysis scripts are located in Appendix B.
Figure 1. Overall process diagram for data preparation, extraction, modeling, and accuracy assessment for this research on canopy mortality mapping in burned areas of northwest Wyoming.

**Study Area**

This study encompasses three administrative units of public land in Western Wyoming, including the Bridger-Teton National Forest (BTN), Grand Teton National Park (GTNP), and Yellowstone National Park (YNP) (Figure 2). These areas comprise approximately 2.4 million hectares of public land with complex geology, varied mountain climate patterns, and diverse flora (Steele et al 1983). The study area features a mosaic of forested and non-forested vegetation distributed according to microclimate, soil types, and fire disturbance history (Looke and Gruell 1973). Elevations range from roughly 1800 meters to peaks over 4000 meters. Seasonal patterns of temperature and precipitation are characterized by cold, snowy winters, rainy springs, and moderately

Five main forest communities are found in the study area, characterized by the following dominant trees and associations: 1) Douglas-Fir (*Pseudotsuga menziesii*), 2) subalpine fir (*Abies lasiocarpa*) – Englemann spruce (*Picea englemanii*), 3) lodgepole pine (*Pinus contorta*), 4) high elevation whitebark pine (*Pinus albicaulis*) with spruce-fir, and 5) aspen (*Populus tremuloides*) (Steele et al 1983, Bradley et al 1992).

![Study Area Map](image)

Figure 2. Study area map showing YNP, GTNP, and BTN in northwest Wyoming, with 23 fires and three Landsat scenes.

The most significant ecological disturbance agent affecting the forest types of the study area is fire (Loope and Gruell 1973, Clark 1981, Agee 1998). Two types of fire
regime have been attributed to these forest types; “stand replacing” and “mixed severity” (Turner et al 1994, Arno 2000, Arno et al 2000, Morgan et al 2001). Fire regimes are characterizations of an ecosystem’s fire processes, ecological effects, spatial characteristics and temporal frequency (Lertzman 1998, Agee 1998, Brown 2000). The factors that determine a fire regime are thought to be climate, vegetation, and topography (Morgan et al 2001). In stand replacing fire regimes, burn patch sizes can be very large, especially with sustained high winds (Turner et al 1994, Bessie and Johnson 1995, Miller and Urban 2000). Within these fires, some live trees remain due to variations in topography, fuels, and burning conditions (Lertzman 1998, Arno 2000, Turner et al 2003). Fire return intervals can be over 200 years (Brown 2000). Stand replacing fire regimes occur in lodgepole pine, spruce-fir, Whitebark pine, aspen, and Douglas-fir forests (Arno 2000). Fire intervals can be centuries apart, with most burning occurring during extremely dry years (Looke and Gruell 1973, Clark 1981).

Mixed severity fire regimes are also associated with lodgepole pine, spruce-fir, Whitebark pine, and Douglas-fir forests (Arno 2000). A mixed severity regimes has more variability in fire behavior, effects, return intervals, and patch sizes than is found in a stand replacement regime. The mixed severity regime has been described as both a mid-range disturbance type (between surface and stand replacing), and as a spatial or temporal juxtaposition of two or more different fire regimes on a landscape (Agee 1998, Lertzman et al 1998, Arno 2000, Lentile et al 2006). Several forest types including Douglas-fir, lodgepole pine, and whitebark pine have been attributed to both fire regime types (Arno 2000). Fire return intervals in mixed severity fire regimes can be 35 to over 100 years (Brown 2000).
The distinction between stand replacing and mixed severity regimes is not always clear. Arno (2000) suggests that the two fire regimes can overlap both spatially and temporally, according to both topographic variability and site productivity. With the degree of overlap between these two fire regime characteristics, it is reasonable to consider that they are not actually distinct from one another in this study area. Rather, a single fire regime can be conceived to exist along a spatial and temporal spectrum (as described by Ryan 2002 for the boreal forest). This study explores the patterns of canopy mortality in the burned areas of northwest Wyoming according to this concept of one fire regime operating within a continuum of ecological effects.

A combination of fire suppression, fuels reduction by grazing and logging, and moist weather patterns (Loope and Gruell 1973) tempered the occurrence of large fires in the study area from the 1890’s through the 1970’s. Since the late 1980’s, widespread larger and more lethal wildland fires have occurred throughout the Rocky Mountains (Turner et al 1994, Arno 2000, Westerling et al 2006) despite ongoing suppression programs. The recent fire activity is more characteristic of the stand replacing end of the fire behavior spectrum rather than the mixed severity type.

**Dependent Variable: Estimates of Percent Canopy Mortality**

Estimated percent mortality of overstory canopy cover was compared to an array of predictor variables in classification tree modeling. These estimates were obtained from 694 CBI plots in 23 fires in the study area. Field CBI data were collected by National Park Service field personnel from 2001 – 2004 following the methods of Key and Benson (2006).
For each CBI plot, ocular estimates of percent canopy mortality were recorded for overstory trees in a 30 meter diameter circle. Each plot was located using GPS for comparison with remote imagery in GIS. GPS errors of up to 12 meters were recorded on CBI plot data sheets. Many of these plot locations were not differentially corrected in the office. During 2001 and 2002, the Key and Benson (2006) CBI protocols were in development, and percent overstory tree mortality estimates were not part of this data collection. In these cases, field photographs were used to estimate the percent of overstory trees killed.

In order to evaluate a remote method for measuring canopy mortality (Chapter 2), and study the effects of changing the spatial resolution of analysis (Chapter 3), a second set of mortality observation was obtained. Percent canopy mortality was re-estimated to the nearest 5 percent at all 694 CBI plot locations for three concentric circles using 1 meter digital aerial photography (both true color from 2006 and color infrared from 2001-2002). These sizes of the circles were .07, 1 and 5 hectares. The .07 hectare circles are the same size as CBI plots, which provided an opportunity to compare the two estimation methods (Chapter 2).

Estimated mortality was subsequently classified in three ways, with two, three, and five categories, respectively. This allowed evaluation of the degree of precision possible using the available dataset (Chapter 2). The two-category system uses an 80% mortality cutoff recommended by the Bridger-Teton National Forest for differentiating stand replacing fire in a management context. A middle category of 25-75% was added in the three category system to capture the partial canopy mortality resulting from mixed severity effects. The five-category system further adds 0% and 100% categories to
explore the detection of completely unburned and completely lethal burns. Figures showing the proportions of canopy mortality categories in the plot data are included in Chapters 2 and 3.

**Predictor variables: Selection and Preparation**

A suite of the most commonly used burn severity reflectance indices was employed with Landsat-5 TM and Landsat-7 ETM+ to determine which ones best function as predictor variables to discriminate the mortality classes. These included the NBR of the post-burn scenes, the pre- and one year post-burn dNBR, and RdNBR. In addition, the dNDVI and RdNDVI were added.

Landsat TM and ETM+ 6-band images and pre- and post-fire NBR and dNBR subsets were obtained in Albers Conical Equal-Area projection from the National Burn Severity Mapping website of the United States Geological Survey (USGS) EROS Data Center (http://burnseverity.cr.usgs.gov/download_data.asp). All images provided were terrain corrected and geometrically rectified using ground control points and digital elevation models according to National Land Archive Production System (NLAPS) protocols (Eidenshink et al 2007). Bands 1-5 and 7 are converted to at satellite reflectance, which normalizes image pixel values for differences in sun illumination geometry, atmospheric effects and instrument calibration (Huang et al 2002). Specifications for terrain correction require an average root mean square error of less than one pixel (30m) and differenced image registration errors less than one half pixel (Howard 2006).

The 23 fires included in this study occurred over four summers in a geographic area covering three Landsat scenes. A total of 11 pre- and post-fire pairs of images were
used (Appendix A, Table A-1). Pre- and post-fire NBR and NDVI were generated using
the Image Analysis Extension for ArcGIS 9.1.

In order to remove bias associated with the particular atmospheric and phenologic
characteristics of individual image pairs, dNBR and dNDVI subsets were standardized.
Mean pixel values were computed by sampling adjacent unburned areas in each fire, and
then subtracted from the entire dNBR for each fire prior to combining them into final
mosaic layers (Key 2006). For relative indices, the standardized dNBR and dNDVI were
used when calculating RdNBR and RdNDVI using the ArcGIS Spatial Analyst raster
calculator.

Canopy mortality due to fire results from complex relationships between tree
species characteristics, fire intensity, and the post-fire environment (Wright and Bailey
1982, Diaz-Delgado et al 2001). In order to improve upon the use of remote sensing
change detection for burn severity mapping, GIS layers featuring topography, vegetation
type, and drought were also included in predictive models for this study. Elevation,
slope percent, and aspect layers were obtained from 30 meter resolution USGS Digital
Elevation Models (DEM). Five forest type categories were created from vegetation maps
of GTNP, YNP, and the BTNF, following the fire groups of Bradley et al (1992).

Pre-fire Landsat imagery was transformed using the Tasseled Cap (TCT) method
(Crist and Cicone 1984) in order to examine relationships between vegetation types,
forest structure, and fuels and canopy mortality effects. The TCT is a set of
multiplicative and additive coefficients, which when applied to the six bands of Landsat
imagery, reduce the data volume to three bands called brightness, greenness and wetness
(Crist and Cicone 1984, Lillesand et al 2004). Brightness (TCT-1) is a measure of
overall reflectance in all six Landsat bands. It is sensitive to soil exposure, and is higher for deciduous vegetation than it is for conifer forests (Crist et al 1986). Greenness (TCT-2) increases with photosynthetic vegetation and can also discriminate coniferous versus deciduous trees (Kushla and Ripple 1998). The wetness band (TCT-3) expresses relationships between soil and vegetation (Crist et al 1986). It is sensitive to moisture in vegetation, which enables separation of growing versus senescing or dead plants, and shadows made by different sizes of plants. Wetness has been used to detect structure and woody fuel loading in forests (Kushla and Ripple 1998). In this study, pre-fire TCT bands 1-3 were intended to provide surrogates for vegetation type and woody fuel characteristics. The bands were produced for each pre-fire image with ERDAS Imagine 9.1, and combined into a 23-fire mosaic using ArcGIS 9.1.

Each predictor variable raster was filtered using a circular focal mean algorithm (focal majority for forest type) to compute the focal means for .07, 1, and 5 hectare circles to match the CBI plot canopy mortality estimate areas. ArcGIS 9.1 Spatial Analyst performs focal mean calculations by averaging the values of all pixels that fall within the chosen radii, which in this case were 15, 56.41, and 126.16 meters. In this way, estimates of percent mortality in 5 hectare circles, for example, were analyzed using predictor grids using the corresponding 126.16 radius circular focal means. When the predictor grids were aggregated according to focal means, their numeric distributions became more centralized (Table 1).

Administrative unit (GTNP, YELL or BTNF) was also used in selected models to test for differences in canopy mortality predictions that might exist across the landscapes of the study area (Table 1).
Drought records were used in initial model development to control for climate variation. Annual differences in snow deposition and rainfall play a major role in the fire regime and plant phenology of this study area (Loope and Gruell 1973, Turner et al. 1994, Bessie and Johnson 1995, Arno 2000). Change detection using dNBR and dNDVI indices would likely detect differences in burned areas according to both fuel dryness during burning and the degree of vigor in regrowth the following year. The Palmer “Z” Index was chosen to represent this variation. It gives the moisture anomaly or departure from normal for a given month; with records going back 1900 for individual climate regions (Alley 1984). Positive numbers indicate periods of above normal moisture, while negative numbers correspond to drought.
Table 1. Predictor variables, spatial resolutions, sources, and ranges of values used in modeling canopy mortality in burned areas of northwest Wyoming.

<table>
<thead>
<tr>
<th>Predictor Variable</th>
<th>Spatial Resolution</th>
<th>Data Source, Description</th>
<th>Range of Values (Min-Max)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normalized Burn Ratio (NBR) Post-Fire</td>
<td>30m pixels, unfiltered and focal means for 1.0, and 5.0 hectare circular areas</td>
<td>7 scenes (2001 – 2004) Landsat TM and ETM+</td>
<td>.07h: -507.4 – 722.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1h: -482.4 – 718.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5h: -460.5 – 688.5</td>
</tr>
<tr>
<td>Differented Normalized Burn Ration (dNBR)</td>
<td>11 pairs of scenes (1999 – 2004)</td>
<td>Landsat TM and ETM+</td>
<td>.07h: -242.4 – 1125.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1h: -195.9 – 1116.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5h: -149.1 – 997.2</td>
</tr>
<tr>
<td>Relative differented Normalized Burn Ratio (RdNBR)</td>
<td>11 pairs of scenes (1999 – 2004)</td>
<td>Landsat TM and ETM+</td>
<td>.07h: -17,655.2 – 6087.7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1h: -3884.9 – 5965.9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5h: -1.55 E13 – 4.88 E13</td>
</tr>
<tr>
<td>Differented Normalized Vegetation Index (dNDVI)</td>
<td>11 pairs of scenes (1999 – 2004)</td>
<td>Landsat TM and ETM+</td>
<td>.07h: -69.3 – 582.9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1h: -43.1 – 509.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5h: -65.2 – 458.6</td>
</tr>
<tr>
<td>Relative differented Normalized Vegetation Index (RdNDVI)</td>
<td>11 pairs of scenes (1999 – 2004)</td>
<td>Landsat TM and ETM+</td>
<td>.07h: -266.6 – 3811.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1h: -186.8 – 4369.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5h: -5.9 E12 – 1.7E14</td>
</tr>
<tr>
<td>Pre-fire Tasseled Cap Transformation Brightness (TCT-1)</td>
<td>9 scenes (1999 – 2002) Landsat TM and ETM+</td>
<td></td>
<td>.07h: 54.0 – 168.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1h: 54.6 – 160.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5h: 59.5 – 154.5</td>
</tr>
<tr>
<td>Pre-fire Tasseled Cap Transformation Greenness (TCT-2)</td>
<td>9 scenes (1999 – 2002) Landsat TM and ETM+</td>
<td></td>
<td>.07h: -1.0 – 78.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1h: 2.2 – 77.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5h: 5.7 – 69.7</td>
</tr>
<tr>
<td>Pre-fire Tasseled Cap Transformation Wetness (TCT-3)</td>
<td>9 scenes (1999 – 2002) Landsat TM and ETM+</td>
<td></td>
<td>.07h: -43.0 – 16.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1h: -43.2 – 12.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5h: -43.7 – 9.3</td>
</tr>
<tr>
<td>Elevation (m)</td>
<td>USGS 30 meter DEM</td>
<td></td>
<td>.07h: 1760.9 – 3056.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1h: 1761.0 – 3056.7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5h: 1763.4 – 3059.2</td>
</tr>
<tr>
<td>Aspect</td>
<td>USGS 30 meter DEM</td>
<td></td>
<td>.07h: 0 – 358.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1h: 6.45 – 355.4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5h: 16.5 – 347.2</td>
</tr>
<tr>
<td>Slope (Percent)</td>
<td>USGS 30 meter DEM</td>
<td></td>
<td>.07h: 5 – 73.8</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1h: 0 – 90.7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5h: 1 – 85.9</td>
</tr>
<tr>
<td>Pre-fire Forest Type</td>
<td>GTNP, YNP, and BTNF vegetation maps. Converted to raster and reclassified to 5 forest types and non-forested.</td>
<td></td>
<td>1 = Douglas-Fir</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 = Spruce – Fir</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 = High Elevation Spruce – Fir</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4 = Lodgepole Pine</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5 = Aspen</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6 = Non-forested</td>
</tr>
<tr>
<td>Palmer’s Drought Severity Index Z Index of Mean Departure</td>
<td>Climate divisions for Wyoming: Month of fire, June, July, August (JJA) average for fire season, JJA average for year following fire</td>
<td>NOAA National Climatic Data Center <a href="http://www7.ncdc.noaa.gov/CDOD/DivisionalSelect.jsp">http://www7.ncdc.noaa.gov/CDOD/DivisionalSelect.jsp</a></td>
<td>Month of fire: -4.69 – 1.98</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>JJA Year of fire: -4.19 – 0.84</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>JJA Year following fire: -3.45 – 1.79</td>
</tr>
<tr>
<td>Administrative Unit</td>
<td>Grand Teton National Park (GTRE), Yellowstone National Park (YELL), and Bridger-Teton National Forest (BTNF)</td>
<td>Fire History Records</td>
<td>GTRE: 3 Fires, 78 Plots</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>BTNF: 8 Fires, 425 Plots</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>YELL: 11 Fires, 191 Plots</td>
</tr>
</tbody>
</table>
Three forms of Palmer’s Z indices were used (Table 1), including the monthly value for the climate region during the time of each fire; the average for the summer months (June, July, and August) of the fire season; and summer month averages for the year following each fire (when summer moisture could effect recovery rates, which in turn impact post-fire change detection). The values were simply typed into the data tables for each CBI plot location. Due to the very coarse nature of this climate region data, it performed poorly in classification tree models and was later removed from analysis.

*Classification Tree Modeling Using R*

In this study, the statistical software program R Version 2.4.1 with the “Tree” package was used for classification tree models (R Development Core Team 2006). R is open source software, easily obtained by users outside of academia, such as fire and resource managers. With the Tree package, R chooses optimal splits by comparing reduction in deviance. The default stopping criteria are 10 total observations in a node, or the deviance is less than 1% of the total dataset deviance. Trees were pruned to the number of leaves with lowest residual mean deviance. See Appendix B and the supplemental data DVD for individual model scripts.

*Accuracy Assessment*

Independent accuracy assessment was necessary to determine how the classification tree models performed for new fires outside of the training dataset. A simple random sample of 100 points was generated in three of the 23 fires, for a total of 300 points. New plots were used rather than reserving some of the original 694 plots to conserve the size of the dataset, since 700 plots is recommended as a minimum for CART.
trees (Perlich et al 2003). The Blind Trail fire in the BTNFR, the Wilcox fire in GTNP, and the Broad fire in YNP were chosen due to their large sizes, variable forest types, elevations, and locations in separate mountain ranges. Also, no Landsat 7 SLC-off problems occurred in the differenced imagery for these fires.

As with the 694 original locations, canopy mortality was estimated to the nearest 5% for concentric circles of .07, 1, and 5 hectares in size surrounding the random points. One meter digital orthophotos (true color and infrared) provided reference imagery. The mortality estimates categorized into three level classes; 0-20%, 25-75% and 80-100%.

Predicted canopy mortality surfaces were generated for each model being evaluated. Canopy mortality classes for the reference points were compared to predicted surfaces made from classification tree models using the ArcGIS 9.1 Spatial Analyst Raster Calculator with conditional statements (see Appendix A). Error matrices from these comparisons were used to derive user’s and producer’s accuracies for each class, as well as calculated Kappa statistics (Equation 6) (Cohen 1960).

$$K = \frac{N \sum_{i=1}^{r} x_{ii} - \sum_{i=1}^{r} x_{i+} x_{+i}}{N^2 - \sum_{i=1}^{r} x_{i+} x_{+i}}$$

where:
- $N$ = total number of observations.
- $r$ = the number of rows in the error matrix
- $x_{ii}$ = number of observations in row $i$ and column $i$
- $x_{i+}$ and $x_{+i}$ = marginal totals for row $i$ and column $i$

Canopy Mortality Sampling Considerations:

The CBI plots used to develop predictive models of canopy mortality were located in burned areas by field personnel with an opportunistic, not random approach (Key and Benson 2006). This section addresses the implications of this sampling scheme.
on the final geospatial models. Random sampling is not a requirement of predictive mapping or CBI protocols (Longley et al 2002, Key and Benson 2006), however, in this case unintended bias appears to impact at least one of the models. The consequences of this are minimal for the preferred models and overall conclusions, however.

The objectives of CBI field work that guided the selection of canopy mortality estimate locations called for approximately 50 samples per fire, representing the range of severity, from unburned to the most severe crown fire effects. A variety of vegetation types was also sought during CBI data collection, including sagebrush, riparian, and meadow vegetation in addition to forest. In order to maximize travel efficiency, field personnel targeted areas with many levels of severity occurring together. They therefore prioritized their work to take place in more heterogeneously burned portions of fires with a variety of plant communities.

CBI protocols recommend pre-selection of plot locations in each of five initial severity classifications (unburned, low, moderate, moderate-high, and high) to obtain a variety of burn severity level examples (Key and Benson 2006). In some cases plot locations were randomly pre-selected in the office, and CBI crews used GPS to navigate to them. Once in the field, however, the crews chose among these plots according to their planned travel routes over the course of a given field day.

In order to assess the potential impact of this plot selection, the slope, aspect, elevation, and distance from roads of the 694 CBI plots were compared to the same array of characteristics for a randomly generated sample of 700 points in the 23 fires. The results (Figures 3-6) indicate little meaningful difference in the distributions of the variables.
Figure 3. Very slight differences are evident in this comparison of cumulative frequency of slope percent for 694 CBI plot locations and 700 random locations in 23 fires.

Figure 4. A comparison of cumulative frequencies of slope percent for 694 CBI plot locations and 700 random locations in 23 fires shows that the CBI plots have slightly more south facing and fewer east facing locations.
Cumulative Frequencies of Elevation Data for CBI Plot Locations vs. Random Points in 23 Fires

Figure 5. Cumulative frequencies of elevation for 694 CBI plots and 700 random points in 23 fires. Some fires had many more CBI plots than others, accounting for the greater number of locations above 2100 meters.

Cumulative Frequencies of Distance from Roads Data for CBI Plot Locations vs. Random Points in 23 Fires

Figure 6. Cumulative frequencies are compared for distance to roads for 694 CBI plot locations and 700 random points in 23 fires. As with elevation (Figure 5), more CBI plots were obtained from some fires than from others. Several of the more intensively-sampled fires are in roadless areas, which probably accounts for the greater numbers of remote plots. The gap between 15,000 and 27,000 meters results from two extremely remote fires in the Teton Wilderness of the BTNF and YNP.
While the above comparisons between topographic variables and road distances for CBI plots and random locations indicate minimal impacts from sampling bias, the CBI plot selection methods did appear to affect the proportional distribution of mortality categories in the model dataset. Figure 7A illustrates the numbers of CBI plot location-based observations corresponding to 1-20%, 25-75% and 80-100% canopy mortality at the three spatial resolutions investigated in Chapter 3. Figure 7B shows much more evenly distributed proportions for the three categories and spatial resolutions from random points used in accuracy assessment. At the .07 hectare resolution, the differences are minimal, however as the size of the estimation circles increased, differences emerge. The CBI plot dataset has much fewer 0-20% observations, and more 25-75% cases.

In targeting CBI plot locations in heterogeneously burned areas to facilitate efficient data collection from all severity categories and a variety of vegetation types, field personnel avoided large continuous patches of consistent fire effects. In addition, locations near the edges of burned patches were preferred, because traveling far into the interiors of them represented additional time expenditures. This procedure allowed the desired variety among 30 meter diameter severity samples, but 1 and 5 hectare co-located circles took in the adjacent burn patterns. A small unburned or low severity patch that would fall completely within a 30 meter diameter circle would represent only a small part of a 5 hectare circle. Thus, more aggregation of adjacent patches resulted, leading to more circles having the middle, 25-75% canopy mortality category, and very few in the 0-20% category (Figure 7A).
Figure 7. Pie charts showing the distributions of canopy mortality categories estimated for three spatial resolutions in the 694 opportunistically sampled CBI plots (A), and the 300 randomly sampled accuracy assessment plots in the Blind Trail, Broad, and Wilcox fires (B). Note there more even proportions of categories in B.

With classification tree modeling, the distribution of categories in the training data impacts model structure and performance (Lawrence and Wright 2001). This is because the models apply splits where the greatest deviance reduction is attained. A category with more observations would be expected to have more variability within it, which could overshadow between-category differences. As Chapter 3 shows, the
skewed proportions for canopy mortality observations at the 5 hectare spatial resolution severely hampered the classification tree model. While this is important to note, other problems at the 5 hectare resolution rendered it undesirable. The relatively even distributions of observations for .07 and 1 hectare circles (Figure 7A) did not indicate such problems.

In summary, it appears that the CBI based plot location selections influenced the proportions of the mortality categories, which in turn affected the performance of the 5 hectare model, but had little overall impact on the predictive models at .07 and 1 hectare spatial resolutions.

**Literature Cited**


CHAPTER 2: USING SATELLITE IMAGERY TO MAP POST-FIRE FOREST CANOPY MORTALITY CLASSES IN NORTHWEST WYOMING

Keywords: Remote sensing, Landsat, Burn severity, Canopy mortality, Normalized Burn Ratio, Normalized Differenced Vegetation Index, Classification trees.

Abstract

Burn severity mapping using remote sensing has become a standard procedure to help resource managers assess the effects of fire on the landscape. Several remote change detection indices, derived from Landsat-5 TM and Landsat-7 ETM+, have been used in conjunction with ground plots to produce these maps. Burn severity is a qualitative expression of the extent of ecological change on the ground. As such, it conveys limited specific information about fire effects. Canopy mortality is a more quantitative and tangible way to define and map burn severity, better suited for evaluating and managing fire effects. This study shows that percent canopy mortality in forested areas can be mapped using Landsat TM and ETM+ imagery to provide such a specific measure of burn severity for northwest Wyoming. Binary classification tree models of canopy mortality were derived from 694 locations in 23 fires. Mortality was estimated two ways; in the field and remotely with the use of digital orthophotographs. Predictor variables included variations of the Normalized Burn Ratio and Normalized Differenced Vegetation Index. In addition, forest type, topography, and Tasseled Cap Transformations were included as predictors. Mortality was predicted using two, three, and five categories to determine optimal model and map precision.

Models using air photo-based estimates versus field estimates had similar misclassification rates but different structures. Three categories were optimal for mapping. The relative differenced NBR was the best predictor of canopy mortality.
Independent testing of a three-category predicted surface indicated 68.5% accuracy overall (Kappa 0.45). A simplified model using only dNBR and topography was 60.3% accurate (Kappa 0.33).

Remotely-sensed thematic maps of canopy mortality have great applicability for resource managers to assess fire effects to timber, wildlife habitat, hydrologic function, recreation potential, and future vegetation growth. They also will aid in maintaining and updating maps of fuels and vegetation in burned areas.

**Introduction**

Wildland fires have significant disturbance effects on the forests of the Rocky Mountain West. It is necessary to locate, measure, and understand the effects of these fires in order to conduct appropriate management responses. Until recently, most public land management agencies documented large fire disturbances with maps of ignition locations and final perimeters (Morgan et al 2001, Rollins et al 2002). Mapping techniques included a combination of ground reconnaissance, over flights, aerial photographs, and more recently Global Positioning Systems (GPS) (Kolden and Weisberg 2007).

The effects of fire are much more complex both spatially and qualitatively than a simple perimeter would suggest (Lertzman 1998, Peterson 1998, Turner et al 2003). It is surprising that, until recently, many resource management professionals, researchers, and members of the public still considered all forest stands within these fire perimeter to be uniformly (and lethally) affected (Turner and Romme 1994), and managed them as such.

In order to understand the magnitude of fire effects both quantitatively and qualitatively, more realistic geospatial maps of burned areas are needed. Recent research
into burn severity mapping using the differenced Normalized Burn Ratio (NBR) and Normalized Differenced Vegetation Index (NDVI) with Landsat TM and ETM+ provide such remote assessments of fire effects (White et al 1996, Brewer et al 2005, Lentile et al 2006). Burn severity is a qualitative term, however, and is used inconsistently (Miller and Yool 2002, Jain and Graham 2007). Burn severity maps are therefore ambiguous in their representation of specific fire effects.

A tangible, specific measure of burn severity, such as percent forest canopy mortality, would provide a quantifiable alternative. This study is an investigation into the use of remote sensing to map tree canopy mortality, which is a tangible and quantifiable consequence of fire, relevant to management. Whether or not trees are killed, and where stand replacement has occurred are fundamental questions for timber programs, wildlife habitat, hydrology, recreation, fire and fuels management, and vegetation mapping. Maps of percent canopy mortality in burned areas can be used to address important resource management questions. With the apparent increase in the occurrence of large fires in Western North America (Westerling et al 2006) this remotely-obtained geographic information becomes even more vital for appropriate resource management.

Classification tree modeling was used in this study to predict canopy mortality from Landsat (TM and ETM+) imagery and ancillary data. Geographically-located canopy mortality estimates in 23 fires in two national parks and a national forest in Northwest Wyoming provided a basis for model development. Percent tree mortality from 694 locations was estimated in two ways, using field evaluation and digital orthophotography. Mortality was categorized according to three systems with five, three, and two categories, respectively. Comparisons of the performance of these levels
of detail indicated appropriate precision for mapping. Several NBR- and NDVI-based burn severity indices from Landsat TM and ETM+ images were used as predictor variables. Additionally, Tasseled Cap Transformations, forest type, elevation, slope, aspect, and administrative unit were considered as predictors.

The accuracy of selected canopy mortality mapping models was assessed using independent random samples, with error matrices and Kappa statistics (Cohen 1960) provided. The results show that Landsat imagery can be used to provide a mapping tool for managers, while demonstrating an ecologically significant, tangible measure of burn severity for mapping forest fires. Furthermore, the results demonstrate that it is possible to use remote sensing with digital orthophotography to obtain large datasets of canopy mortality estimate locations for use in building similar models in other forest ecosystems.

**Background**

The Normalized Burn Ratio (NBR) and Normalized Differenced Vegetation Index (NDVI) are two popular multispectral band ratios for discriminating fire effects using Landsat TM and ETM+ and other platforms (Lentile et al 2006, Brewer et al 2005, White et al 1996). The NBR is calculated by subtracting the shortwave infrared reflectance (Band 7) of an image from the near infrared (Band 4), and dividing by their sum (Equation 1) (Key and Benson 2006). The index is patterned after the NDVI formula (Equation 2), however Band 7 (middle infrared) is used instead of Band 3 (visible red), because it has greater sensitivity to burned soil surfaces (White et al 1996). Using either index, change detection between pre fire and post fire images provides an indication of fire induced change. The differenced NBR (dNBR) (Equation 3) and differenced NDVI (dNDVI) (Equation 4) pixel values have been shown to increase with
burn severity (White et al 1996, Diaz-Delgado et al 2001, Key and Benson 2006, Zhu et al 2006). Because of its sensitivity to both vegetation change and burned soils, the dNBR has become the most common method for mapping the severity of burned areas using Landsat in North America (Brewer et al 2005, Lentile et al 2006). Other burn severity mapping studies targeting strictly vegetation damage and recovery have used the dNDVI (Diaz-Delgado 2001, Hammill and Bradstock 2004).

Recently a relative dNBR index (RdNBR) has been proposed to better detect severe overstory burns (Miller and Thode 2007), especially in rocky or non-productive desert areas (Zhu et al 2006). The RdNBR index (Equation 5) divides the dNBR by the NBR of pre-fire vegetation. A square root transformation is used to adjust for the tendency for Band 7 reflectance in burned areas to be inflated, resulting in a curved distribution when compared to ground measures of severity (Miller and Thode 2007). In the formula, pre-fire NBR is divided by 1000 because dNBR is multiplied by 1000 for integer format. Relative dNDVI (RdNDVI) can be calculated without the transformation because there is no boosting of relative change with the use of Band 3 (Equation 6).

\[
NBR = \left( \frac{\text{NearIR}(band4) - \text{MidIR}(band7)}{\text{NearIR}(band4) + \text{MidIR}(band7)} \right) \times 1000
\]

\[\text{NDVI} = \left( \frac{\text{NearIR}(band4) - \text{red}(band3)}{\text{NearIR}(band4) + \text{red}(band3)} \right) \times 1000\]

\[dNBR = \text{Pre-fire NBR} - \text{Post-fire NBR}\]

\[d\text{NDVI} = \text{Pre-fire NDVI} - \text{Post-fire NDVI}\]

\[RdNBR = \left( \frac{\text{PreFireNBR} - \text{PostfireNBR}}{\sqrt{\text{PreFireNBR}/1000}} \right)\]

1000)7()4(\text{bandMidIRbandNearIR})\text{NBR} + \text{MidIR}(band7)\right)\times 1000\]

\[\text{bandredbandNearIR})\text{NDVI} + \text{red}(band3)\right)\times 1000\]

\[\text{PreFireNBR} - \text{PostfireNBR}\]
\[ RdNDVI = \left( \frac{Pr eFireNDVI - PostfireNDVI}{Pr efireNDVI} \right) \times 1000 \] (6)

Burn severity has been defined in numerous ways, but it is generally expressed as the degree of ecological change resulting from a fire (van Wagtendonk et al 2004, Neary et al 2005, Key and Benson 2006). In the field of remote sensing, fire severity is linked to the overall magnitude of change determined by the sensors for a given pixel (Hammill and Bradstock 2004, Lentile et al 2006).

Key and Benson (2006) developed a standardized ground-truthing method to facilitate for burn severity mapping, called the Composite Burn Index (CBI). According to this method, geographically–positioned field plots are evaluated using a 0-3 severity scale that incorporates ocular rankings of substrate, understory, and overstory ecological effects. Circular 20 meter diameter plots are used for ground and understory effects, with concentric 30 meter diameter circle for overstory tree effects. The CBI method has been widely used to calibrate burn severity maps into low, moderate, and high categories and evaluate overall performance of mapping (van Wagtendonk et al 2004, Cocke et al 2005, Zhu et al 2006, Miller and Thode 2007).

In 2004, the multi-agency Wildland Fire Leadership Council proposed a major burn severity mapping project across the United States, entitled Monitoring Trends in Burn Severity (MTBS) (Eidenshink et al 2007). Under this directive, the U. S. Forest Service Remote Sensing Applications Center, and the U. S. Geological Service EROS Data Center jointly provide atlases of dNBR burn severity maps for all wildland fires larger than 1000 acres (500 acres in the East). RdNBR maps will also be provided in
some areas (Eidenshink et al 2007). MTBS burn severity mapping will be retro-active to 1984, using archived Landsat TM and ETM+ images.

These Recent advances in burn severity mapping using remote sensing have informed fire and resource management in important ways (Eidenshink et al 2007). A basic question of fire effects is usually unanswered, however: Where was the forest overstory killed, and where did it survive? It seems reasonable to suggest that remote sensing could be used to provide such data in map format. Trees are visible to overhead sensors, and NBR and NDVI indices are very sensitive to live versus dead vegetation (White et al 1996). Prior to this study, no attempt has been made to test the utility of MTBS mapping products for this purpose.

**Methods**

**Study Area**

The public lands of Northwest Wyoming are an excellent laboratory for mapping canopy mortality effects in burned areas. Grand Teton National Park (GTNP), Yellowstone National Park (YNP), and the Bridger-Teton National Forest (BTNF) together comprise approximately 2.4 million hectares of mountainous land with extensive forests. Five main forest types can be distilled from the diverse floras of the region (Steele et al 1983, Bradley et al 1992). They are dominated by: Douglas-fir (*Pseudotsuga mensiesii*), lodgepole pine (*Pinus contorta*), spruce-fir (*Picea englemannii* and *Abies lasiocarpa*), high elevation spruce-fir (*P. englemanii* and *A. lasiocarpa* with *Pinus albicaulis*) and aspen (*Populus tremuloides*). Each of these forest types has different levels of vulnerability to fire (Bradley et al 1992) ranging from very resistant Douglas-fir to easily killed spruce-fir and aspen.
Since the historic 1988 Yellowstone fires burned over 250,000 hectares in one season (Turner et al 1994), more and larger forest fires have occurred in the study area. A series of very dry summers between 2000 and 2003 caused approximately two dozen major fires in YNP, GTNP, and BTNF. As part of pre-MTBS investigations, the National Park Service and U.S. Geological Survey provided dNBR imagery to help map the severity of these fires. Local fire effects monitoring field crews conducted over 700 CBI plots to assist with severity calibration.

Data Preparation

Percent canopy mortality was the dependent variable in binary classification tree model development. It was estimated at 694 CBI plot locations in 23 fires in YNP, GTNP, and BTNF that occurred between 2000 and 2003. Field crews estimated canopy mortality at many of these locations as part of CBI plot protocols (Key and Benson 2006). This data collection took place in first or second year following the fire, depending on field crew availability. Plots were located in the 23 fires in an attempt to capture a wide range of severity levels and forest types (Key and Benson 2006).

A second, remote method was investigated to make canopy mortality estimates, using digital aerial photographs (with 1 meter resolution) for these same locations. True color (2006) and color infrared (2001-2002) images 1 meter pixel resolution were available for post-fire mortality assessments over the entire study area. Percent tree mortality was estimated to the nearest 5% for circular areas of 30 meter diameter projected over the 694 CBI plot locations on the aerial photographs using ArcGIS.

Comparison of model results using both field and air photo estimates will indicate options for similar studies in other ecosystems. Field estimates are expensive, but can
better detect individual dead trees. GPS errors can be large, however, particularly in heavily forested locations. Air photo estimates require timely photography and may introduce interpretation error, however. Some misregistration occurs with such orthophotographs and between them and satellite imagery. Finally, depending on timing, field and air photo estimates may represent different conditions due to delayed tree mortality.

All canopy mortality estimates for the 694 locations were classified into groups according to three systems; with five, three, and two categories each (Table 1, Figure 1). With both field-based and photo-based estimates of canopy mortality, and three classification systems, a total of six combinations were used to generate predictive models.

Table 1. Three systems used to categorize canopy mortality estimates used as the dependent variable in predictive mapping.

<table>
<thead>
<tr>
<th>Five Categories:</th>
<th>Three Categories:</th>
<th>Two Categories:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A 0 %</td>
<td>X 0-20 %</td>
<td>0 0-75 %</td>
</tr>
<tr>
<td>B 5-25 %</td>
<td>Y 25-75 %</td>
<td>1 80-100 %</td>
</tr>
<tr>
<td>C 30-75 %</td>
<td>Z 80-100 %</td>
<td></td>
</tr>
<tr>
<td>D 80-95 %</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E 100 %</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Pre- and post-fire Landsat TM and ETM+ 6-band scenes and individual fire subsets for dNBR were downloaded from the United States Geological Survey (USGS) EROS Data Center Website (http://burnseverity.cr.usgs.gov/). The post burn imagery used was obtained at least one full growing season after the fires, according to Extended Assessment protocols (Key 2005, Key and Benson 2006). All images were terrain corrected and geometrically rectified using ground control points and digital elevation models according to the National Landsat Archive Production System (NLAPS) protocols, with Bands 1-5 and 7 converted to at satellite reflectance (Eidenshink et al 2007). NBR and NDVI for pre and post fire were generated using the Image Analysis Extension for ArcGIS 9.1. Pre-fire TCT brightness, greenness, and wetness were created using ERDAS Imagine 9.1.
The 23 fires included in this study occurred over four summers in a geographic area covering three Landsat scenes. A total of 11 pre- and post-fire pairs of images were needed to generate the Extended Assessment (Key 2006) burn severity indices for all 23 fires. These indices included dNBR, post-burn NBR, RdNBR, dNDVI, and RdNDVI. In order to combine the 23 fires for analysis, DNBR and dNDVI subsets were standardized by subtracting the mean differences of pixels sampled in unburned areas adjacent to each fire (Key 2006). Relative indices (RdNBR and RdNDVI) were calculated using these.

Additional data included Pre-fire Tasseled Cap Transformation (TCT) bands (Crist and Cicone 1984), topography, and forest type (Table 2). TCT brightness, greenness, and wetness were derived from pre-fire Landsat TM and ETM+ 6-band imagery using Erdas Imagine 9.1. Elevation, slope percent, and aspect were produced from 30 meter Digital Elevation Models (DEM). The forest type layer was generated from pre-fire vegetation maps of YNP and GTNP, and BTNF. The five types mapped were Douglas-fir, lodgepole pine, spruce-fir, high elevation spruce-fir, and aspen.

All GIS data layers were converted to UTM NAD 83 Zone 12N. A mosaic of raster subsets for all 23 fires in the study area was made for each predictor variable used. A geographic intersection of these mosaic layers was used to extract pixel values for the 694 CBI plots, resulting in a spreadsheet dataset for comparison with canopy mortality estimates.
Table 2. Geospatial predictor variables used in classification tree model development for predicting canopy mortality in burned areas of northwest Wyoming.

<table>
<thead>
<tr>
<th>Predictor Variable</th>
<th>Source</th>
<th>Range of Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative differenced Normalized Burn Ratio (RdNBR)</td>
<td>11 pairs of scenes (1999 – 2004) Landsat TM and ETM+</td>
<td>-17,655.2 – 6067.7</td>
</tr>
<tr>
<td>Differenced Normalized Differenced Vegetation Index (dNDVI)</td>
<td>11 pairs of scenes (1999 – 2004) Landsat TM and ETM+</td>
<td>-69.3 – 582.9</td>
</tr>
<tr>
<td>Relative differenced Normalized Differenced Vegetation Index (RdNDVI)</td>
<td>11 pairs of scenes (1999 – 2004) Landsat TM and ETM+</td>
<td>-266.6 – 3811.2</td>
</tr>
<tr>
<td>Tasseled Cap Brightness – Pre-fire</td>
<td>9 scenes (1999 – 2002) Landsat TM and ETM+</td>
<td>54.0 – 168.0</td>
</tr>
<tr>
<td>Tasseled Cap Greenness – Pre-fire</td>
<td>9 scenes (1999 – 2002) Landsat TM and ETM+</td>
<td>-1.0 – 78.0</td>
</tr>
<tr>
<td>Tasseled Cap Wetness – Pre-fire</td>
<td>9 scenes (1999 – 2002) Landsat TM and ETM+</td>
<td>-43.0 – 16.0</td>
</tr>
<tr>
<td>Elevation (m)</td>
<td>USGS 30 meter DEM</td>
<td>1760.9 – 3056.3</td>
</tr>
<tr>
<td>Aspect</td>
<td>USGS 30 meter DEM</td>
<td>0 – 358.2</td>
</tr>
<tr>
<td>Slope Percent</td>
<td>USGS 30 meter DEM</td>
<td>.5 – 73.8</td>
</tr>
</tbody>
</table>
| Pre Fire Forest Type                     | GTNP, YNP, and BTNF vegetation maps. Converted to raster, Reclassified to 5 forest types and non-forested. | 1 = Douglas-Fir

Classification Tree Model Development

Classification and Regression Tree (CART) methods were used to predict percent canopy mortality using the CBI plot estimates and predictor variables. CART is an increasingly popular predictive modeling method made possible by powerful computer processors (Lawrence and Wright 2001). The process works by generating a series of binary splits (or branches) according to an iterative process that selects a break point in a
single predictor variable that maximizes the reduction in overall deviance (Urban 2002). The same step is then applied to the resulting groups until specified criteria are met, and the tree is complete.

Classes of canopy mortality are categorical by definition, so the CART process produced “classification trees.” with class membership predicted for each observation in the training dataset. A numeric dependent variable would generate “regression trees,” which predict average values. With classification trees, each terminal node (or “leaf”) is assigned a class, and the percent of correct versus incorrect classifications is given. Most CART software packages provide a graphic that shows the branch configurations, the split statistics, and leaf labels that resembles a tree. These diagrams function as a decision tool, much like a diagnostic key, that can be used to make predictions with new observations. Classification and regression trees usually need to be “pruned,” because they are over fitted to the training data (Hansen et al 2000). The lowest branches of a tree model tend to be the least reliable because they are associated with noise in the training data (Urban 2002), so pruning can actually reduce the errors made on an independent test (Mingers 1989, Lawrence and Wright 2001, Sanchez-Flores and Yool 2004). Pruning tree models also helps to simplify them and make them easier to use (Esposito et al 1997, Amatulli et al 2006).

The open source statistical program R Version 2. 4. 1 was used with the “Tree” package for generating classification trees for this study (R Development Core Team 2006). The Tree package chooses optimal splits by comparing reduction in deviance. The default stopping criteria are 10 total observations in a node, or the deviance is less than 1% of the total dataset deviance. A 10-fold cross validation algorithm was used to
produce plots of deviance versus tree size. Trees were pruned to the number of nodes with the lowest residual mean deviance according to ten iterations of the cross validation process.

*Accuracy Assessment*

Selected classification tree models were used to generate predicted surfaces in GIS. The accuracy of these maps was tested in comparison to a new set of 300 random locations in three fires (100 locations per fire) where canopy mortality was estimated using true color and color infrared digital orthophotography. The three fires included the Blind Trail fire in the BTNF, the Wilcox fire in GTNP, and the Broad fire in YNP. Error matrices were generated by comparing these estimates to predicted surfaces made from the preferred classification tree models.

When remotely-sensed reference data (such as aerial photographs) are used in accuracy assessment, there is potential for additional error. In particular, misregistration, photo interpretation, and timing differences can complicate accuracy evaluations, making them conservative (Verbyla and Hammond 1995, Kalkhan et al 1998, Foody 2002).

Figure 2 shows the process steps used in data preparation, modeling, mapping, and accuracy assessment of canopy mortality using two methods to obtain the training datasets and three different classification systems.
Figure 2. Process steps utilized in development and evaluation of predictive models based on two data collection methods for mapping three canopy mortality classification systems in burned areas of Northwest Wyoming.

**Results and Discussion**

Six initial tree models were developed using three different classification systems and both field- and photo-based canopy mortality estimates (Table 3, Figure 3). Differences are apparent in both tree structure and misclassification rates among the models.

*Classification Tree Model Structure:*

All six tree models generated use the RdNBR as the primary split variable for predicting canopy mortality (Figure 3). The CART algorithm compared the deviance reduction at all possible thresholds for all predictor variables, and in each case RdNBR
was the best predictor at the broadest level. The relative index highlights the proportion of reduction in dNBR rather than the absolute reduction, so it is more sensitive to subtle differences distinguishing canopy mortality categories.

Table 3. Summary of six tree models used to predict canopy mortality in burned areas. Model misclassification rates are based on observed versus predicted categories in the training dataset.

<table>
<thead>
<tr>
<th>Mortality Categories</th>
<th>Source of Estimate</th>
<th>Misclassification Rate</th>
<th>Main predictor (first split)</th>
<th>Other predictor variables used</th>
<th>Categories of first split</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Field</td>
<td>43.5% *5-25% and 80-95% categories not predicted</td>
<td>RdNBR</td>
<td>Elevation dNBR</td>
<td>30-75% vs. 100%</td>
</tr>
<tr>
<td>3</td>
<td>Field</td>
<td>27.4%</td>
<td>RdNBR</td>
<td>Elevation dNBR</td>
<td>80-100% vs. 80-100%</td>
</tr>
<tr>
<td>2</td>
<td>Field</td>
<td>18.0%</td>
<td>RdNBR</td>
<td>dNBR Elevation NBR post fire</td>
<td>0-75% vs. 80-100%</td>
</tr>
<tr>
<td>5</td>
<td>Air Photos</td>
<td>42.9% *80-95% category not predicted</td>
<td>RdNBR</td>
<td>Elevation NBR post fire RdNDVI dNBR</td>
<td>0% vs. 100%</td>
</tr>
<tr>
<td>3</td>
<td>Air Photos</td>
<td>26.4%</td>
<td>RdNBR</td>
<td>Elevation, dNDVI</td>
<td>0-20% vs. 80-100%</td>
</tr>
<tr>
<td>2</td>
<td>Air Photos</td>
<td>19.3%</td>
<td>RdNBR</td>
<td>Elevation dNDVI NBR post fire</td>
<td>0-75% vs. 80-100%</td>
</tr>
</tbody>
</table>

When the six tree models were pruned to show the results of the first split, they showed that RdNBR was not separating the same pairs of groups (Table 3). The initial split in the field-based model with three categories results in the 80-100% mortality category for both sides. Because classification trees choose splits that most reduce deviance in the dataset, this first split shows that there is considerable variability within
the RdNBR reflectance of stands estimated by field crews to be over 80% killed. Likely, these differences are characterized by high severity crown fires that kill all of the trees versus surface fires that kill most of them. Because field estimates were made by looking at the appearance of the forest one year post fire, it is possible that trees thought to be lethally burned may have actually survived. If such locations were categorized as over 80% mortality in error, this would increase the variability in the reflectance characteristics of this category. Consequently, the deviance within this category would also be larger.

Figure 3. Classification tree diagrams for models based on field- and photo-based estimates with five, three, and two categories of canopy mortality. Note that in the five category models and photo-based three category model, elevation thresholds limit the predictions of middle mortality levels.
The field estimate-based model using five mortality categories differentiated the 30-75% group from the 100% group with the first split. Thus, there was once again more variability between the RdNBR of a mixed-mortality category and 100% mortality. Dividing these two groups reduced the deviance more than separating unburned forest from 100% killed forest. The most likely reason for this was the distribution of the training data. Classification tree models are sensitive to the proportions of observations in each category (Lawrence and Wright 2001). As Figure 1 shows, only 72 of 694 observations had 0% mortality. The RdNBR thresholds were also much higher for the field-based model initial splits (Figure 3), which corresponds to a separation occurring at a higher severity level, such as would be expected within the higher percent mortality class.

The first splits in the photo-based models have more intuitive results (Table 3). The two category model differentiated 0-75% from 80-100% canopy mortality at the first node. The three category tree split the 0-20% group from the 80-100% group, and the five category model split 0% from 100% mortality. The thresholds of these splits were also more centrally located in the range of RdNBR values (Figure 3).

Lower branches in the classification trees split according to different predictors and threshold values depending on whether field or photo estimates were used, and how many categories were assigned. More branches remained after pruning in the photo-based models. This may indicate that cross-validation eliminated fewer relationships linked to noise in the dataset when the photo based estimates were used.

All three models based on air photo estimates featured NDVI indices as split variables, while none of the field estimate models included it (Table 3, Figure 3). NDVI
is more sensitive to plant photosynthesis and living biomass (White et al 1996) than NBR, and therefore would best highlight vegetative changes. In estimating canopy mortality for the 694 locations, the photo method also depended on visible changes in living vegetation (particularly with color infrared images). Field estimates, on the other hand, involved examination of tree scorch, char, and girdling, which occur in the understory and are less directly associated with NDVI. The use of NDVI in the photo based models therefore may be at least partially linked to the estimation method.

Based on these patterns in tree model structure, it appears that estimating canopy mortality from digital aerial photographs was better suited to predictive modeling than field CBI plot estimates. A comparison of percent mortality observations made at the 694 locations using field estimates versus digital orthophotograph estimates yielded a correlation coefficient of .84. Differences probably resulted from a combination of GPS registration errors, delayed mortality, and different observer perspectives. Using the orthophotograph method, canopy mortality estimates are better co-registered with predictor variables, and larger sample sizes can be obtained rapidly at low cost.

Landsat burn severity satellite indices (RdNBR, dNBR, NBR post fire, dNDVI and RdNDVI) and elevation were the only variables used by the pruned classification tree models to predict canopy mortality in burned areas. Despite the relationships between fuel loading and fire behavior (Countryman 1972), TCT brightness, greenness, and wetness were not featured in any of the models. Slope and aspect were also unused. Vegetation types are fundamentally linked to fuel characteristics (Anderson 1982), as well as vulnerability to mortality from fire (Wright and Bailey 1982), however forest type was not included in any of the pruned classification tree models. The forest type that
would be expected to differ most from the others would be deciduous aspen, but with only 55 aspen CBI plots, the dataset may have been too small to demonstrate this relationship.

Elevation played a perplexing role in several of these classification tree models (Figure 3). In many cases, classes of partial canopy mortality could only occur above certain threshold elevations due to binary splits in this predictor variable. Observations of partial mortality were found at all elevations in the dataset, however. While it operates awkwardly as a predictor variable, it may represent a relevant relationship in terms of fire effects. Fire spread is limited at high elevations by sparse fuels, open canopy growth, higher relative humidity, and moister fuels (Turner and Romme 1994). When fire behavior is constrained in this way, mixed tree mortality would be more likely to occur.

**Classification Tree Model Performance**

The tree models using five categories of canopy mortality had the highest overall misclassification rates (43.5 and 42.9 %). These models were unable to derive predictions for all five levels (Figure 3, Table 3). Even without pruning, no observations fell into the 80-95% mortality category in either model, although the dataset contained 113 and 121 cases for this level. Similarly, the 5-25% category was not predicted by the field-based tree despite 70 observations. The training dataset used in this study appears to have been too small to make classification models with five levels.

The tree models with the lowest misclassification rates (18.0 and 19.3%) were used to predict only two categories of canopy mortality. The distribution of two categories (0-75% and 80-100%) is less useful for understanding fire effects on the landscape, however (Agee 1998, Lertzman 1998). Maps with this binary information
would lack detail about important mixed-lethal fire effects that impact wildlife habitat, fuel loading, recreation, and hydrologic function, among other resources (Turner et al 1994, Ryan 2002). At worst, these two-category maps could lead to questionable resource management decisions. Based on model performance and utility for resource management, the three-category approach is the most appropriate choice for thematic mapping of canopy mortality in burned areas.

Model misclassification rates are similar for field- and photo-based models (Table 3). For the three- and five-category trees, the photo based models have slightly fewer errors, while the two-category tree using field estimates was more accurate by a small margin.

Accuracy assessment of tree model performance with independent data was necessary to further explore the potential for canopy mortality mapping beyond the training dataset. The three-category model based on mortality estimates from digital orthophotos was selected. This “Best Tree” was used to generate a predicted surface for the study area, and compared to a simple random sample of 300 locations in the Broad, Willcox, and Blind Trail Fires (Figure 5, Table 4).

Additionally, a second three-category model surface was derived using a simplified set of predictors easily obtained by resource managers. Since the MTBS program will be providing dNBR maps for large fires as a standard procedure, it may be more feasible to map canopy mortality with this burn severity index alone. Without proper software it is difficult to acquire many of the predictor variables used in the Best Tree model, particularly the NDVI. The “dNBR Only Tree” model provides an alternative that uses elevation, aspect, and dNBR (Figure 4).
A predicted surface for the dNBR Only Tree model was also generated for accuracy assessment (Figure 5, Table 4) Some accuracy was lost according to the independent test for the dNBR Only Tree. Although the model misclassification rates were similar, the best tree (68.5% accuracy, Kappa 0.45) outperformed the dNBR only tree (60.3% accurate, Kappa 0.33).
Both models accurately predicted the 80-100% morality category. The producer’s accuracy shows that 92.1% of this category was correctly identified on the maps using the best tree model (80.1% for the dNBR only tree). The most severe burn patches are usually larger and more uniform (Turner et al 1994, Hudak et al 2004), and are therefore easily detected by remote sensors using burn severity mapping indices. Also, the training dataset was rich in observations for this category.

Table 4. Accuracy assessment results comparing predicted surfaces and random locations for the 3-category Best Tree and dNBR Only tree models.

<table>
<thead>
<tr>
<th></th>
<th>A. Best Tree</th>
<th>B. dNBR Only Tree</th>
</tr>
</thead>
<tbody>
<tr>
<td>Misclassification Rate</td>
<td>26.4%</td>
<td>27.4%</td>
</tr>
<tr>
<td>Overall Accuracy</td>
<td>68.5%</td>
<td>60.3%</td>
</tr>
<tr>
<td>Accuracy 0-20%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User’s:</td>
<td>67.7%</td>
<td>55.4%</td>
</tr>
<tr>
<td>Producer’s:</td>
<td>60.9%</td>
<td>66.7%</td>
</tr>
<tr>
<td>Accuracy 25-75%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User’s:</td>
<td>50.0%</td>
<td>21.9%</td>
</tr>
<tr>
<td>Producer’s:</td>
<td>25.4%</td>
<td>9.9%</td>
</tr>
<tr>
<td>Accuracy 80-100%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User’s:</td>
<td>72.2%</td>
<td>69.5%</td>
</tr>
<tr>
<td>Producer’s:</td>
<td>92.1%</td>
<td>80.9%</td>
</tr>
<tr>
<td>Kappa</td>
<td>0.45</td>
<td>0.33</td>
</tr>
<tr>
<td>Main predictor (first split)</td>
<td>RdNBR</td>
<td>dNBR</td>
</tr>
<tr>
<td>Other predictor variables used</td>
<td>Elevation dNDVI</td>
<td>Elevation Aspect</td>
</tr>
</tbody>
</table>

The user’s and producer’s accuracies for the 0-20% category were lower, ranging from 55.4% to 67.8%. The middle category of 25-75% mortality had the poorest accuracy. According to Key (2006) burn severity maps using dNBR also tend to be least
reliable in moderately burned areas. Only 25.4% of the burned area with this level was correctly mapped using the best tree (9.9% for the dNBR only tree model). The greatest confusion occurred due to misclassification of this level as 80-100%. Several published burn severity mapping studies have also noted that low and moderate levels are most difficult to map accurately with Landsat imagery (Bobbe et al 2001, Miller and Yool 2002, Cocke et al 2005, Key 2006, Lentile et al 2006).

Elevation thresholds may also be contributing to the inaccuracy in the mapping of 25-75% canopy mortality. According to the best tree model the 25-75% mortality category can only occur above 2011.5 meters (Figure 3). The dNBR-only model requires 2436.6 meter elevation to achieve this category (Figure 4).

Predicted surfaces generated for all 23 fires in the study area were summarized to compare the relative proportions of each of the three mortality categories within fire perimeters (Figure 6). The dNBR tree model predicted more of the area within the burn perimeters as the 0-20% mortality class, while the best tree predicts more area in the 80-100% category. Accuracy assessment indicated that the dNBR tree had greater accuracy in the 0-20% category, while the best tree was more accurate for the 80-100% category. Similar proportions were predicted for the 25-75% category.
Summary and Conclusions

This study has shown that percent canopy mortality can be effectively mapped using remote sensing data in burned areas of northwest Wyoming forests. Accuracy assessment with independent samples showed that burned forests with over 80% mortality are particularly well detected. While the middle mortality category mapping has lower accuracy, knowing its distribution is important for management and ecological understanding.

Predictive modeling using classification trees allowed comparison of several popular Landsat indices based on NBR and NDVI. The RdNBR was most effective for reducing deviance in the estimated canopy mortality categories.

None of the models generated in this study utilized pre-fire TCT bands or forest type data. This indicates that canopy mortality models using MTBS products are
potentially useful across a wide range of forest landscapes, perhaps beyond the study area.

Classification tree models perform best with large and evenly distributed datasets. The effect of fewer observations in the lower mortality categories was evident in tree model structure and performance. Furthermore, as more mortality categories were used, misclassification rates increased drastically. A total of 694 observations in the dataset was insufficient for mapping five mortality categories. This indicates that many more observations would be needed if a continuous scale of mortality (rather than classes) were to be predicted.

Tree models compared the use of field estimates of canopy mortality in model development to estimates obtained for the same locations using digital aerial photography (true color and color infrared). The field- and photo-based estimates of mortality differed in both perspective and time since fire. GPS errors caused locational differences as well. Mortality estimates depended primarily on the overhead visibility of living canopy foliage. Field estimates, on the other hand, were made from the ground, within one or two years post fire. Tree mortality was assessed according to bole char as well foliage appearance. Delayed tree mortality, post-fire regrowth, and soil color would vary considerably depending which of these sources was used.

Misclassification rates for models based on the two estimation methods were similar; however tree model structure using field estimates revealed inefficient partitions in the first splits. These models also may represent less utility outside of the training data, because cross-validation indicated pruning to fewer total nodes. If timely imagery
is available, photo-based mortality estimates would be both economical and advantageous for obtaining large datasets.

Predicted map surfaces using the simplified dNBR only tree models were 60.3% accurate according to independent testing. While this is lower than the best tree accuracy (67.7%), some resource managers may prefer the more available data to map canopy mortality in burned areas. The reduced level of accuracy may be acceptable for some applications. Given the availability of dNBR products for burn severity mapping through the MTBS program, and the ease of obtaining elevation and aspect grids, this appears to be a reasonable approach. Overall proportions of mortality categories in the predicted surfaces were similar between the best tree and dNBR only tree (Figure 6).

In conclusion, Landsat TM and ETM+ remote sensing can be used in conjunction with classification trees in a relatively simple mapping process for canopy fire effects. This method will enable fire and resource managers and researchers to create thematic maps of tangible, measurable, and ecologically important effects on the ground. These maps add great value to conventional burn severity assessments, such as those provided by the MTBS program (Eidenshink et al 2007) because they provide specific and quantitative data that can be used for applications such as hydrologic models, updates for fuels and vegetation maps, succession models, and habitat assessments. With advances in higher resolution satellite and airborne imagery as well as spectral unmixing (Smith et al in press, Robichaud et al 2007, Lentile et al 2006), such mapping will undoubtedly improve.

**Literature Cited**


CHAPTER 3:  
MAPPING CANOPY MORTALITY IN BURNED LANDSCAPES OF NORTHWEST WYOMING, USA: EFFECTS OF CHANGING SPATIAL RESOLUTION

Keywords: Remote Sensing, Landsat, Spatial Resolution, Positional Accuracy, Fire Regime, Normalized Burn Ratio, Classification Trees.

Abstract

Thematic maps made using remote sensing reflect the relationships between landscape pattern sizes and shapes and the spatial resolution of the imagery. Burn severity maps made using Landsat TM and ETM+ multispectral sensors are therefore subject to the advantages and limitations of 30 meter pixels. The resolution and degree of positional accuracy attainable impact the information contained in the maps. Fire effects that occur at scales larger than 30 meters square are most likely to be captured. This study examined how changing spatial resolution affected accuracy and thematic content of Landsat-derived maps of forest canopy mortality, an index of burn severity, in burned areas.

Classification tree models were used to predict and map percent overstory tree mortality in 23 fires in northwest Wyoming at three spatial resolutions (.07, 1. and 5 hectares). Independent variables included several variations of the Landsat TM and ETM+ Normalized Burn Ratio (NBR) and Normalized Differenced Vegetation Index (NDVI), as well as ancillary geographic data. The three spatial resolutions resulted in models that used different remotely-sensed burn severity indices as primary predictors. The .07 hectare analysis (with unfiltered 30 meter Landsat TM and ETM+ pixels) provided the highest accuracy (68.5%, Kappa 0.45). The 1 and 5 hectare models were less effective because of patch aggregation and unbalanced categories in the input data.
The highest percent mortality class, representing crown fire, was mapped most accurately at all spatial resolutions. The middle class with partial canopy mortality was poorly predicted. These areas were most vulnerable to the homogenizing effects of spatial aggregation at coarser resolutions, due to their inherent patchiness.

Fire behavior processes responsible for killing trees occur according to surface and crown fires along a continuum of increasing intensity and patch size as part of the fire regime of the Northern Rocky Mountains. Surface fires tend to exhibit heterogeneous effects at finer scales due to environmental variations under typical weather patterns. Crown fires spread rapidly, leaving large homogeneous patches. A drought and wind threshold marks the transition from one process to the other. The results of this study indicate that the spatial resolution of Landsat TM and ETM+ sensors is effective for mapping the distribution of crown fire, but cannot adequately detect smaller canopy mortality patterns associated with surface fire.

**Introduction**

This study examined effects of changing spatial resolution on modeling and mapping fire effects in northwest Wyoming using Landsat (TM and ETM+) remote sensing. Geospatial models were made using binary classification trees, at three spatial resolutions (.07, 1, and 5 hectares). The results demonstrate the capabilities and limitations of remote sensing for mapping burned areas across a continuum of fire processes and resulting patterns.

Recent advances in remote sensing using Landsat TM and ETM+ and other platforms to map burned areas have led to widespread adoption of government-sponsored burn severity mapping programs (Eidenshink et al 2007). These maps are used by fire
managers to document fire perimeters in remote areas, estimate smoke emissions, prioritize soil stabilization treatments, and other post-fire activities (Isaev et al 2002, Hudak et al 2004, Lentile et al 2006). Furthermore, they have facilitated ecological analyses of the spatial patterns of fire and the processes that create them (e.g. Duffy et al 2007, Thompson et al 2007).

Burn severity is equated with the degree of ecological change due to fire (Neary et al 2005, Key and Benson 2006), and as such is a qualitative (and inconsistent) measure for comparison across ecosystems (Brewer et al 2005, Lentile et al 2006). To allow a more quantitative approach to mapping fire effects, this study used percent canopy mortality as a measure of burn severity.

Predictive models of canopy mortality were created using 694 circular training plots located in 23 fires in Grand Teton National Park (GTNP), Yellowstone National Park (YNP), and the Bridger-Teton National Forest (BTNF). The fires occurred between 2000 and 2003. Estimates of percent mortality from these locations were derived from digital orthophotographs, and compared to several popular Landsat TM and ETM+ burn severity detection indices and ancillary data in a Geographic Information System (GIS). Model-based geospatial raster surfaces were tested against a random sample of 300 locations in three of the fires.

In the northern Rocky Mountains, fire behavior operates along a continuum from individual fuel particles smoldering, to square kilometers of forest exploding in an independent crown fire (Countryman 1972, Ryan 2002). When fine fuel moistures are moderate and winds are light, local variations in the fire environment lead to inconsistent fire spread and heterogeneous burn patches (Turner and Romme 1994, Miller and Urban
The spatial patterns of overstory tree mortality are therefore heterogeneous according to these factors (Turner et al 1994, Hudak 2004ab, Rocca 2004). Above a certain drought and wind threshold, fire behavior is subject to conditions that operate on a much larger scale (Bessie and Johnson 1995). These crown fire patches are equally large and homogeneous (Turner et al 1994).

To best map landscape disturbances using remote sensing, such as burned overstory trees, data should be collected at the same resolution as the operational scales at which the phenomenon, in this case fire, operates (Levin 1992, Cao and Lam 1997, Marceau 1999).

Fire effects on forests range in size from individual tree girdling or torching to complete blackening of entire landscapes (Agee 1998). These fire patterns are linked to fire behavior processes, determined by fuels, weather, and topography (Countryman 1972).

Ideally, remote assessments of fire effects would be capable of discerning all of the scales of operation that correspond to fire behavior (Moody and Woodcock 1995, Lertzman et al 1998, Peterson 1998). The multispectral reflectance values derived from Landsat are averaged over 30 meter square pixels, however, which affects the ability to distinguish burned surfaces depending on their patch size and arrangement (Turner et al 1989, Bobbe et al 2001, Key 2006, Lentile et al 2006).

The use of remote sensing to map fire patterns is also complicated by positional inaccuracy of the imagery. Remotely-sensed layers in a GIS are subject to misregistration up to three pixels in either direction (Goodchild 1994). When change detection between two images is used, this is compounded, and considerable thematic errors can result (Dai and Khorram 1998, Townshend et al 1992, Verbyla and Boles...
In order to compensate, moving window filters are frequently used (e.g. van Wagendonk et al 2004, Key and Benson 2006, Miller and Thode 2007), which change each pixel value to an average of some number of surrounding pixels. In this process, spatial resolution is further decreased (Verbyla and Boles 2000).

This study examined how Landsat 30 meter pixels captured the patterns of canopy mortality (using the .07 hectare spatial resolution), and what happened when additional spatial aggregation was applied to improve positional accuracy (1 hectare resolution). The 5 hectare resolution analysis illustrated the risks of extremely coarse analysis for mapping fire effects for ecological analysis and management purposes.

The performance of the classification tree models showed that canopy mortality can be mapped using remote sensing. Model structure and results differed, however, according to spatial resolution and the type of fire behavior involved. The ideal spatial resolution for making canopy mortality maps was indicated to be a compromise between minimum grain size and positional accuracy.

Background

Burn Severity Mapping with Satellite Imagery

Since the 1980’s several methods of imaging burned areas from space and aircraft have been used to map burn severity worldwide (Lentile et al 2006). In the United States, the Normalized Burn Ratio (NBR) of Landsat TM and ETM+ imagery (Equation 1) has become the standard approach (Eidenshink et al 2007). The NBR is an index of near infrared (Band 4) and middle infrared (Band 7) reflectance that contrasts the characteristics of green vegetation and bare soil (White et al 1996).

\[
NBR = \frac{NearIR(\text{band 4}) - MidIR(\text{band 7})}{NearIR(\text{band 4}) + MidIR(\text{band 7})} \times 1000
\]
The NBR of a post fire image is subtracted from that of a pre-fire image to detect change. The differenced NBR (dNBR) (Equation 2) is calibrated to burn severity by comparing it with ground measures, such as the Composite Burn Index (CBI) plots developed by Key and Benson (2006) (e.g. van Wagendonk et al 2004, Cocke et al 2005, Zhu et al 2006, Miller and Thode 2007).

\[
dNBR = \text{Pre-fire NBR} - \text{Post-fire NBR}
\]  \hfill (2)

DNBR maps are categorized according to low, moderate, and high levels of ecological change for thematic mapping. With dNBR from pre- and immediate post-fire-image pairs, ‘Rapid assessments’ of severity provide maps for soil rehabilitation (Bobbe et al 2001) and other time-sensitive management (Key 2006). More accurate maps of burn severity (‘Extended Assessments’) are made using post-fire NBR from images that show at least one growing season of vegetative recovery (White et al 1996, Key 2005).

The dNBR has been adapted for sparsely-vegetated burned areas in California by Miller and Thode (2007) to create a relative index of NBR change. The Relative differenced DNBR (RdNBR) divides the dNBR by pre-fire NBR with the intent of deriving a percent change (Equation 3). This index is intended to be more sensitive to canopy mortality when tree cover is thin. Because Landsat Band 7 reflectance is boosted over burned soils and ash, the distribution of RdNBR is curved in comparison to ground severity levels. To correct for this, the pre-fire NBR square root absolute value is used in the denominator.

\[
RdNBR = \left( \frac{\text{PreFireNBR} - \text{PostfireNBR}}{\sqrt{|\text{PreFireNBR}/1000|}} \right)
\]  \hfill (3)
In some countries, the differenced Normalized Differenced Vegetation Index (dNDVI) is used to map and study burn severity (Diaz-Delgado et al 2001 in Spain, Hammill and Bradstock 2004 in Australia). The NDVI is similar to the NBR (Equation 1), but visible red reflectance (Landsat Band 3) takes the place of Band 7. NDVI is sensitive to photosynthetic activity in vegetation, and thus is useful to detecting mortality in burned areas (White et al 1996). Relative dNDVI is calculated without the use of square root adjustments (Equation 4).

\[ R_{dNDVI} = \left( \frac{P_{\text{efireNDVI}} - P_{\text{PostfireNDVI}}}{P_{\text{efireNDVI}}} \right) \times 1000 \]  

**Burn Severity Patterns and Fire Behavior Processes**

A basic tenet of Landscape Ecology states that spatial distributions in the environment control ecological processes and vice-versa (Turner et al 2001). In the case of wildland fire, Agee (1998) illustrated that under ‘normal’ weather, the patterns of fuels and topography control the processes of fire spread. With drought, however, the processes of weather and crown fire behavior overwhelm many of these environmental variations. Two kinds of fire behavior result from these relationships - surface fire and crown fire. Different patterns of burn severity are created according to their characteristic operational scales (Turner et al 1994, Bain 1997, Walsh et al 1997, Miller and Urban 2000, Rocca, 2004).

Surface fire intensity and spread are predicted according to fuel type, wind, slope, and fine dead fuel moisture (Rothermel 1972). Ecological effects occur mainly on the ground surface, although trees can be killed by girdling and root damage (Wright and Bailey 1982, Agee 1993). During moderate weather and climate conditions, differences
in temperature, shading, wind speed, and fuel accumulations result from varied aspect, elevation, and vegetation types on the landscape. These function to affect localized fine dead fuel moisture, critical for determining receptive fuels at various scales from mountain slopes to individual trees, logs, and fuel jackpots (Countryman 1972, Rocca 2004). Surface fire behavior ranges in intensity from smoldering to creeping to running (Ryan 2002). The effects of these processes to forest vegetation vary in the same spatial contexts that they occur (Turner et al 1989a, Turner and Romme 1994, Turner et al 1994, Miller and Urban 2000, Rocca 2004).

The drivers of crown fire spread are different from those of surface fire, and spread is predicted using different models (Van Wagner 1976). When fine dead fuel moistures are low, crown fires have great speed and intensity. Wind gusts can lead to rapid shifts in fire behavior (Ryan 2002), while fuels and topography are less important (Rothermel 1972, Bessie and Johnson 1995). Crown fire initiation marks a substantial leap in the magnitude of spatial patterns (Turner et al 1994, Miller and Urban 2000). Patch sizes are much larger, with less spatial variation (Turner et al 1994, Lertzman et al 1998, Miller and Urban 2000, Hudak et al 2004a, Rocca 2004). Spread rate, which is wind driven, can actually be what limits patch size because the fire will continue over large areas until the weather changes (Countryman 1972, Ryan 2002).

During fire season, a threshold in fine dead fuel moisture determines whether surface fire or crown fire processes occur in forest vegetation (Bessie and Johnson 1995, Miller and Urban 2000). During extreme drought, fires can spread rapidly without regard to local environmental variations (Van Wagner 1976, Ryan 2002). These are the fires that contribute to most of the area burned on the landscape (Agee 1998). When the fire
behavior threshold is not exceeded, because of seasonal or diurnal humidity, fire behavior is much more subject to changes in topography and fuel loading, and the total burned area will be smaller (Bessie and Johnson 1995, Miller and Urban 2000, Ryan 2002). Surface and crown fire dominance alternates over a fire season, during a fire event, and diurnally as fuels patterns and weather processes take turns driving fire behavior (Miller and Urban 2000). Near the threshold between the two, variations in wind speed interact with stand structure and topography to produce intermittent crowning and individual tree torching (Van Wagner 1977, Ryan 2002).

**Materials and Methods**

*Study Area*

This study area includes approximately 2.4 million hectares of mountainous terrain with extensive conifer forests in a region known as the ‘Greater Yellowstone Ecosystem’ (Keiter and Boyce 1991). Elevations range from approximately 1800 meters to peaks over 4000 meters. The climate is characterized by cold, snowy winters, rainy springs, and moderately warm summers (Baker 1944, Clark 1981). Peak fire season occurs in mid to late summer (Bradley et al 1992).

Two types of fire regime have been attributed to the forests of the study area; termed ‘stand-replacing’ and ‘mixed-severity’ (Turner et al 1994, Arno 2000, Brown 2000, Morgan et al 2001). In the stand replacing fire regime, most overstory trees are killed, due to crown fire as well as lethal surface fire (Ryan and Noste 1983, Brown 2000). Burn patch sizes can be very large, especially with sustained high winds (Miller and Urban 2000, Ryan 2002).
Mixed severity regimes have more variability in fire behavior, effects, return intervals, and patch sizes. They have been described as both a mid-range disturbance type (between surface and stand replacing), and as a spatial or temporal juxtaposition of two or more different fire regimes on a landscape (Agee 1998, Lertzman et al 1998, Arno 2000, Brown 2000, Lentile et al 2006). These two kinds of fire regime correspond to the processes and spatial patterns of surface and crown fire. Thus, stand-replacing and mixed-severity fire regimes may not be physically or ecologically distinct from one another. Instead, a single Northern Rockies fire regime may be exhibiting a dual expression depending on climatic and weather thresholds.

Five main forest types occur in the study area; characterized by the following dominant tree species: Douglas-fir (Pseudotsuga mesziesii), lodgepole pine (Pinus contorta), spruce-fir (Picea englemani and Abies lasiocarpa), high elevation spruce-fir (P. englemani and A. lasiocarpa with Pinus albicaulis) and aspen (Populus tremuloides) (Steele et al 1983, Bradley et al 1992). Each of these types has the ability to burn under both ‘mixed’ and ‘stand replacing’ fire behavior conditions (Arno 2000), although sparse high-elevation forests rarely experience crown fire (Bradley et al 1992).

Model Development

Classification and Regression Trees (CART) models were used to predict canopy mortality using Landsat TM and ETM+ burn severity indices and ancillary data gathered in a GIS. CART methods use an iterative process to consecutively subdivide training data observations into two groups according to which predictor variables most reduce deviance (Lawrence and Wright 2001, Urban 2002). This continues until the final splits, called leaves, meet specified criteria. Categories are predicted using ‘classification trees,’
while ‘regression trees’ derive average values for continuous data inputs (Urban 2002). Tree models are not affected by skewed distributions, unequal variances, spatial dependence, or complex interactions between variables. Instead of attempting to explain relationships mathematically, they simply demonstrate how they behave for predicting group membership (Michaelsen et al 1994, Lawrence and Wright 2001, Simard et al 2000).

With CART modeling, each predictor variable has an equal chance to be considered with every partitioning step, so the best one emerges (Simard et al 2000). This presents an advantage for this study, because several remote sensing indices are compared to evaluate their use for predicting canopy mortality.

CART outputs provide a dichotomous key that can be used to make predictions with new observations (Simard et al 2000, Sanchez-Flores and Yool 2004, Amatulli et al 2006). Because tree models are completely representative of the training data used to generate them, large datasets and independent testing are recommended (Mingers 1989, Amatulli et al 2006, Coops et al 2006). ‘Pruning’ tree models removes the lowest splits, which are more likely to be associated with noise in the training data, and improves their use for new observations (Mingers 1989, Hansen et al 2000, Lawrence and Wright 2001, Urban 2002).

The statistical software program R (version 2.4.1) was used with the ‘Tree’ package to build and prune classification tree models for this study. The criteria for stopping the splitting process was 10 or fewer total observations or a deviance value less than 1% of the initial overall deviance in a leaf. Pruning was done using ten
iterations of ten-fold cross validation, to the number of nodes indicated to have the lowest residual mean deviance.

**Data Preparation**

The dependent variable for predictive modeling was estimated canopy mortality for 694 locations in 23 fires that occurred between 2000 and 2003 in the study area. Three sizes of analysis were used for each location, consisting of concentric circles with 15, 56.41, and 126.16 meter radii (.07, 1, and 5 hectares, respectively). The 15 meter/.07 hectare size was chosen because it corresponds to the size of CBI plots used to calibrate burn severity maps (Key and Benson 2006). Mortality was estimated in each circle to the nearest 5% using 2006 true color and 2001-2002 color infrared 1 meter digital orthophotographs, regardless of the amount of pre-fire canopy cover. Percent mortality for each observation was then classified into three categories; 0-20%, 25-75%, and 80-100% (Figure 1).

![Canopy Mortality Group Breakdowns for 694 Locations](image)

**Figure 1.** Pie charts showing the numbers of plots in each mortality category in the training data for each spatial resolution of classification tree modeling. Note there were only 25 observations for the 0-20% category at 5h.
Independent variables included Landsat 7 ETM+ and Landsat 5 TM -derived post-fire NBR, dNBR, RdNBR, dNDVI, RdNDVI, and Tasseled Cap transformations. Pre- and extended post-fire Landsat NBR, dNBR and 6-band imagery was provided by the USGS Eros Data Center for the 23 fires. These included 19 terrain corrected, geo-rectified image pairs. The Image Analysis Extension for ArcGIS 9.1 was used to make pre- and post-fire NDVI. Pre-fire Tasseled Cap Transformations (TCT) for brightness, greenness and wetness were generated using Erdas Imagine 9.1. RdNBR, dNDVI, and relative dNDVI (RdNDVI) were produced using the ArcGIS Spatial Analyst extension Raster Calculator.

In addition to these Landsat-derived variables, ancillary pre-fire forest type and topography data was included in modeling (Table 1). Forest type was obtained from three separate vegetation GIS layers from YNP, GTNP and BTN. These maps were reclassified.
Table 1. Geospatial predictor variables used in classification tree model development for predicting canopy mortality in burned areas of northwest Wyoming. The dependent variables were estimated canopy mortality classes for three sizes of circular areas corresponding to .07, 1, and 5 hectare spatial resolutions.

<table>
<thead>
<tr>
<th>Predictor Variable</th>
<th>Source</th>
<th>Range of Values</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>1h: -482.4 – 718.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5h: -460.5 – 688.5</td>
</tr>
<tr>
<td>Differenced Normalized Burn Ratio (dNBR)</td>
<td>11 pairs of scenes (1999 – 2004) Landsat TM and ETM+</td>
<td>.07h: -242.4 – 1125.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1h: -195.9 – 1116.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5h: -149.1 – 997.2</td>
</tr>
<tr>
<td>Relative differenced Normalized Burn Ratio (RdNBR)</td>
<td>11 pairs of scenes (1999 – 2004) Landsat TM and ETM+</td>
<td>.07h: -17,655.2 – 6067.7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1h: -3884.9 – 5965.9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5h: -1.55 E13 – 4.88 E13</td>
</tr>
<tr>
<td>Differenced Normalized Vegetation Index (dNDVI)</td>
<td>11 pairs of scenes (1999 – 2004) Landsat TM and ETM+</td>
<td>.07h: -6.93 – 582.9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1h: -43.1 – 509.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5h: -65.2 – 458.6</td>
</tr>
<tr>
<td>Relative differenced Normalized Vegetation Index (RdNDVI)</td>
<td>11 pairs of scenes (1999 – 2004) Landsat TM and ETM+</td>
<td>.07h: -266.6 – 3811.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1h: -186.8 – 4369.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5h: -5.9 E12 – 1.7E14</td>
</tr>
<tr>
<td>Tasseled Cap Brightness – Pre-fire</td>
<td>9 scenes (1999 – 2002) Landsat TM and ETM+</td>
<td>.07h: 54.0 – 168.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1h: 54.6 – 160.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5h: 59.5 – 154.5</td>
</tr>
<tr>
<td>Tasseled Cap Greenness – Pre-fire</td>
<td>9 scenes (1999 – 2002) Landsat TM and ETM+</td>
<td>.07h: -1.0 – 78.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1h: 2.2 – 77.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5h: 5.7 – 69.7</td>
</tr>
<tr>
<td>Tasseled Cap Wetness – Pre-fire</td>
<td>9 scenes (1999 – 2002) Landsat TM and ETM+</td>
<td>.07h: -43.0 – 16.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1h: -43.2 – 12.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5h: -43.7 – 9.3</td>
</tr>
<tr>
<td>Elevation (m)</td>
<td>USGS 30 meter DEM</td>
<td>.07h: 1760.9 – 3056.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1h: 1761.0 – 3056.7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5h: 1763.4 – 3059.2</td>
</tr>
<tr>
<td>Aspect</td>
<td>USGS 30 meter DEM, Converted to aspect</td>
<td>.07h: 0 – 358.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1h: 6.45 – 355.4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5h: 16.5 – 347.2</td>
</tr>
<tr>
<td>Slope Percent</td>
<td>USGS 30 meter DEM, Converted to percent slope</td>
<td>.07h: .5 – 73.8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1h: 0 – 90.7</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5h: .1 – 85.9</td>
</tr>
<tr>
<td>Pre Fire Forest Type</td>
<td>GTNP, YNP, and BTNF vegetation maps</td>
<td>1 = Douglas-Fir</td>
</tr>
<tr>
<td></td>
<td>Converted to raster, Reclassified to 5 forest types and non-forested.</td>
<td>2 = Spruce – Fir</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 = High Elev. Spruce – Fir</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 = Lodgepole Pine</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5 = Aspen</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6 = Non-forested</td>
</tr>
<tr>
<td>Unit</td>
<td>Administrative unit where fire occurred:</td>
<td>GRTE – 4 fires</td>
</tr>
<tr>
<td></td>
<td>GRTE = Grand Teton National Park, YELL=Yellowstone National Park, BTNF = Bridger-Teton National Forest</td>
<td>YELL – 11 fires</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BTNF – 8 fires</td>
</tr>
</tbody>
</table>
into a single 30 meter resolution raster dataset with five forest types and a sixth, nonforested category. Thirty-meter resolution Digital Elevation Models (DEM) were used to produce slope, aspect and elevation grids.

All predictor variable layers were compiled in a GIS and filtered to the 1 and 5 hectare spatial resolutions using circular focal means (56.41 and 126.16 meter radii). In this way, canopy mortality estimates for each scale of analysis were modeled in comparison to a set of GIS predictor variables with the same spatial resolution (Figure 2). The .07 hectare model analysis was conducted using the original 30 meter pixel layers, because the 15 meter radius circles could fit within one pixel.

![Diagram](image)

Figure 2. Steps utilized in development and evaluation of predictive models for mapping canopy mortality classes in burned areas at three spatial resolutions.

In order to examine the applicability of the classification tree models across the study area, the administrative unit where fires occurred (YNP, GTNP, and BTNF) was
included in the dataset (Table 1). If the unit variable was included as a split variable in any of the tree models, it would indicate important geographic limitations for this mapping approach.

**Accuracy Assessment**

An independent dataset including 100 random locations from each of three of the 23 fires was used to evaluate performance of the classification tree models. These included the Blind Trail fire in the BTN, the Wilcox fire in GTNP, and the Broad fire in YNP. Predicted mortality class surfaces were produced for the .07, 1, and 5 hectare spatial resolutions using conditional statements that duplicated the tree models with the ArcGIS Spatial Analyst Raster Calculator. Canopy mortality was estimated for three sizes of circular areas as before, using digital orthophotographs. Mortality class was extracted from predicted surfaces for the random locations, and used to generate error matrices and Kappa statistics (Cohen 1960) for each model (Equation 5).

\[
K = \frac{N \sum_{i=1}^{r} x_{ii} - \sum_{i=1}^{r} x_{i+} x_{+i}}{N^2 - \sum_{i=1}^{r} x_{i+} x_{+i}}
\]

(5)

\(N\) = total number of observations.
\(r\) = the number of rows in the error matrix
\(x_{ii}\) = number of observations in row \(i\) and column \(i\)
\(x_{i+}\) and \(x_{+i}\) = marginal totals for row \(i\) and column \(i\)

When higher resolution imagery (such as 1 meter digital orthophotography) is used for accuracy assessment of maps also based on remote sensing, conservative results can be expected (Verbyla and Hammond 1995). This phenomenon is due to compounding errors associated with the reference data with model-based inaccuracies.
Such errors can arise from misregistration, photo interpretation error, and time differences (Kalkhan et al 1998, Foody 2002).

Results

The three classification tree models (Figure 3) show the influence of the spatial resolution of analysis (.07, 1, and 5 hectares) for detecting different levels of mortality in burned areas using Landsat. Each model used a different burn severity index as its primary split variable to reduce the majority of deviance. The .07 hectare analysis used the RdNBR to differentiate the 0-20% and 80-100% categories at the first split (Table 2), as determined by pruning the tree model to this initial stage. The 1 hectare model made the same split with dNBR. The 5 hectare model used dNDVI to separate the middle mortality category (25-75%) from the 80-100% group. The differences can be attributed to the effect of spatial resolution on the composition of the training data, sensitivity to heterogeneity of fire effects, and properties of NBR and NDVI.

As the sizes of the circles used to estimate percent canopy mortality increased, they were more likely to include more than one patch of burned or unburned trees, and less likely to contain a single homogeneous canopy mortality category. As Figure 1 indicates, the 5 hectare estimates have disproportional distributions of the three categories because low and unburned CBI plots included adjacent burned areas. Consequently, few fell into the 0-20% mortality category. Classification trees are sensitive to unbalanced categories in the training data (Lawrence and Wright 2001), which explains why the 5 hectare model first split between the middle and higher mortality categories, where the majority of the observations were found (Table 2).
At the .07 hectare spatial resolution, the mortality estimation circles were 30 meters in diameter, and intentionally centered in a consistently burned patch of forest vegetation in the field (Key and Benson 2006). At this scale, the 25-75% category would represent a mixed lethal fire, where some trees survived and others were killed. Locations with over 80% mortality would have experienced severe surface or crown fire. As the size of the canopy mortality estimation circles increased, the fire characteristics corresponding to the three categories changed. Instead of describing the proportions of killed trees in a stand, the 0-20% and 25-75% estimates for the 1 and 5 hectare circles reflected aggregations of heterogeneous burn patches. Proportionally more of the 25-75% category was found in the 5 hectare estimates as a result. These could have included patches of surface or crown fire, or
boundary zones along the edge of more than one patch. Estimates of 80-100% mortality at these scales would indicate a homogeneous crown fire patch.

Table 2. Summary of classification tree model characteristics and performance for three spatial resolutions used for prediction and mapping canopy mortality classes.

<table>
<thead>
<tr>
<th>Resolution of Model</th>
<th>.07h</th>
<th>1h</th>
<th>5h</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model Misclassification Rate</td>
<td>26.4%</td>
<td>27.2%</td>
<td>20.6%</td>
</tr>
<tr>
<td>Main predictor (first split)</td>
<td>RdNBR</td>
<td>dNBR</td>
<td>dNDVI</td>
</tr>
<tr>
<td>Other predictor variables used</td>
<td>Elevation dNDVI</td>
<td>dNDVI RdNBR Elevation</td>
<td>dNBR NBR post fire TCT greenness Elevation</td>
</tr>
<tr>
<td>Classes resulting from first split</td>
<td>0-20% vs. 80-100%</td>
<td>0-20% vs. 80-100%</td>
<td>25-75% vs. 80-100%</td>
</tr>
<tr>
<td>Overall Accuracy Assessment</td>
<td>68.5%</td>
<td>62.5%</td>
<td>53.0%</td>
</tr>
<tr>
<td>Accuracy 0-20%</td>
<td>User’s: 67.7%</td>
<td>83.1%</td>
<td>100%</td>
</tr>
<tr>
<td>Producer’s:</td>
<td>60.9%</td>
<td>62.8%</td>
<td>5.7%</td>
</tr>
<tr>
<td>Accuracy 25-75%</td>
<td>User’s: 50.0%</td>
<td>66.7%</td>
<td>42.2%</td>
</tr>
<tr>
<td>Producer’s:</td>
<td>25.4%</td>
<td>14.5%</td>
<td>57.4%</td>
</tr>
<tr>
<td>Accuracy 80-100%</td>
<td>User’s: 72.2%</td>
<td>56.4%</td>
<td>63.2%</td>
</tr>
<tr>
<td>Producer’s:</td>
<td>92.1%</td>
<td>93.7%</td>
<td>78.9%</td>
</tr>
<tr>
<td>Kappa</td>
<td>0.45</td>
<td>0.38</td>
<td>0.25</td>
</tr>
</tbody>
</table>

Because the characteristics being described for the three mortality categories changed depending on spatial resolution, it is not surprising that different reflectance characteristics best discriminated between them. NBR and NDVI have different properties due to the alternate use of red reflectance (Landsat TM and ETM+ Band 3) and
middle infrared (Band 7). NDVI is more sensitive to plant photosynthesis, while NBR enhances differences in exposed dry soils, ferrous minerals, and ash (White et al 1996). Due to their size, the 5 hectare circles were more likely than the others to include diverse vegetation types and multiple burned patches. The primary split separated the 25-75% mortality category from the over 80% group (Table 2). The distinction between these levels was best made using dNDVI, suggesting that differences in the overall cover of photosynthesizing vegetation best separate them (White et al 1996).

The .07 and 1 hectare classification tree models appear to have capitalized on the sensitivity of NBR to change in blackened and ashy surfaces. The proportions of observation in the training data for these models were well balanced, and the first splits separated the 0-20% and 80-100% categories as would be expected. The relativized version of dNBR (RdNBR) was used for the primary split in the .07 hectare model with the original 30 meter pixel resolution. The RdNBR is more sensitive than dNBR to subtle changes, such as might be detected with higher spatial resolution when only a proportion of the trees in a forest canopy is burned.

Once pruned using ten-fold cross-validation, none of the classification tree models used pre-fire forest type, TCT brightness or wetness, or administrative unit. Apparently differences in the pre-fire vegetation, fuels, or mountain range discernible by these variables were not important for differentiating canopy mortality levels post-fire. At the spatial resolutions used, the various forested landscapes may appear relatively similar when burned. At the larger scales of analysis forest type and TCT layers would also likely represent an aggregation of vegetation and fuels, which would tend to diminish any relationship that might exist for predicting canopy mortality. The lack of
these predictor variables in the final classification trees suggests that the models are useful across the entire study area, and may be applicable over larger geographic regions.

Model misclassification rates (Table 2) and error matrices (Table 3) from independent testing show the importance of appropriate spatial resolution for mapping and modeling canopy mortality in burned areas. The three spatial resolutions resulted in different misclassification rates for observed and predicted training data, as well as varied performance using a separate dataset.

Table 3. Error matrices for accuracy assessment using independent random samples. One hundred samples each in three fires were obtained, however some locations were non-forested resulting in fewer than 300 total observations.

<table>
<thead>
<tr>
<th></th>
<th>Predicted 0-20%</th>
<th>Predicted 25-75%</th>
<th>Predicted 80-100%</th>
<th>Observed 0-20%</th>
<th>Observed 25-75%</th>
<th>Observed 80-100%</th>
</tr>
</thead>
<tbody>
<tr>
<td>.07h Resolution Model</td>
<td>42</td>
<td>13</td>
<td>7</td>
<td>62</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1h Resolution Model</td>
<td>49</td>
<td>7</td>
<td>3</td>
<td>59</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5h Resolution Model</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The highest overall accuracy for the three mortality categories was provided by the .07 hectare map (68.5%) (Table 2). It also showed a reasonable Kappa statistic of 0.45 (Kalkhan et al 1997), suggesting that the model’s accuracy can be differentiated from that of random chance. The 92% producer’s accuracy for the 80-100% mortality category indicates that most of the stand-replacing fire effects were correctly mapped. The user’s accuracy (75%), however, was lower because many of the predicted 80-100% pixels actually belonged in the 25-75% mortality category. The model mainly underpredicted the middle category at lower elevations (user’s accuracy 50%) due to the
role of elevation as a limiting factor in the tree model (Figure 3). The model is structured in such a way that only locations above 2011.53 meters can be assigned the 25-75% mortality category. This rule detracts from the utility of the elevation variable in classification tree models, especially because the middle mortality category is known to occur below 2011.53 meters in the training dataset. However, the elevation threshold does have some basis in fire behavior. High elevation forests in the study area are sparse, and have limited fuels for carrying fire between trees (Bradley et al 1992). Moister environments and shorter growing seasons prevent fine fuels from drying to levels where fire can carry consistently (Countryman 1972, Ryan 2002), thus mixed tree mortality would be expected. In comparison to the aerial photographs, the .07 hectare model surfaces appear to more accurately detect the middle category at high elevations.

At .07 hectares, a pronounced speckle pattern of the middle and high mortality categories is evident in the predicted map surfaces outside of the burn perimeters, particularly in rocky areas (Map 1A). It is likely that misregistration between the unfiltered pre- and post-fire satellite images has caused this artificial change where adjacent patches of rock and vegetation were misaligned.

The 1 hectare map accuracy was 62.5% overall (Table 3) with a Kappa statistic of 0.38. The producer’s and user’s accuracies for the 0-20% mortality class were improved over those of the .07 hectare map. The producer’s accuracy for 80-100% mortality was 93.7%. This category appears to be overpredicted, however, as indicated by a 56.4% user’s accuracy. The 25-75% category is often mapped as 80-100% by this model. Once again, this problem is linked to an elevation threshold in the tree model (Figure 3), but to a greater degree. With a larger circle used to estimate mortality, more observations
belonged to this category due to the inclusion of more combinations of adjacent burned and unburned patches (82 versus 73 for the .07 hectare dataset). With more 25-75% observations, more were incorrectly predicted below 2478 meters (14.5% producer’s accuracy). This threshold is also substantially higher, and thus more restrictive than the 2011.53 meter level in the .07 hectare tree model.

Map 1. Canopy Mortality Predicted Surfaces for the Wilcox Fire at three spatial resolutions: A. = .07 h, B = 1h, C = 5h. The speckle pattern of canopy mortality outside of the fire in A probably resulted from RdNBR image misregistration. Note the large 25-75% boundary areas around each patch of the 80-100% category in C.

Examination of the 1 hectare model predicted surface shows much less speckle of middle and high mortality pixels outside of the burn perimeter (Map 1B). The 1 hectare focal mean filter has apparently corrected for many misregistration errors that falsely indicated change. However, the maps are much more homogeneous, and appear to miss many small patches of the lower and middle mortality categories visible on aerial photographs, even at high elevations.
The accuracy assessment at the 5 hectare map showed the poorest overall performance, at only 53.0% (Kappa = 0.25). This contrasts with the low misclassification rate (20.6%) given for the model’s observed and predicted training data, underscoring the importance of independent testing. It also illustrates drawbacks associated with the coarse spatial resolution used, and the related problem of unbalanced training data. With only 25 observations in the dataset for the 0-20% mortality category, the tree is only capable of predicting the low mortality category under very specific criteria (Figure 3). Consequently, most of the forest outside of the burn perimeters is mapped as 25-75% mortality. The producer’s accuracy for this category is only 5%.

Map 1C shows the most troublesome result of the 5 hectare spatial resolution model. Misclassification of boundary pixels between crown fire patches and adjacent unburned forest caused very wide buffers (200-250 meters) of 25-75% mortality pixels to be erroneously mapped along the edges of 80-100% patches. When compared with aerial photographs, the sizes of these high mortality crown fire patches were substantially reduced on the predicted surface. This led to very high user’s accuracy (100%) because all of the pixels mapped as 80-100% mortality really were that category, however only 5.7% of the locations on the ground with that degree of canopy mortality were correctly mapped. Nearly all of the remaining pixels on the entire map were attributed to the 25-75% mortality class, even outside of the known fire perimeters.

Conclusions and Discussion

In modeling and mapping canopy mortality in burned areas using classification trees, each of the classification tree models used primarily Landsat TM and ETM+ derived remote sensing burn severity indices and elevation to predict canopy mortality.
Different spatial resolutions produced different models with different sets of predictors and levels of map accuracy.

The resolution of the 1 and 5 hectare canopy mortality maps was too coarse to distinguish stands where partial tree mortality has occurred. Instead, they function to identify mixtures of adjacent burned patches. The burned forests with truly partial tree mortality are ecologically important (Turner and Romme 1994), however they have patterns that are too small to be separable at 1 or 5 hectares. These spatial resolutions of these thematic maps are therefore unlikely to provide the kind of information desired for research or management applications.

The 5 hectare model analysis was further hampered by insufficient 0-20% mortality observations in the training data. Unburned sample locations obtained farther from adjacent burned forest would have improved the model. Boundary pixel misclassifications due to aggregation along the edges of burned patches would have still led to poor accuracy, however.

The best accuracy resulted from the .07 hectare analysis without spatial filtering (68.5% overall accuracy, Kappa 0.45). The 30 meter pixel-based maps based on .07 hectare estimates were better able to detect the smaller and more subtle patterns of canopy mortality, including partially killed patches. The accuracy for the 80-100% category, which would correspond to crown fire areas, is particularly high (producer’s 92.1%, user’s 72.2%). The middle category of mortality is poorly predicted (user’s 50%, producer’s 14.5%). Key (2006) noted a similar poor performance in dNBR burn severity mapping, where the small-scale variability in moderate severity effects was poorly detected.
The .07 hectare tree model uses RdNBR as the primary split variable to differentiate categories of mortality. RdNBR may be registering some of the subtle changes associated with fire patterns that occur at the scale of individual trees or groups of trees, smaller than a 30 meter pixel. This is difficult to evaluate, however, because the tree model uses an elevation threshold that limits this category to locations above 2011.53 meters. For this reason, partial canopy mortality (25-75%) is best predicted at high elevations. As indicated by speckle patterns of canopy mortality outside the fire perimeters, misregistration errors are occurring at this spatial resolution. As a next step in this study, it would be appropriate to test a minimal spatial filter, such as a 3x3 moving window, to see if this would improve accuracy or decrease it.

Total proportions of tree mortality classes in the predicted surfaces are similar for the .07 and 1 hectare model surfaces, however at 5 hectares; the model predicts less than 2% of the area within the burn perimeters in the 0-20% class, and a much larger proportion of the middle mortality class (Figure 4). From independent testing, we know that these proportions are unrealistic.
Aside from spatial resolution, the limitations of Landsat TM and ETM+ imagery for mapping canopy mortality stem also from other errors inherent in remote sensing and GIS. Misregistration of paired imagery, GPS position error, inaccurate aerial photo interpretation, post-fire time delay differences, and other data noise likely contributed to model and map inaccuracy. Nevertheless, it appears that remote sensing of canopy mortality can provide reasonably accurate maps of crown fire effects, because many of these more homogeneous high severity patterns are large enough to be differentiated at the 30 meter pixel resolution. More subtle low and moderate severity surface fire effects, however, are too small to be reliably mapped using this technology. The fire behavior processes and effects that lead to partial canopy mortality are heterogeneous as a result of small spot fires, variable degrees of tree girdling, fuel beds, and forest composition (Miller and Urban 2000, Hudak et al 2004, Rocca 2004). Mapping these mixed areas is
difficult if these patterns are smaller than the resolution of remote sensors (Lentile et al 2006).

Crown fire behavior processes driven by drought and wind occur at scales that are both spatially and temporally different from those of surface fire. Surface fires under average weather conditions are much more subject to environmental variability, and thus are more spatially complex (Agee 1998, Miller and Urban 2000). While one process can be observed at the 30 meter pixel resolution, the other cannot.

Figure 5 shows a continuum of fire behaviors and operational scales (as described by Ryan 2002) in the fire regime of northwest Wyoming (combining the stand replacing and mixed severity types of Arno 2000 and Brown 2000). Along the horizontal axis, the severity of weather conditions increases from moist through extreme drought and wind. The vertical axis increases with the operational scale of fire behavior and effects from a particle of surface fuel to an entire landscape. During moist seasons or moderate weather fire creeps slowly through fine fuels and burns small patches according to microtopography and fuel loading (Rocca 2004). Average weather conditions allow surface fires to run through the forest understory and torch individual trees and groups of trees (Ryan 2002). Once a certain threshold of drought and wind speed is reached, (indicated by the dashed line) crown fire spreads (Bessie and Johnson 1995, Miller and Urban 2000). These fires are controlled by larger forces and patterns (Turner et al 1994). Above the dashed line (B), remote sensing with Landsat TM and ETM+ imagery is effective for mapping canopy mortality effects. Below the line (A), the 30 meter spatial resolution is too coarse to make accurate mapping feasible.
Figure 5. Fire behavior and effects according to drought and wind conditions in the fire regime of northwest Wyoming forests (x axis), and spatial domain of fire behavior (y axis). The shaded area (B) represents the stand replacing expression that can be mapped with Landsat imagery. The left portion (A) includes mixed lethal tree effects from surface fire that are not accurately mapped at this resolution.

If Landsat satellite technology is used to map the effects of fire in the landscapes of the Greater Yellowstone Ecosystem, the spatial distributions of crown fire disturbances will be well documented. This information will lead to better understanding of this disturbance regime. Unfortunately, the other expression of the dual fire regime will not be as well captured. The ‘mixed’ effects of surface fires may be overlooked. The ecological importance of these more subtle disturbance patterns may be neglected because they cannot be assessed from space. The small scale heterogeneity of surface fire in ‘mixed severity regimes’ is poorly understood (Arno 2000, Rocca 2004), and it is not incorporated in spread models (Rothermel 1972, Van Wagner 1977). Fire suppression has been much more successful in eliminating the fires that occur under these conditions.
If managers and researchers rely on 30 meter pixel resolution imagery to understand the fire regime of the Rocky Mountains, an important aspect of the fire regime will be unknown, and its ecological significance may be forgotten in land use management.

It is important for fire researchers and resource managers to understand the capabilities and limitations of remote sensing data for fire effects mapping that this study has revealed. This is because important and far-reaching decisions are often made using maps. For example, timber salvage sales, wildlife habitat protection, and stream stabilization practices will likely depend on remotely-sensed GIS data. Updates to current higher resolution vegetation and fuels GIS layers can be made from remote sensing for burned areas (Ryan 2002, Zhu 2006), but users must be aware of the effects of reduced spatial precision.

Finally, our scientific understanding of fire regimes is also subject to interpretations made at scales dictated by technological specifications rather than ecological processes. Not only are we at risk of overemphasizing crown fire at the expense of the other fire processes we cannot map, we will compromise our understanding of fire’s true ecological effects.

Higher resolution sensors are needed to accurately map the finer-scale heterogeneity of the effects of partially-lethal surface fire. Current research into spectral mixture analysis shows interesting potential for evaluating sub-pixel effects of Landsat TM and ETM+ images (Robichaud et al 2007, Smith et al in press). Digital aerial photography, whether interpreted by humans or machines, may also prove useful for obtaining inexpensive large sample sizes for modeling and mapping of canopy mortality.
Spatial attributes such as burned area fractal dimension or mean patch size may enhance model performance. Fuzzy classification methods using tree models to map probability surfaces may enhance their functioning (Lawrence and Wright 2001). More research into these areas will improve understanding of the patterns and processes of the entire fire regime rather than only the stand replacing expression.

**Literature Cited:**


CHAPTER 4: SYNTHESIS

This research process has shown that it is possible to make maps of canopy mortality patterns due to crown fire using Landsat imagery. Relative dNBR (RdNBR) appears to be most effective for distinguishing this pattern at the pixel scale according to classification tree modeling. DNBR is more easily obtained, however, from the Federally-sponsored Monitoring Trends in Burn Severity (MTBS) program (Eidenshink et al 2007) and can be used alone with elevation and aspect to produce maps with slightly reduced accuracy compared to the model using RdNBR, elevation, and dNDVI. At Grand Teton National Park and the Bridger-Teton National Forest, these maps will be used in the near future for assessments of snowshoe hare habitat (as part of endangered Canada lynx management), post-fire reforestation planning, hydrologic assessments, and vegetation map updates.

Scale of analysis has distinct effects on map accuracy and utility, particularly for the important middle categories of partial canopy mortality. Due to the problems of small-scale heterogeneity in mixed-lethal burns, it is difficult to detect these areas with 30 meter pixels, and more so at 1 or 5 hectare aggregations. To make matters worse, the characteristics being mapped as the middle canopy mortality category are different as the spatial resolution increases. Areas that were 25-75% mortality in the 1 and 5 hectare circles represented boundaries between adjacent burned or unburned patches. True partial canopy mortality, with a mixture of killed and living trees, is poorly captured, despite its ecological importance for community diversity, forest structure, succession, and fuel loading (Turner et al 1994, Agee 1998, Ryan 2002, Rocca 2004). Even with the best combination of spatial resolution and positional accuracy, remotely sensed maps of
burn severity are only able to tell part of the story of fire’s effects. In northern Rocky Mountain forests, larger patches of high or complete mortality (such as crown fire) can be detected with high accuracy. However, low severity surface fire or heterogeneous effects to the soil surface are often lost in these mapping processes. Only the fire behavior processes and effects that occur above the fire regime’s drought and wind threshold are represented.

With the adoption of the MTBS program (Eidenshink et al. 2007) remote sensing and mapping of wildland fire severity is standard procedure. Kolden and Weisberg (2007) predicted that Landsat-based mapping of wildfires will soon replace manual mapping methods. If so, this research suggests that only crown fire effects will be adequately mapped in the northern Rocky Mountains. A risk associated with this is that resource managers using these maps may ignore the mixed severity processes, and fail to assure their perpetuation under future scenarios.

The scale of analysis for canopy mortality mapping using Landsat TM and ETM+ should be as small as possible, with minimal spatial aggregation to compensate for misregistration and positional errors inherent in the technology. Other sources of remote imagery should be explored, such as USDA National Agriculture Imagery Program digital photography (used in this study for canopy mortality estimation and accuracy assessment). If Landsat dNBR and RdNBR products continue to be available, a 3x3 moving window filter with .5 hectare or smaller canopy mortality estimates should be evaluated in for modeling and mapping in the future.

The Composite Burn Index (CBI) plot protocols of Key and Benson (2006) are intended to bridge the field-level and remote sensing burn severity ratings for ground-
truthing burn severity mapped with dNBR. Given that overstory and ground fire effects are distributed independently, however (Jain and Graham 2007), this composite approach may be less effective than separately calibrating the substrate and overstory ratings. This may lead to poor correlations between the overall CBI scores and dNBR pixel values. In addition, the resolution of Landsat is too coarse to adequately detect small scale heterogeneity in soil effects (Robichaud et al. 2007).

Chapter 2 showed that the use of digital orthophotography was appropriate for generating canopy mortality estimates for model development. This approach would allow collection of a many more observations for modeling and mapping with classification trees. With a substantially larger dataset, it is possible that more than three categories of mortality could be accurately mapped, because classification trees perform better with larger datasets (Mingers 1989). A continuous canopy mortality model using regression trees rather than classifications would be unlikely, however, because air photo estimations more precise than the nearest 5% are not practical.

Photo-based canopy mortality estimates could also be used to also facilitate a random sampling approach for generating model training data. This method would be less likely to have the unbalanced proportions of categories in the training data found with CBI plot locations. While this probably had minimal effects on the models for all but the coarsest spatial resolutions, the bias could be easily avoided in the future.

Classification tree models for mapping canopy mortality in this study used primarily NBR change detection indices and elevation. An elevation threshold in classification tree models prevented the 25-75% category from occurring below certain threshold elevations. Elevation was an important predictor variable, however such ordinal
variables do not seem ideally suited to classification tree modeling for fire disturbance. Even without pruning, forest type, TCT transformations, administrative units, and slope were not needed in the tree models. Because the different pre-fire vegetation and fuels characteristics did not help to predict post-fire tree survival, these models may be more widely applicable outside of the study area.

One of the appeals of using Landsat data for burn severity mapping is the rich archival record of imagery dating back to the first Landsat Multispectral Sensor (MSS) mission in 1972 (Lilesand et al 2004). Band 7 was not part of the program’s data collection until Landsat 4 TM was launched in 1982. If burn severity (or canopy mortality) maps are desired for fires that occurred during the MSS missions, the RdNDVI or dNDVI would be required. The spatial resolution of these early Landsat sensors was 79 meters, which would compromise the detection of mixed severity effects.

**Literature Cited:**


### APPENDIX A

GIS Processes

#### Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>120</td>
</tr>
<tr>
<td>Canopy Mortality Estimates from Digital Orthophotographs</td>
<td>120</td>
</tr>
<tr>
<td>Sources of Digital Orthophotography</td>
<td>120</td>
</tr>
<tr>
<td>CBI Plot Locations Shapefile</td>
<td>120</td>
</tr>
<tr>
<td>Landsat Burn Severity Products</td>
<td>122</td>
</tr>
<tr>
<td>Obtaining Data</td>
<td>122</td>
</tr>
<tr>
<td>Re-projecting Pre- and Post-fire 6 Band Imagery and dNBR</td>
<td>124</td>
</tr>
<tr>
<td>Subsetting the 23 Fires</td>
<td>124</td>
</tr>
<tr>
<td>Standardizing the dNBR</td>
<td>125</td>
</tr>
<tr>
<td>Mosaicking the Standardized dNBR to One Layer</td>
<td>127</td>
</tr>
<tr>
<td>Creation of Pre- and Post-fire NBR</td>
<td>128</td>
</tr>
<tr>
<td>Creation of the RdNBR</td>
<td>130</td>
</tr>
<tr>
<td>Creation of Pre- and Post-burn NDVI</td>
<td>130</td>
</tr>
<tr>
<td>Creation and Standardization of dNDVI</td>
<td>131</td>
</tr>
<tr>
<td>Creation of RdNDVI</td>
<td>132</td>
</tr>
<tr>
<td>Tasseled Cap Transformations</td>
<td>132</td>
</tr>
<tr>
<td>Creating TCT Bands</td>
<td>132</td>
</tr>
<tr>
<td>Re-Projecting TCT bands</td>
<td>133</td>
</tr>
<tr>
<td>Topography</td>
<td>134</td>
</tr>
<tr>
<td>Obtaining Data</td>
<td>134</td>
</tr>
<tr>
<td>Creating Percent Slope and Aspect</td>
<td>134</td>
</tr>
<tr>
<td>Forest Type</td>
<td>135</td>
</tr>
<tr>
<td>Obtaining and Reprojecting Data</td>
<td>135</td>
</tr>
<tr>
<td>Reclassifying Vegetation into Forest Types</td>
<td>136</td>
</tr>
<tr>
<td>Creating Three Spatial Resolutions</td>
<td>142</td>
</tr>
<tr>
<td>Point Extraction from Raster Data</td>
<td>144</td>
</tr>
<tr>
<td>Accuracy Assessment</td>
<td>144</td>
</tr>
<tr>
<td>Random Point Generation</td>
<td>144</td>
</tr>
<tr>
<td>Making Predicted Surfaces</td>
<td>147</td>
</tr>
<tr>
<td>Extracting Predicted Values for Accuracy Assessment Locations</td>
<td>149</td>
</tr>
<tr>
<td>Analysis of Sampling Bias for CBI Plot Locations</td>
<td>149</td>
</tr>
<tr>
<td>Literature Cited</td>
<td>150</td>
</tr>
</tbody>
</table>
Introduction

This appendix provides step-by-step descriptions and screen shots of the Geographic Information System (GIS) methods used in the modeling and mapping of forest canopy mortality in burned areas for this Thesis research. GIS procedures were used to derive data for both building and testing binary classification tree models using Landsat-5 TM and Landsat-7 ETM+ imagery, as well as several other raster layers. Refer to Chapter 1 for data characteristics and rationale for model data selection. The ESRI ArcGIS 9.1 suite with Spatial Analyst, Image Analysis, and Hawth’s Tools Extensions was used for creation and manipulation of raster data. Erdas Imagine 9.1 was used to produce Tasseled Cap Transformations from pre-fire imagery.

Canopy Mortality Estimates from Digital Orthophotographs

Sources of Digital Orthophotography

Color infrared quarter-quad orthophotographs with one meter pixel resolution were obtained from the Wyoming GIS Coordination Structure (http://wgiac.state.wy.us/html/aboutDoqq2002.asp). They were derived from air photographs taken over the entire state of Wyoming between 2001 and 2002 (see example metadata file in supplemental data DVD). The scars of 2000 – 2001 fires are evident in these photographs, while pre-burn images are provided for 2002-2003 fires.

True color 1 meter pixel aerial orthophotographs for Wyoming counties for the summer of 2006 were also used. They were produced by the USDA National Agricultural Inventory Program (NAIP) (See example metadata in supplemental DVD). The effects of all 23 fires are evident in these images.

Both the color infrared and true color orthophotos were provided in UTM NAD 83 for Zone 12N.

CBI Plot Locations Shapefile

Each of the 694 Composite Burn Index (CBI) plot locations used for estimating canopy mortality was recorded using Global Positioning System (GPS) devices in the field (Key and Benson 2006). The UTM coordinates were entered in to a database and imported as a layer in ArcMap (Tools Menu > Add XY Data). The new layer was then saved as a point shapefile (see supplemental data DVD). Each location in the attribute table included a field estimate of percent canopy mortality for the 30 meter diameter CBI plot, however new estimates were needed for other spatial resolutions. Digital aerial orthophotography provided a means to develop this data.

The ArcToolbox Buffer tool was used to create concentric circles of .07, 1, and 5 hectares in size for each CBI plot location (ArcToolbox > Analysis Tools > Proximity > Buffer). Buffer distances of 15, 56.41, and 126.16 meter were specified around each point, creating circles having these radii (see example, Figure A-1). The resulting three shape files were displayed in ArcMap over digital orthophotograph layers. Percent mortality was estimated and recorded for each circle size at each location, using the
screen display (Figure A-2). The same process was used to make canopy mortality estimates for accuracy assessment locations.

Figure A-1. The Buffer tool was used to create .07, 1, and 5 hectare circles at each CBI plot location for estimating percent mortality using digital orthophotos. In this example, the 1 hectare circles are created using a 56.14 meter buffer distance, corresponding to a circle with that radius.
Figure A-2. Color infrared (left) and true color (right) digital orthophotographs with .07, 1, and 5 hectare concentric circles for estimating percent canopy mortality in the ArcMap viewer.

**Landsat Burn Severity Products**

*Obtaining Data*

Landsat TM and ETM+ satellite products (differenced Normalized Burn Ratio (dNBR) subsets, pre- and post-fire 6 band imagery) were downloaded from the USGS burn severity website (http://burnseverity.cr.usgs.gov/download_data.php). As Extended Assessment protocols dictate (Key 2006), the pre-fire imagery was obtained during the middle of the growing season. The post-fire imagery closely duplicated the plant phenology of the pre-fire image after one season of vegetative recovery. Eleven image pairs were used to provide the necessary burn severity indices for the 23 fires in the study area, because the fires occurred during different years, over three row-path locations (Table A-1).
Table A-1. Pairs of Landsat scenes used for generating burn severity indices. Pre-fire images were used for TCT brightness, greenness, and wetness bands.

<table>
<thead>
<tr>
<th>Fire Name</th>
<th>Path-Row ID</th>
<th>Pre Image Date</th>
<th>USGS ID Pre Image</th>
<th>Type</th>
<th>Post Image Date</th>
<th>USGS ID Post Image</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boundary</td>
<td>3829</td>
<td>7/15/2000</td>
<td>7038029000726450</td>
<td>ETM+</td>
<td>7/2/2001</td>
<td>703802900118350</td>
<td>ETM+</td>
</tr>
<tr>
<td>Broad</td>
<td>3829</td>
<td>7/15/2000</td>
<td>7038029000726450</td>
<td>ETM+</td>
<td>8/1/2003</td>
<td>5038029000321310</td>
<td>TM</td>
</tr>
<tr>
<td>Divide</td>
<td>3730</td>
<td>7/3/2001</td>
<td>5037030000118410</td>
<td>TM</td>
<td>7/9/2003</td>
<td>5037030000139010</td>
<td>TM</td>
</tr>
<tr>
<td>East</td>
<td>3829</td>
<td>8/1/2003</td>
<td>5038029000321310</td>
<td>TM</td>
<td>8/11/2004</td>
<td>703802900422452</td>
<td>ETM+ SLC-off</td>
</tr>
<tr>
<td>East Table</td>
<td>3830</td>
<td>7/29/2002</td>
<td>5038030000221010</td>
<td>TM</td>
<td>8/11/2004</td>
<td>7038030000422452</td>
<td>ETM+ SLC-off</td>
</tr>
<tr>
<td>Enos</td>
<td>3829</td>
<td>7/15/2000</td>
<td>7038029000726450</td>
<td>ETM+</td>
<td>7/2/2001</td>
<td>703802900118350</td>
<td>ETM+</td>
</tr>
<tr>
<td>Falcon</td>
<td>3829</td>
<td>7/15/2000</td>
<td>7038029000726450</td>
<td>ETM+</td>
<td>7/5/2002</td>
<td>703802900218650</td>
<td>ETM+</td>
</tr>
<tr>
<td>Frank</td>
<td>3829</td>
<td>8/1/2003</td>
<td>5038029000321310</td>
<td>TM</td>
<td>8/11/2004</td>
<td>703802900422452</td>
<td>ETM+ SLC-off</td>
</tr>
<tr>
<td>Glade</td>
<td>3829</td>
<td>7/15/2000</td>
<td>7038029000726450</td>
<td>ETM+</td>
<td>7/2/2001</td>
<td>703802900118350</td>
<td>ETM+</td>
</tr>
<tr>
<td>Green Knoll</td>
<td>3830</td>
<td>7/2/2001</td>
<td>7038030000118410</td>
<td>TM</td>
<td>7/2/2001</td>
<td>7038030000220250</td>
<td>ETM+</td>
</tr>
<tr>
<td>Little</td>
<td>3829</td>
<td>7/15/2000</td>
<td>7038029000726450</td>
<td>ETM+</td>
<td>7/5/2002</td>
<td>703802900218650</td>
<td>ETM+</td>
</tr>
<tr>
<td>Little Joe</td>
<td>3829</td>
<td>7/15/2000</td>
<td>7038029000726450</td>
<td>ETM+</td>
<td>7/5/2002</td>
<td>703802900218650</td>
<td>ETM+</td>
</tr>
<tr>
<td>Moose</td>
<td>3829</td>
<td>7/15/2000</td>
<td>7038029000726450</td>
<td>ETM+</td>
<td>7/5/2002</td>
<td>703802900218650</td>
<td>ETM+</td>
</tr>
<tr>
<td>Moran</td>
<td>3829</td>
<td>7/15/2000</td>
<td>7038029000726450</td>
<td>ETM+</td>
<td>7/2/2001</td>
<td>703802900118350</td>
<td>ETM+</td>
</tr>
<tr>
<td>Mule</td>
<td>3730</td>
<td>7/3/2001</td>
<td>5037030000118410</td>
<td>TM</td>
<td>7/9/2003</td>
<td>5037030000319010</td>
<td>TM</td>
</tr>
<tr>
<td>Phlox</td>
<td>3829</td>
<td>7/15/2000</td>
<td>7038029000726450</td>
<td>ETM+</td>
<td>8/1/2003</td>
<td>5038029000321310</td>
<td>TM</td>
</tr>
<tr>
<td>Stone</td>
<td>3829</td>
<td>7/15/2000</td>
<td>7038029000726450</td>
<td>ETM+</td>
<td>7/5/2002</td>
<td>703802900218650</td>
<td>ETM+</td>
</tr>
<tr>
<td>Upper Slide</td>
<td>3830</td>
<td>7/3/1999</td>
<td>70380300009919450</td>
<td>ETM+</td>
<td>7/2/2001</td>
<td>703803000019750</td>
<td>ETM+</td>
</tr>
<tr>
<td>Wilcox</td>
<td>3829</td>
<td>7/15/2000</td>
<td>7038029000726450</td>
<td>ETM+</td>
<td>7/2/2001</td>
<td>703802900118350</td>
<td>ETM+</td>
</tr>
</tbody>
</table>
Re-projecting Pre- and Post-fire 6 Band Imagery and dNBR

The Project Raster tool (ArcToolbox > Data Management Tools > Projections and Transformations > Raster > Project Raster) was used to re-project pre and post fire 6 band imagery and dNBR subsets to NAD 83 Zone 12. The re-sampling technique was nearest neighbor (Figure A-3). This was chosen because each Landsat pixel value represented a discrete characteristic of a location, rather than a continuous isopleth-type data layer occurring along a gradient (which would be better resampled using bilinear or cubic methods).

Subsetting the 23 fires

One at a time, the reprojected pre-and post-fire six band images and dNBR rasters for each fire or group of fires were loaded into ArcMap. An “area of interest” polygon shapefile called AOI.shp was created (in ArcCatalog). This shapefile was used to create a temporary rectangular polygon around each desired fire. The Extract by Mask tool (ArcToolbox > Spatial Analyst Tools > Extraction > Extract by Mask) was then used to create each fire subset (Figure A-4).
Standardizing the dNBR

Each of the eleven image pairs (Table A-1) resulted in dNBR indices that were influenced by the particular atmospheric conditions, moisture conditions, and plant phenology of their acquisition times. It was necessary to remove the bias associated with these conditions before combining them for analysis. Each dNBR was therefore standardized according to methods of Key (2006). As an example, Figure A-5 shows a temporary polygon shapefile (AOI.shp) used to sample the unburned areas surrounding the Green Knoll fire. A minimum of ten polygons (totaling at least 10,000 pixels) was used to obtain a mean value with the Zonal Statistics tool (Figure A-6) (*ArcToolbox > Spatial Analyst Tools > Zonal > Zonal Statistics*). The mean was then subtracted from the entire dNBR image in the Spatial Analysis Raster Calculator prior to using it in combination with any other dNBR subsets (Figure A-7).
Figure A-5. Temporary polygons used to select a sample of pixels in unchanged areas adjacent to the Green Knoll fire.

Figure A-6. The zonal statistics for pixels within the temporary polygons, showing the mean for unchanged areas on the differenced image to be a dNBR of -34.832.

Figure A-7. The Spatial Analyst Raster Calculator is used here to subtract the dNBR mean for unchanged areas from the entire Green Knoll fire subset.
Mosaicking the Standardized dNBRs to One Layer

All of the standardized dNBR subsets from the 23 fires were loaded into one ArcMap project file, and combined into one raster layer using the Mosaic to New Raster tool (ArcToolbox > Data Management Tools > Raster > Mosaic to New Raster) (Figures A-8, A-9).

Figure A-8. The Mosaic to New Raster tool combined all of the standardized dNBR subsets into one layer for later use. This same procedure was used for all predictor variables.
Creation of Pre- and Post-burn NBR

The re-projected pre- and post-burn 6 band image subsets were loaded into ArcMap, with the Image Analysis extension turned on. The Image Analysis toolbar pull down menu features a Vegetative Indices tool, which includes a NDVI (Normalized Differenced Vegetation Index) option that makes the calculation using bands specified by the user (Figure A-10). Because the Normalized Burn Ratio (NBR) uses the same equation as the NDVI with the substitution of Band 7 for Band 3, this tool functions for both indices.

Figure A-9. The standardized dNBR mosaic for all 23 fires in one layer. The blank spaces between subsets have no data.
Figure A-10. The Image Analysis Extension Vegetative Indices tool showing the commands for generating the Glade Fire pre burn NBR. This is done by substituting the middle infrared band for the red band in the NDVI calculation. “Band 6” in this case refers to Landsat Band 7 because the true thermal Band 6 data is absent. The same steps were used to derive the post-fire NBR for each fire.

The next step was to use the Spatial Analyst Raster Calculator to multiply the new NBR raster subsets by 1000 (Figure A-11). The Mosaic to New Raster tool was used to generate a single raster that combined all of the post burn NBR subsets for the 23 fires (see Mosaicking the Standardized dNBR to One Layer, page 126).

Figure A-11. Each derived NBR is multiplied by 1000 using the Raster Calculator to remove the decimal.
Creation of the RdNBR

The standardized dNBR and pre-fire NBR for each of the fire subsets were used to derive the Relative differenced Normalized Burn Ratios (RdNBR) (Miller and Thode 2007). The RdNBR equation was entered into the Spatial Analyst Raster Calculator as Figure A-12 illustrates.

The RdNBR subsets for all of the fires were mosaicked in to one layer using the Mosaic to New Raster tool (see Mosaicking the Standardized dNBR to One Layer, page 126).

![Image](image-url)

Figure A-12. The Spatial Analyst Raster Calculator expression used to generate the RdNBR for the Green Knoll fire from the standardized dNBR and pre-fire NBR subsets.

Creation of the Pre- and Post-fire NDVI

As with NBR, the Image Analysis extension was used to produce NDVI from the pre- and post-fire 6 band images for each of the fire subsets (see Creation of Pre- and Post-fire NBR, page 127). In the Vegetative Indices dialog box, Band 3 was specified as the visible infrared band (Figure A-13). The results were then multiplied by 1000 to remove the decimal.
Creation and Standardization of $d_{NDVI}$

The differenced NDVI ($d_{NDVI}$) was made by subtracting the post-fire NDVI from the pre-fire NDVI for each fire using the Spatial Analyst Raster Calculator (Figure A-14). Each $d_{NDVI}$ subset was standardized using the same process used with $d_{NBR}$ (see Standardizing the $d_{NBR}$, page 124). The $d_{NDVI}$ subsets were then combined into a single $d_{NDVI}$ grid for all 23 fires using the Mosaic to New Raster tool (see Mosaicking the Standardized $d_{NBR}$ to One Layer, page 126).
Creation of the RdNDVI

The Relative differenced NDVI (RdNDVI) formula divides the dNDVI by the pre-fire NDVI and multiplies it by 1000. Figure A-15 shows the expression used to create the RdNDVI for the Green Knoll fire using the Spatial Analyst Raster Calculator. As with the other burn severity indices, the RdNDVI rasters for the 23 fires were combined into one layer (see Mosaicking the Standardized dNBR to One Layer, page 126).

![Figure A-15. Creation of the RdNDVI using the Spatial Analyst Raster Calculator](image)

Tasseled Cap Transformations

Creating TCT Bands

Erdas Imagine 9.1 was used to derive the pre-fire Tasseled Cap Transformations (TCT) from the original 6-band image subsets downloaded from the USGS. Figure A-16 shows the Tasseled Cap dialog box (Spectral Enhancement > Data Prep > Tasseled Cap). This operation created six new bands, but only the first three (brightness, greenness, and wetness) were retained.
Re-Projecting TCT Bands

The three TCT band rasters were re-projected to UTM NAD 83 in ArcGIS ArcToolbox using the Data Management Raster Project tool with nearest neighbor resampling (see Reprojecting the Pre-and Post-fire 6 Band Imagery and dNBR, page 123). They were then clipped to rectangular subsets surrounding each fire using the Extract by Mask tool with the dNBR subsets used as masks (ArcToolbox > Spatial Analyst Tools > Extraction > Extract by Mask). Mosaics of all 23 fires were made for brightness, greenness and wetness (TCT 1-3) using the same methods described in Mosaicking the Standardized dNBR to One Layer, page 126).
Topography

Obtaining Data

USGS digital elevation models (DEM) were provided by Yellowstone National Park, Grand Teton National Park, and the Bridger-Teton National Forest. The 10 meter Yellowstone DEM was resampled to 30 meter pixels to match the resolution of the Landsat products and other DEMs (ArcToolbox Data Management Tools > Raster > Resample) (Figure A-17). The bilinear technique was chosen because elevation exists along a continuous gradient. The Yellowstone elevation data was also converted from feet to meters by multiplying it by .3048 in the Spatial Analyst Raster Calculator.

![Resample.tif](image)

Figure A-17. Resampling of the Yellowstone 10 meter DEM to 30 meter resolution with the bilinear technique

The 30 meter DEM data files for the three administrative units of the study area are very large. For more efficient processing, the 23 fire areas were extracted using the Extract by Mask tool (ArcToolbox > Spatial Analyst Tools > Extraction > Extract by Mask), with temporary polygons used as the masks. The three resulting rasters were then combined according to the methods in Mosaicking the Standardized dNBR to One Layer, page 126).

Creating Percent Slope and Aspect

The 30 meter DEM mosaic including all of the fires in the study area was used to create a percent slope layer with the Slope tool (ArcToolbox 3D Analyst > Raster Surface > Slope) (Figure A-18). The Aspect tool (ArcToolbox 3D Analyst > Raster Surface > Aspect) was used to make the aspect layer (Figure A-19).
Forest Type

Obtaining and Reprojecting Data

Pre-fire forest type data was obtained from vegetation maps provided by Yellowstone National Park, Grand Teton National Park, and the Bridger-Teton National Forest. Pre-fire vegetation for Grand Teton National Park consisted of vector maps made using aerial photography digitized in 1979. This shape file was converted to 30 meter resolution raster format (ArcToolbox > Conversion Tools > To Raster > Polygon to Raster) (Figure A-20). Yellowstone National Park provided a 30 meter pixel raster vegetation layer that originated from the same 1979 source. Vegetation data from the Bridger-Teton National forest was obtained from a 1998 Landsat-derived 30 meter pixel raster map made by Utah State University. See the supplemental data DVD (Appendix C) for metadata for all three vegetation data layers.
Reclassifying Vegetation into Forest Types

The Bridger-Teton National Forest map was re-projected to UTM NAD 83 using the nearest neighbor technique (ArcToolbox > Data Management Tools > Projections and Transformations > Raster > Project Raster). Each of the three vegetation rasters was then reclassified to produce a forest type map using the Reclassify tool (ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify) (Figure A-21). Five forest types and a nonforested category were derived from the three vegetation maps, as specified in Tables A-2, A-3, and A-4.

Once reclassified, the three forest type maps were combined together using the Mosaic to New Raster tool (ArcToolbox > Data management Tools > Raster > Mosaic to New Raster). Because of overlap, the aerial-photo derived Grand Teton National Park vegetation map was chosen to supersede the Bridger-Teton National Forest map in the final output (Figure A-22).
Figure A-21. The Spatial Analyst raster Calculator Reclassify dialog box with values for the Bridger-Teton National Forest vegetation and forest types.

Table A-2. Reclassification of the Grand Teton National Park Vegetation Cover Types into Forest Types.

<table>
<thead>
<tr>
<th>Original Map Cover Type</th>
<th>Original Pixel Value</th>
<th>Reclass Pixel Value</th>
<th>Reclassified Forest type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lodgepole Pine(0)</td>
<td>0</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Moist_Grassland/Meadow (&gt;7400')</td>
<td>1</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Whitebark(0)</td>
<td>2</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Whitebark(4)</td>
<td>3</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Lodgepole Pine(3)</td>
<td>4</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole Pine(2)</td>
<td>5</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole Pine(1)</td>
<td>6</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Spruce-Fir(4)</td>
<td>7</td>
<td>2</td>
<td>Spruce-fir</td>
</tr>
<tr>
<td>Lodgepole Pine(4)</td>
<td>8</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Douglas-Fir(4)</td>
<td>9</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Moist_Sagebrush/Cinquefoil</td>
<td>10</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Water Body</td>
<td>11</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Marsh/Fen</td>
<td>12</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Marsh/Fen (&gt;7400')</td>
<td>13</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Talus</td>
<td>14</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Wet_Meadow (&gt;7400')</td>
<td>15</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Moist_Grassland/Meadow</td>
<td>16</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Wet_Meadow</td>
<td>17</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Low_Willow</td>
<td>18</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Dry_Forb_Meadow (&gt;7400')</td>
<td>19</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Vegetation Type</td>
<td>Value</td>
<td>Class</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td>Moist Forb Meadow</td>
<td>20</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Bedrock/Unvegetated</td>
<td>21</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Wet Forb Meadow (&gt;7400')</td>
<td>22</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Spruce-Fir(1)</td>
<td>23</td>
<td>Spruce-fir</td>
<td></td>
</tr>
<tr>
<td>Douglas-Fir(3)</td>
<td>24</td>
<td>Douglas-fir</td>
<td></td>
</tr>
<tr>
<td>Water Course</td>
<td>25</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>High Elevation Grassland</td>
<td>26</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Douglas-Fir(2)</td>
<td>27</td>
<td>Douglas-fir</td>
<td></td>
</tr>
<tr>
<td>Mixed Forest(1)</td>
<td>28</td>
<td>Spruce-fir</td>
<td></td>
</tr>
<tr>
<td>Tall Shrub</td>
<td>29</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Douglas-Fir(1)</td>
<td>30</td>
<td>Douglas-fir</td>
<td></td>
</tr>
<tr>
<td>Spruce-Fir(0)</td>
<td>31</td>
<td>Spruce-fir</td>
<td></td>
</tr>
<tr>
<td>Dry Grassland/Meadow</td>
<td>32</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Dry Forb Meadow</td>
<td>33</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Dry-Moist Forest Opening</td>
<td>34</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Wet Forest Opening</td>
<td>35</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Whitebark(3)</td>
<td>36</td>
<td>High elevation spruce-fir</td>
<td></td>
</tr>
<tr>
<td>Wet Forb Meadow</td>
<td>37</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Cliff</td>
<td>38</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Whitebark(2)</td>
<td>39</td>
<td>High elevation spruce-fir</td>
<td></td>
</tr>
<tr>
<td>Dry Sagebrush</td>
<td>40</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Human Development</td>
<td>41</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Tall Shrub (&gt;7400')</td>
<td>42</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Aspen(2)</td>
<td>43</td>
<td>Aspen</td>
<td></td>
</tr>
<tr>
<td>Aspen(4)</td>
<td>44</td>
<td>Aspen</td>
<td></td>
</tr>
<tr>
<td>Aspen(3)</td>
<td>45</td>
<td>Aspen</td>
<td></td>
</tr>
<tr>
<td>Whitebark(1)</td>
<td>46</td>
<td>High elevation spruce-fir</td>
<td></td>
</tr>
<tr>
<td>Aspen(0)</td>
<td>47</td>
<td>Aspen</td>
<td></td>
</tr>
<tr>
<td>Mixed Forest(2)</td>
<td>48</td>
<td>Spruce-fir</td>
<td></td>
</tr>
<tr>
<td>Douglas-Fir(0)</td>
<td>49</td>
<td>Douglas-fir</td>
<td></td>
</tr>
<tr>
<td>Aspen(1)</td>
<td>50</td>
<td>Aspen</td>
<td></td>
</tr>
<tr>
<td>Graminoid/Forb-dominated Avalanche Chute</td>
<td>51</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Spruce-Fir(2)</td>
<td>52</td>
<td>Spruce-fir</td>
<td></td>
</tr>
<tr>
<td>Shrub-dominated Avalanche Chute</td>
<td>53</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Moist Sagebrush</td>
<td>54</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Tundra</td>
<td>55</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Mixed Forest(4)</td>
<td>56</td>
<td>Spruce-fir</td>
<td></td>
</tr>
<tr>
<td>Krumholtz</td>
<td>57</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Forb-Dominated Seep</td>
<td>58</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Mixed Forest(3)</td>
<td>59</td>
<td>Spruce-fir</td>
<td></td>
</tr>
<tr>
<td>Cottonwood(3)</td>
<td>60</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Agricultural</td>
<td>61</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Open Woods/Juniper</td>
<td>62</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Cottonwood(2)</td>
<td>63</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Cottonwood(1)</td>
<td>64</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Cottonwood(0)</td>
<td>65</td>
<td>Non forested</td>
<td></td>
</tr>
<tr>
<td>Cottonwood(0)</td>
<td>66</td>
<td>Non forested</td>
<td></td>
</tr>
</tbody>
</table>
Table A-3. Reclassification of the Yellowstone National Park Vegetation Types into Forest Types.

<table>
<thead>
<tr>
<th>Original Map Cover Type</th>
<th>Original Pixel Value</th>
<th>Reclass Pixel Value</th>
<th>Reclassified Forest type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lodgepole Pine, climax</td>
<td>1</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Whitebark Pine, post disturbance</td>
<td>2</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Douglas Fir, post disturbance</td>
<td>3</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Lodgepole Pine, post disturbance</td>
<td>4</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole Pine, post disturbance</td>
<td>5</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole Pine, climax</td>
<td>6</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Nonforested</td>
<td>7</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Lodgepole Pine, successional</td>
<td>8</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Engelmann Spruce &amp; Subalpine Fir, climax</td>
<td>9</td>
<td>2</td>
<td>Spruce-fir</td>
</tr>
<tr>
<td>Engelmann Spruce &amp; Subalpine Fir, climax</td>
<td>10</td>
<td>2</td>
<td>Spruce-fir</td>
</tr>
<tr>
<td>Whitebark Pine, climax</td>
<td>11</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Whitebark Pine, climax</td>
<td>12</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Whitebark Pine, climax</td>
<td>13</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Whitebark Pine, climax</td>
<td>14</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Whitebark Pine, climax</td>
<td>15</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Douglas Fir, climax</td>
<td>16</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Douglas Fir, climax</td>
<td>17</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Lodgepole Pine, climax</td>
<td>18</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Pygmy Lodgepole Pine</td>
<td>19</td>
<td>2</td>
<td>Spruce-fir</td>
</tr>
<tr>
<td>Lodgepole Pine, successional</td>
<td>20</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Pygmy Lodgepole Pine</td>
<td>21</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole Pine, successional</td>
<td>22</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Aspen</td>
<td>23</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Douglas Fir, successional</td>
<td>24</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Whitebark Pine, successional</td>
<td>25</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Whitebark Pine, successional</td>
<td>26</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Lodgepole Pine, climax</td>
<td>27</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole Pine, successional</td>
<td>28</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole Pine, successional</td>
<td>29</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole Pine, successional</td>
<td>30</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole Pine, successional</td>
<td>31</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Lodgepole Pine, successional</td>
<td>32</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole Pine, climax</td>
<td>33</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Krummholz</td>
<td>34</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Lodgepole Pine, successional</td>
<td>35</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Krummholz</td>
<td>36</td>
<td>6</td>
<td>Non forested</td>
</tr>
<tr>
<td>Aspen</td>
<td>37</td>
<td>5</td>
<td>Aspen</td>
</tr>
<tr>
<td>Whitebark Pine, successional</td>
<td>38</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Pygmy Lodgepole Pine</td>
<td>39</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Water</td>
<td>40</td>
<td>6</td>
<td>Non forested</td>
</tr>
</tbody>
</table>
Table A-4. Reclassification of the Bridger-Teton National Forest Vegetation Types into Forest Types.

<table>
<thead>
<tr>
<th>Original Map Cover Type</th>
<th>Original Pixel Value</th>
<th>Reclass Pixel Value</th>
<th>Reclassified Forest type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subalpine Fir - Cc &lt; 30%</td>
<td>1</td>
<td>2</td>
<td>Spruce-fir</td>
</tr>
<tr>
<td>Subalpine Fir - Cc 30-59%</td>
<td>2</td>
<td>2</td>
<td>Spruce-fir</td>
</tr>
<tr>
<td>Subalpine Fir - Cc &gt; 59%</td>
<td>3</td>
<td>2</td>
<td>Spruce-fir</td>
</tr>
<tr>
<td>Subalpine Fir/Doug Fir - Cc 30-59%</td>
<td>5</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Subalpine Fir/Doug Fir - Cc &gt; 59%</td>
<td>6</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Subalpine Fir/Lodgepole - Cc 30-59%</td>
<td>8</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Subalpine Fir/Lodgepole - Cc &gt; 59%</td>
<td>9</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Subalpine Fir/Spruce - Cc &lt; 30%</td>
<td>10</td>
<td>2</td>
<td>Spruce-fir</td>
</tr>
<tr>
<td>Subalpine Fir/Spruce - Cc 30-59%</td>
<td>11</td>
<td>2</td>
<td>Spruce-fir</td>
</tr>
<tr>
<td>Subalpine Fir/Spruce - Cc &gt; 59%</td>
<td>12</td>
<td>2</td>
<td>Spruce-fir</td>
</tr>
<tr>
<td>Subalpine Fir/Whitebark - Cc 30-59%</td>
<td>14</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Doug Fir - Cc &lt; 30%</td>
<td>16</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Doug Fir - Cc 30-59%</td>
<td>17</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Doug Fir - Cc &gt; 59%</td>
<td>18</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Doug Fir/Lodgepole - Cc 30-59%</td>
<td>23</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Juniper Utah - Cc &lt; 30%</td>
<td>31</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Juniper Utah - Cc 30-59%</td>
<td>32</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Lodgepole - Cc &lt; 30%</td>
<td>37</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole - Cc 30-59%</td>
<td>38</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole - Cc &gt; 59%</td>
<td>39</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Lodgepole Sapling</td>
<td>40</td>
<td>4</td>
<td>Lodgepole pine</td>
</tr>
<tr>
<td>Engelmann Spruce - Cc 30-59%</td>
<td>46</td>
<td>2</td>
<td>Spruce-fir</td>
</tr>
<tr>
<td>Engelmann Spruce - Cc &gt; 59%</td>
<td>47</td>
<td>2</td>
<td>Spruce-fir</td>
</tr>
<tr>
<td>Limber/Whitebark Pine - Cc &lt; 30%</td>
<td>48</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Limber/Whitebark Pine - Cc 30-59%</td>
<td>49</td>
<td>3</td>
<td>High elevation spruce-fir</td>
</tr>
<tr>
<td>Doug Fir/Limber - Cc 30-59%</td>
<td>52</td>
<td>1</td>
<td>Douglas-fir</td>
</tr>
<tr>
<td>Aspen - Cc &lt; 30%</td>
<td>60</td>
<td>5</td>
<td>Aspen</td>
</tr>
<tr>
<td>Aspen - Cc 30-59%</td>
<td>61</td>
<td>5</td>
<td>Aspen</td>
</tr>
<tr>
<td>Aspen - Cc &gt; 59%</td>
<td>62</td>
<td>5</td>
<td>Aspen</td>
</tr>
<tr>
<td>Aspen/Conifer - Cc 30-59%</td>
<td>64</td>
<td>5</td>
<td>Aspen</td>
</tr>
<tr>
<td>Maple - Cc 30-59%</td>
<td>67</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Maple - Cc &gt; 59%</td>
<td>68</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Mountain Mahogany - Cc 30-59%</td>
<td>70</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Mountain Mahogany - Cc &gt; 59%</td>
<td>71</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Big Sagebrush</td>
<td>75</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Vegetation Type</td>
<td>Code</td>
<td>Category</td>
<td>Land Use Type</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------</td>
<td>------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Bitterbrush</td>
<td>76</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Burn Shrub</td>
<td>77</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Low Sagebrush</td>
<td>80</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Montane Shrub</td>
<td>81</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Mountain Big Sage</td>
<td>82</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Mountain Low Sage</td>
<td>83</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Silver Sage</td>
<td>86</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Alpine Shrub</td>
<td>87</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Alpine Herbaceous</td>
<td>90</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Burn Herbaceous</td>
<td>92</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Clearcut Herbaceous</td>
<td>93</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Dry Meadow</td>
<td>94</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Perennial Grass</td>
<td>95</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Perennial Grass Slope</td>
<td>96</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Perennial Grass Montane</td>
<td>97</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Tall Forb Montane</td>
<td>98</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Wet Meadow</td>
<td>99</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Barren</td>
<td>101</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Rock</td>
<td>104</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Water</td>
<td>107</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Snow</td>
<td>108</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Deciduous Tree Riparian</td>
<td>111</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Riverine Riparian</td>
<td>112</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Herbaceous Riparian</td>
<td>113</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Shrub Riparian</td>
<td>114</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Deep Marsh</td>
<td>120</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Shallow Marsh</td>
<td>121</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Aquatic Bed</td>
<td>122</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Mud Flat</td>
<td>123</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Agricultural</td>
<td>126</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Disturbed High</td>
<td>129</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Disturbed Low</td>
<td>130</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Urban High Density</td>
<td>131</td>
<td>6</td>
<td>Non-forested</td>
</tr>
<tr>
<td>Urban Low Density</td>
<td>132</td>
<td>6</td>
<td>Non-forested</td>
</tr>
</tbody>
</table>
Creating Three Spatial Resolutions

In order to make the spatial resolution of the predictor variables spatially compatible with the canopy mortality estimates, each raster layer was resampled to 1 and 5 hectare circles. The .07 hectare analysis used the original 30 meter resolution data layers because the 15 meter radius circle was completely contained in one pixel. This was accomplished using circular focal statistics calculations for the three appropriate radii: 56.41 meters for 1 hectare and 126.16 meters for 5 hectares. The ArcGIS 9.1 Focal Statistics tool was used to specify these operations (ArcToolbox > Spatial Analyst Tools > Neighborhood > Focal Statistics). The numeric raster layers (dNBR, NBR post-fire, RdNBR, dNDVI, RdNDVI, TCT 1-3, elevation, slope, and aspect) used the focal mean statistics type (Figure A-23). Each pixel value was replaced by the mean of all pixels that partially or completely intersected the specified radii. Forest type, a categorical layer, used focal majority instead of mean to replace each pixel with the most prevalent forest type within the designated radii (Figure A-24).
Figure A-23. The Focal Statistics tool was used to calculate the 1 hectare circular focal mean for the Tasseled Cap Transformation brightness (TCT-1) raster grid.

Figure A-24. The 5 hectare circular focal majority for forest type was calculated using a radius of 126.16 meters.
Point Extraction from Raster Data

The pixel values of each predictor variable raster layer were extracted for the 694 canopy mortality estimate locations using The Hawth’s Analysis Tools 3.26 package, available at (http://www.spatialecology.com/htools/tooldesc.php). The point shape file containing the 694 XY locations was used with the Intersect Point tool (Hawth’s Tools toolbar > Analysis Tools > Intersect Point Tool) (Figure A-25). This operation appended a new field for each intersecting raster pixel at the three spatial resolutions to the attribute table of the point shapefile. The table was then exported to a database file (Open Attribute Table > Options > Export > Export Data) for statistical analysis.

Accuracy Assessment

Random Point Generation

The Hawth’s Tools Extension for ArcGIS was used to generate random points within designated polygons for accuracy assessment of canopy mortality models. In order to exclude nonforested areas from the random sample area, a polygon shapefile of nonforested vegetation was used. This shapefile was made by converting a reclassified
forest type raster layer to only nonforested vegetation and NoData (Figure A-26) 
(*ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify*). This was then converted
to a polygon shapefile (Figure A-27) (*ArcToolbox > Conversion Tools > From Raster > Raster to Polygon*).

A simple random sample of 100 points was derived within each of the three fires
chosen (Figure A-28), for a total of 300 (*Hawth’s Tools > Sampling Tools > Generate Random Points*).

Figure A-26. Reclassification of the 1 hectare forest type raster layer to Nonforested and
NoData

Figure A-27. Converting the raster layer of nonforested vegetation to a shapefile for use as
a mask in selecting random locations for accuracy assessment.
Figure A-28. The Hawth’s Tools dialog box for generating 100 random points within the Wilcox fire, exclusive of nonforested vegetation
Making Predicted Surfaces

Classification tree models were expressed in the form of conditional statements for conversion to raster form using the ArcGIS Spatial Analyst extension Raster Calculator. An analysis mask was used that limited these surfaces to forested vegetation only (Spatial Analyst toolbar > Options > Analysis Mask > raster file name). This mask layer was made from the forest type grids for .07, 1, and 5 hectare spatial resolutions using the Reclassify tool (ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify) (Figure A-29).

![Reclassify dialog box](image)

Figure A-29. Creating the 1 hectare forested vegetation analysis mask layer for generating predicted surfaces of canopy mortality. All five forest types were combined as value “1” and the nonforested category was excluded as “NoData.”

Figure A-30 shows how the Spatial Analyst Raster Calculator is used to generate the predicted surface for the classification tree model for three mortality categories at the .07 hectare spatial resolution (see original tree model diagram Figure A-31). Tables A-5 and A-6 show the conditional statements used for all models subjected to accuracy assessment in Chapters 2 and 3, respectively. If both tree branches at a node resulted in the same mortality category, that step was omitted from the conditional statement.
Figure A-30. Raster Calculator expression featuring conditional (con) statements used to generate the predicted raster surface for three levels of canopy mortality at the original 30 meter pixel scale.

Figure A-32. Original binary classification tree model diagram for three canopy mortality categories at .07 hectare resolution. Note that the splits on the right side of the tree are not included in conditional statements (Figure A-30) because they all result in the 80-100% category.
Table A-5. Raster Calculator Expressions used to create predicted surfaces for classification tree models for Chapter 2. See Appendix B and the supplemental data DVD for model specifics.

<table>
<thead>
<tr>
<th>Tree Model</th>
<th>Conditional Statement Used in Raster Calculator</th>
</tr>
</thead>
<tbody>
<tr>
<td>3- Category Air Photo Based Best Tree</td>
<td>[ p_{\text{photo}_3} = \text{con} ( [\text{rdnbr30}] &lt; 357.72, \text{con} ( [\text{rdnbr30}] &lt; 147.86 , 1 , \text{con} ( [\text{elev}_30] &lt; 2011.53 , 3 , 2 )) , 3 ) ]</td>
</tr>
<tr>
<td>3- Category Air Photo Based DNBR Only Tree</td>
<td>[ p_{\text{ph}_3_dnbr} = \text{con} ( [\text{dnbr30}] &lt; 99.98, 1 , \text{con} ( [\text{dnbr30}] &lt; 352.9 , [\text{elev}_30] &lt; 2436.51 , 3 , 2 ) , 3 ) ]</td>
</tr>
</tbody>
</table>

Table A-6. Raster Calculator Expressions used to create predicted surfaces for classification tree models for Chapter 3. See Appendix B and the supplemental data DVD for model specifics.

<table>
<thead>
<tr>
<th>Tree Model</th>
<th>Conditional Statement Used in Raster Calculator</th>
</tr>
</thead>
<tbody>
<tr>
<td>.07 Hectare Tree</td>
<td>[ p_{0.07h_3} = \text{con} ( [\text{rdnbr30}] &lt; 357.72, \text{con} ( [\text{rdnbr30}] &lt; 147.86 , 1 , \text{con} ( [\text{elev}_30] &lt; 2011.53 , 3 , 2 )) , 3 ) ]</td>
</tr>
<tr>
<td>1 Hectare Tree</td>
<td>[ p_{1h_3} = \text{con} ( [\text{dnbr}_1h] &lt; 100.235 , \text{con} ( [\text{dndvi}_1h] &lt; 100.235 , 1 , 3 ) , \text{con} ( [\text{rdnbr}_1h] &lt; 956.275 , \text{con} ( [\text{elev}_1h] &lt; 2478.13 , 3 , 2 ) , 3 ) ) ]</td>
</tr>
<tr>
<td>5 Hectare Tree</td>
<td>[ p_{5h_3} = \text{con} ( [\text{dndvi}_5h] &lt; 158.52, \text{con} ( [\text{dnbr}_5h] &lt; 11.9 , \text{con} ( [\text{nbrpost}_5h] &lt; 315.01 , 2 , 1 ) , \text{con} ( [\text{dnbr}_5h] &lt; 146.7 , \text{con} ( [\text{tc2}_5h] &lt; 40.16 , \text{con} ( [\text{elev}_5h] &lt; 1927.78 , 3 , 2 ) , 3 ) ) , \text{con} ( [\text{nbrpost}_5h] &lt; 135.5 , 3 , 2 ) ) ]</td>
</tr>
</tbody>
</table>

Extracting Predicted Values for Accuracy Assessment Locations

Canopy mortality estimates were made for the 300 accuracy assessment plots using the same digital orthophotography and buffer process used for the original 694 estimates at three scales (see Canopy Mortality Estimates from Digital Orthophotographs, page 119). In order to construct error matrices comparing the estimated and predicted mortality levels, the pixel values for the model predicted surfaces were obtained with the Hawth’s Tools Point Intersect Tool, which appended them to the random location shape file for export to database format (see Point Extraction from Raster Data, page 143).

Analysis of Sampling Bias for CBI Plot Locations

To evaluate the effects of using field selected CBI plots instead of random locations for this study, a comparison was made between slope, aspect, elevation, and distance from roads for the 694 plots and 700 points selected using the Hawth’s Tools Generate Random Points tool. The random samples were selected within the 23 fire polygons with no mask for vegetation types. The raster layer for distance from roads was created using the Euclidean Distance tool (ArcToolbox > Spatial Analyst Tools > Distance > Euclidean Distance) and a shape file for roads (Figure A-32). The Hawth’s Tools Point Intersect Tool was used to extract the pixel values for slope, aspect and
elevation and road distance for the random point and CBI plot point shape files (see Point Extraction from Raster Data, page 143). The attribute tables for these feature datasets were exported to database format for analysis. See Chapter 1 for the results of these comparisons.

Figure AA-32. Creation of a road distance raster layer for the study area using the Spatial Analyst Euclidian Distance tool.

Literature Cited


APPENDIX B

Statistical Analysis: R Script for Classification Tree Models

Table of Contents

Introduction ................................................................. 151

Chapter 2 Classification Tree Model Examples ........................................................ 152

Photo-Based 3 Category Model Script (Best Tree) ...................................................... 152

Photo-Based dNBR Only Model Script (dNBR Only Tree) ........................................ 158

Chapter 3 Classification Tree Model Example ......................................................... 163

.07 Hectare Resolution Model Script ................................................................. 163

Introduction

The R statistical package version 2.3.1 was used to build binary classification tree models as part of this study. The program was developed by the R Project for Statistical Computing, and is available for download free of charge at http://www.r-project.org/.

The R Graphic User Interface (GUI) consists of an “R Console” window for command line entry and program output, as well as windows for graphical outputs. Commands can be typed directly into the R Console, or pasted in from word processing files. The scripts below were developed for such copy-and-paste use. Red text represents command entry, and blue text is R statistical output. Black text is used to explain the operational steps and data characteristics.

The R Tree package was used for classification tree modeling. It can be downloaded from the R Project website (above), and installed from a .zip file from the R Packages pull-down menu. It must be loaded each time the program is restarted.

Only three script examples are included in this appendix; however Microsoft Word document format scripts for all ten models referred to in chapters 2 and 3 are
located on the supplemental data DVD. Electronic data files are also included. To run the scripts, copy the data text files to a root directory. If a drive designated “F” is used, no changes will be needed to read them into R using the pasted lines from the scripts. Otherwise, the drive letter will need to be changed when the read.table command is used.

Chapter 2 Classification Tree Model Examples

Photo-Based 3 Category Model Script (Best Tree)

Categories for percent canopy mortality estimated from Air Photos (30m diameter circle):

X 0-20
Y 25-75
Z 80-100

Tree Model selection process for model to predict canopy mortality levels using air photos.

Read data into R:

```r
photo3<-read.table("F://Photo_3.txt", header=T,sep="")
```

Check the number of columns:

```r
ncol(photo3)
[1] 19
```

<table>
<thead>
<tr>
<th>Column Index</th>
<th>Column Name</th>
<th>Column In subset</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>UNIT</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>FIRE_NAME</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>PLOT_NAME</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>UTM_N</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>UTM_E</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>FIRE_DATE</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>MORT_CATEG_3</td>
<td>7, 1</td>
</tr>
<tr>
<td>8</td>
<td>FORTYPE_30</td>
<td>8, 2</td>
</tr>
<tr>
<td>9</td>
<td>SLOPE_30</td>
<td>9, 3</td>
</tr>
<tr>
<td>10</td>
<td>ELEV_30</td>
<td>10, 4</td>
</tr>
<tr>
<td>11</td>
<td>ASPECT_30</td>
<td>11, 5</td>
</tr>
<tr>
<td>12</td>
<td>TC3_30</td>
<td>12, 6</td>
</tr>
<tr>
<td>13</td>
<td>TC2_30</td>
<td>13, 7</td>
</tr>
<tr>
<td>14</td>
<td>TC1_30</td>
<td>14, 8</td>
</tr>
<tr>
<td>15</td>
<td>RDNDVI_30</td>
<td>15, 9</td>
</tr>
<tr>
<td>16</td>
<td>RDNBR_30</td>
<td>16, 10</td>
</tr>
<tr>
<td>17</td>
<td>NBRPOST_30</td>
<td>17, 11</td>
</tr>
<tr>
<td>18</td>
<td>DNDVI_30</td>
<td>18, 12</td>
</tr>
<tr>
<td>19</td>
<td>DNBR_30</td>
<td>19, 13</td>
</tr>
</tbody>
</table>

Make a subset of columns of interest:
photo3.sub<- photo3[,7:19]

Set response variable MORT_CATEG_3 as categorical:

photo3.sub [,1]<-as.factor(photo3.sub [,1])

Set response variable FORTYPE_30 as categorical:

photo3.sub [,2]<-as.factor(photo3.sub[,2])

Load tree package.

photo3.tree<-tree(MORT_CATEG_3 ~.,, data = photo3.sub)

summary(photo3.tree)

photo3.tree
plot(photo3.tree)
text(photo3.tree)

Classification tree:
tree(formula = MORT_CATEG_3 ~ ., data = photo3.sub)
Variables actually used in tree construction:
[1] "RDNBR_30" "NBRPOST_30" "FORTYPE_30" "ELEV_30" "DNDVI_30"
Number of terminal nodes: 11
Residual mean deviance: 1.15 = 785.3 / 683
Misclassification error rate: 0.2637 = 183 / 694

`node` is the point of a binary split
`var` is the variable used at the split (or leaf for a terminal node)
`split` is the threshold value or category determining the split
`n` is the (weighted) number of cases reaching that node
`dev` the deviance of the node
`yval`, is the fitted value at the node (majority class)
(`yprob`)is a matrix of fitted probabilities for each response level.
* denotes terminal node

node, split, n, deviance, yval, (yprob)
* denotes terminal node

1) root 694 1324.000 Z ( 0.208934 0.194524 0.596542 )
2) RDNBR_30 < 357.72 215 421.200 X ( 0.567442 0.246512 0.186047 )
4) RDNBR_30 < 147.86 123 168.500 X ( 0.764228 0.170732 0.065041 )
8) NBRPOST_30 < 214.305 22 47.090 X ( 0.409091 0.363636 0.227273 ) *
9) NBRPOST_30 > 214.305 101 103.700 X ( 0.841584 0.128713 0.029703 )
18) FORTYPE_30: 0,1,2,4,6 80 57.040 X ( 0.912500 0.050000 0.037500 ) *
19) FORTYPE_30: 5 21 28.680 X ( 0.571429 0.428571 0.000000 ) *
5) RDNBR_30 > 147.86 92 201.800 Z ( 0.304348 0.347826 0.347826 )
10) ELEV_30 < 2011.53 19 19.560 Z ( 0.000000 0.210526 0.789474 ) *
11) ELEV_30 > 2011.53 73 156.900 Y ( 0.383562 0.383562 0.232877 ) *
3) RDNBR_30 > 357.72 479 614.200 Z ( 0.048017 0.171190 0.780793 )
6) DNDVI_30 < 228.615 197 344.900 Z ( 0.086294 0.304569 0.609137 )
12) NBRPOST_30 < -129.065 25 8.397 Z ( 0.000000 0.040000 0.960000 ) *
13) NBRPOST_30 > -129.065 172 316.900 Z ( 0.098837 0.343023 0.558140 )
26) ELEV_30 < 1916.13 19 7.835 Z ( 0.000000 0.052632 0.947368 ) *
27) ELEV_30 > 1916.13 153 292.300 Z ( 0.111111 0.379085 0.509804 ) *
7) DNDVI_30 > 228.615 282 211.600 Z ( 0.021277 0.078014 0.900709 )
14) ELEV_30 < 2436.6 142 48.290 Z ( 0.007042 0.028169 0.964789 ) *
15) ELEV_30 > 2436.6 140 149.200 Z ( 0.035714 0.128571 0.835714 )
30) RDNBR_30 < 1353.07 48 86.340 Z ( 0.104167 0.291667 0.604167 ) *
31) RDNBR_30 > 1353.07 92 32.910 Z ( 0.000000 0.043478 0.956522 ) *

Perform a 10-fold cross validation of the tree model. Repeat 10 times.

photo3.cv<-cv.tree(photo3.tree)
photo3.cv
plot(photo3.cv)

%size
11 10 8 7 5 4 3 2 1

%dev
1141.949 1050.311 1051.615 1025.315 1026.371 1014.699 1065.716 1083.888
9 1327.773

%sk
-Inf 16.74249 17.85462 19.63187 22.01071 25.36371 50.92354
8 57.71470 288.41402

%method
"deviance"

attr("class")
"prune" "tree.sequence"
The deviance starts to increase after about 7 nodes

```r
photo3.prune <- prune.tree(photo3.tree, best = 7)
plot(photo3.prune)
text(photo3.prune)
summary(photo3.prune)
```

Classification tree:
```r
snip.tree(tree = photo3.tree, nodes = c(4, 6))
```
Variables actually used in tree construction:

```
[1] "RDNBR_30" "ELEV_30" "DNDVI_30"
```
Number of terminal nodes: 7
Residual mean deviance: 1.248 = 857.4 / 687
Misclassification error rate: 0.2637 = 183 / 694
Which categories are differentiated in the first split?

```
photo3.prune<-prune.tree(photo3.tree, best = 2)
photo3.prune
plot(photo3.prune)
text(photo3.prune)
summary(photo3.prune)
```
**Photo-Based dNBR Only Model Script (dNBR Only Tree)**

Categories for percent canopy mortality estimated from Air Photos (30m diameter circle):

<table>
<thead>
<tr>
<th>Category</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>0-20</td>
</tr>
<tr>
<td>Y</td>
<td>25-75</td>
</tr>
<tr>
<td>Z</td>
<td>80-100</td>
</tr>
</tbody>
</table>

Tree Model selection process for model to predict canopy mortality levels using air photos.

Read data into R:

```r
photo3dnbr<-read.table("F://Photo_3_dnbr.txt", header=T,sep="")
```

Check the number of columns:

```r
ncol(photo3dnbr)
```

[1] 15

<table>
<thead>
<tr>
<th>Column: Data:</th>
<th>Column In subset</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 UNIT</td>
<td></td>
</tr>
<tr>
<td>2 FIRE_NAME</td>
<td></td>
</tr>
<tr>
<td>3 PLOT_NAME</td>
<td></td>
</tr>
<tr>
<td>4 UTM_N</td>
<td></td>
</tr>
<tr>
<td>5 UTM_E</td>
<td></td>
</tr>
<tr>
<td>6 FIRE_DATE</td>
<td></td>
</tr>
<tr>
<td>7 MORT_CATEG_3</td>
<td>1</td>
</tr>
<tr>
<td>8 FORTYPE_30</td>
<td>2</td>
</tr>
<tr>
<td>9 SLOPE_30</td>
<td>3</td>
</tr>
<tr>
<td>10 ELEV_30</td>
<td>4</td>
</tr>
<tr>
<td>11 ASPECT_30</td>
<td>5</td>
</tr>
<tr>
<td>12 TC3_30</td>
<td>6</td>
</tr>
<tr>
<td>13 TC2_30</td>
<td>7</td>
</tr>
<tr>
<td>14 TC1_30</td>
<td>8</td>
</tr>
<tr>
<td>15 DNBR_30</td>
<td>13</td>
</tr>
</tbody>
</table>
Make a subset of columns of interest:

```r
photo3dnbr.sub <- photo3dnbr[,7:15]
```

Set response variable `MORT_CATEG_3` as categorical:

```r
photo3dnbr.sub[,1] <- as.factor(photo3dnbr.sub[,1])
```

Set response variable `FORTYPE_30` as categorical:

```r
photo3dnbr.sub[,2] <- as.factor(photo3dnbr.sub[,2])
```

Load the tree package

```r
photo3dnbr.tree <- tree(MORT_CATEG_3 ~ ., data = photo3dnbr.sub)
```

```r
summary(photo3dnbr.tree)

tree

plot(photo3dnbr.tree)

text(photo3dnbr.tree)
```

Classification tree:

```r
tree(formula = MORT_CATEG_3 ~ ., data = photo3dnbr.sub)

Variables actually used in tree construction:

[1] "DNBR_30" "FORTYPE_30" "ELEV_30" "ASPECT_30" "TC3_30"

Number of terminal nodes: 9

Residual mean deviance: 1.279 = 876 / 685

Misclassification error rate: 0.2478 = 172 / 694
```

```
There is a tree diagram showing the classification tree with the following splits:

- **DNBR_30 < 99.98**
- **FORTYPE_30: abceg**
  - **DNBR_30 < 352.9**
    - **ELEV_30 < 2436.51**
      - **ASPECT_30 < 138.07**
        - **TC3_30 < -1.5**
          - **ELEV_30 < 2600.85**
            - **DNBR_30 < 99.98**
            - **DNBR_30 < 352.9**
```

'node' is the point of a binary split
'var' is the variable used at the split (or leaf for a terminal node)
'split' in the threshold value or category determining the split
'n' is the (weighted) number of cases reaching that node
'dev' the deviance of the node
'yval', is the fitted value at the node (majority class)
'yprob')is a matrix of fitted probabilities for each response level.
* denotes terminal node
1) root 694 1324.00 Z (0.20893 0.19452 0.59654)
2) DNBR_30 < 99.98 167 288.10 X (0.66467 0.20359 0.13174)
4) FORTYPE_30: 0,1,2,4,6 139 228.50 X (0.69784 0.15108 0.15108)
8) DNBR_30 < 41.565 85 104.40 X (0.81176 0.09412 0.09412) *
9) DNBR_30 > 41.565 54 110.80 X (0.51852 0.24074 0.24074) *
5) FORTYPE_30: 3,5 28 46.02 X (0.50000 0.46429 0.03571) *
3) DNBR_30 > 99.98 527 752.10 Z (0.06452 0.19165 0.74383)
6) DNBR_30 < 352.9 260 475.90 Z (0.11154 0.29615 0.59231)
12) ELEV_30 < 2436.51 154 229.00 Z (0.06494 0.21429 0.72078)
24) ASPECT_30 < 138.07 74 138.00 Z (0.12162 0.29730 0.58108) *
25) ASPECT_30 > 138.07 80 74.52 Z (0.01250 0.01375 0.58000) *
13) ELEV_30 > 2436.51 106 220.30 Y (0.17925 0.41509 0.40566)
26) TC3_30 < -1.5 73 136.70 Y (0.09589 0.50685 0.39726)
52) ELEV_30 < 2600.85 37 59.45 Y (0.10811 0.70270 0.18919) *
53) ELEV_30 > 2600.85 36 62.66 Z (0.08333 0.30556 0.61111) *
27) TC3_30 > -1.5 33 70.00 Z (0.36364 0.21212 0.42424) *
7) DNBR_30 > 352.9 267 210.10 Z (0.01873 0.08989 0.89139) *

Perform a 10-fold cross validation of the tree model. Repeat 10 times.

photo3dnbr.cv<-cv.tree(photo3dnbr.tree)
photo3dnbr.cv
plot(photo3dnbr.cv)

$size
[1] 9 8 7 5 4 3 2 1

$dev
[1] 1177.9152 1121.1016 1124.7038 1085.7086 999.5689 1009.9677 1063.9208
[8] 1328.7955

$sk
[8] 283.64800

$s.method
[1] "deviance"

attr("class")
[1] "prune" "tree.sequence"
<table>
<thead>
<tr>
<th>size</th>
<th>deviance</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>1000</td>
</tr>
<tr>
<td>4</td>
<td>1250</td>
</tr>
<tr>
<td>6</td>
<td>2468</td>
</tr>
<tr>
<td>8</td>
<td>280</td>
</tr>
<tr>
<td>14</td>
<td>17</td>
</tr>
<tr>
<td>-Inf</td>
<td></td>
</tr>
</tbody>
</table>
The deviance starts to increase after about 5 nodes

```r
photo3dnbr.prune <- prune.tree(photo3dnbr.tree, best = 5)
photo3dnbr.prune
plot(photo3dnbr.prune)
text(photo3dnbr.prune)
summary(photo3dnbr.prune)
```

Classification tree:
```r
snip.tree(tree = photo3dnbr.tree, nodes = c(2, 13))
```
Variables actually used in tree construction:
```r
[1] "DNBR_30"  "ELEV_30"  "ASPECT_30"
```
Number of terminal nodes: 5
Residual mean deviance: 1.351 = 931 / 689
Misclassification error rate: 0.2738 = 190 / 694
Chapter 3 Classification Tree Model Script Example

.07 Hectare Resolution Model

Categories for percent canopy mortality estimated from air photos for the 30 meter diameter circle:

X 0-20
Y 25-75
Z 80-100

Tree Model selection process for model to predict canopy mortality levels using air photos.

Read data into R:

```
res07h<-read.table("F://07h_3.txt", header=T,sep="")
```

Check the number of columns:
```
ncol(res07h)
```
```
[1] 20
```

Column Data: ____________________ Column In subset: ____________________
UNIT 1
FIRE_NAME 2
PLOT_NAME 3
UTM_N 4
UTM_E 5
FIRE_DATE 6
MORT_CATEG_3 7
FORTYPE_30 8
SLOPE_30 9
ELEV_30 10
ASPECT_30 11
TC3_30 12
TC2_30 13
TC1_30 14
RDNDVI_30 15
RDNBR_30 16
NBRPOST_30 17
DNDVI_30 18
DNBR_30 19
UNIT 20

Make a subset of columns of interest:

res07h.sub<- res07h [,7:20]

Set response variable MORT_CATEG_3 as categorical:

res07h.sub[,1]<-as.factor(res07h.sub[,1])

Set response variable FORTYPE_30 as categorical:

res07h.sub[,2]<-as.factor(res07h.sub[,2])

Set response variable UNIT as categorical:

res07h.sub[,14]<-as.factor(res07h.sub[,14])

Load tree package

res07h.tree<-tree(MORT_CATEG_3 ~ ., data = res07h.sub)

summary(res07h.tree)
res07h.tree
plot(res07h.tree)
text(res07h.tree)

Classification tree:
tree(formula = MORT_CATEG_3 ~ ., data = cbi30m3.sub)

Variables actually used in tree construction:
[1] "RDNB_30" "NBRPOST_30" "FORTYPE_30" "ELEV_30" "DNDVI_30"
Number of terminal nodes: 11
Residual mean deviance: 1.15 = 785.3 / 683
Misclassification error rate: 0.2637 = 183 / 694
'node' is the point of a binary split
'var' is the variable used at the split (or leaf for a terminal node)
'split' in the threshold value or category determining the split
'n' is the (weighted) number of cases reaching that node
'dev' the deviance of the node
'yval', is the fitted value at the node (majority class)
('yprob')is a matrix of fitted probabilities for each response level.
* denotes terminal node

```
(node), split, n, deviance, yval, (yprob)
* denotes terminal node

1) root 694 1324.000 Z ( 0.208934 0.194524 0.596542 )
  2) RDNBR_30 < 357.72 215 421.200 X ( 0.567442 0.246512 0.186047 )
     4) RDNBR_30 < 147.86 123 168.500 X ( 0.764228 0.170732 0.065041 )
        8) NBRPOST_30 < 214.305 22 47.090 X ( 0.409091 0.363636 0.227273 ) *
        9) NBRPOST_30 > 214.305 101 103.700 X ( 0.841584 0.128713 0.029703 )
           18) FORTYPE_30: 0,1,2,4,6 80 57.040 X ( 0.912500 0.050000 0.037500 ) *
           19) FORTYPE_30: 5 21 28.680 X ( 0.571429 0.428571 0.000000 ) *
     5) RDNBR_30 > 357.72 479 614.200 Z ( 0.048017 0.171190 0.780793 )
        6) DNDVI_30 < 228.615 197 344.900 Z ( 0.086294 0.304569 0.609137 )
           12) NBRPOST_30 < -129.065 25 8.397 Z ( 0.000000 0.040000 0.960000 ) *
           13) NBRPOST_30 > -129.065 172 316.900 Z ( 0.098837 0.343023 0.558140 )
              26) ELEV_30 < 1916.13 19 7.835 Z ( 0.000000 0.052632 0.947368 ) *
              27) ELEV_30 > 1916.13 153 292.300 Z ( 0.111111 0.379085 0.509804 ) *
     7) DNDVI_30 > 228.615 282 211.600 Z ( 0.021277 0.078014 0.899709 )
        14) ELEV_30 < 2436.6 142 48.290 Z ( 0.007042 0.028169 0.964789 ) *
        15) ELEV_30 > 2436.6 140 149.200 Z ( 0.035714 0.128571 0.835714 )
            30) RDNBR_30 < 1353.0 48 86.340 Z ( 0.104167 0.291667 0.604167 ) *
            31) RDNBR_30 > 1353.0 92 32.910 Z ( 0.000000 0.043478 0.956522 ) *
```

Perform a 10-fold cross validation of the tree model. Repeat 10 times.
res07h.cv <- cv.tree(res07h.tree)
res07h.cv
plot(res07h.cv)

$size
[1] 11 10 8 7 5 4 3 2 1

$dev
[9] 1328.790

$sk
[8] 57.71470 288.41402

$smethod
[1] "deviance"

attr("class")
[1] "prune" "tree.sequence"
The deviance starts to increase after 5 nodes

res07h.prune<-prune.tree(res07h.tree, best = 5)
res07h.prune
plot(res07h.prune)
text(res07h.prune)
summary(res07h.prune)

Classification tree:
snip.tree(tree = cbi30m3.tree, nodes = c(4, 6, 7))
Variables actually used in tree construction:
[1] "RDNBR_30" "ELEV_30" "DNDVI_30"
Number of terminal nodes: 5
Residual mean deviance: $1.308 = 901.4 / 689$
Misclassification error rate: $0.2637 = 183 / 694$

Which two classes are differentiated by the first split?

res07h.prune <- prune.tree(res07h.tree, best = 2)
res07h.prune
plot(res07h.prune)
text(res07h.prune)
summary(res07h.prune)
APPENDIX C

Contents of Supplemental DVD Rom

The Attached DVD contains electronic files for GIS products, statistical analysis, databases, and other documents. The diagram below describes the directory structure, with GIS files appearing as they do in ArcCatalog. Text in italics provides descriptive information. All GIS data are projected to NAD 1983 Zone 12, and are accompanied by metadata.

[Diagram of directory structure]

Abendroth_Data_DVD

Accuracy_Assessment

Databases

Blin_Trail_Extract.xls - Spreadsheet comparing mortality estimates and predicted surface values for the Blind Trail Fire
Broad_Extract.xls - Spreadsheet comparing mortality estimates and predicted surface values for the Broad Fire
Wilcox_Extract.xls - Spreadsheet comparing mortality estimates and predicted surface values for the Wilcox Fire

Shapefiles

3_AA_Fires.shp - Polygon shapefile of all three fires used in accuracy assessment
Blind_Trail_Fire.shp - Perimeter shapefile of the Blind Trail Fire
Broad_Fire.shp - Perimeter shapefile of the Broad Fire
Nonforested.shp - Polygon shapefile of nonforested vegetation for the entire study area (used to exclude these areas from random sampling)
Wilcox_Fire.shp - Perimeter shapefile of the Wilcox Fire

Canopy_Mortality_Estimates

Databases

Abendroth_database.xls - Entire canopy mortality modeling database for 694 locations

Shapefiles

cbi_buffer_07.shp - Polygon shapefile with 15 meter radius circles for estimating canopy mortality at each location
cbi_buffer_1h.shp - Polygon shapefile with 56.41 meter radius circles for estimating canopy mortality at each location
cbi_buffer_5h.shp - Polygon shapefile with 126.16 meter radius circles for estimating canopy mortality at each location
CBIplots.shp - Point shapefile for each of 694 canopy mortality observations

Digital_Orthophotographs

2006_True_Color

naip_1-1_1n_s_sy039_2006.htm - Example metadata for the 2006 true color digital orthophoto of Teton County, Wyoming

2001_2002_Color_Infrared

ProspectSW.htm - Example metadata for the 2001 color infrared DOQ for the Prospect Southwest Quadrangle, Wyoming